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ÖN SÖZ 

Veri ve istatistik bilimi tarihsel süreç içerisinde bilimsel araştırmalardan 

elde edilen sonuçları daha anlamlı ve güvenilir kılmada önemli görevler 

üstlenmiştir. Bu kitap son yıllarda uygulamalı araştırmalarda oldukça sık 

kullanılan zaman serisi analiz yöntemlerinden ARDL, A-ARDL ve NARDL 

eşbütünleşme testleri ile Toda-Yamamoto nedensellik testlerinin adım adım 

anlatıldığı bir uygulama kitabıdır. Kitaptaki anlatım ve akış daha önce hiç 

Eviews paket programı kullanmamış kişilere göre kurgulanmıştır. Bu kitap 

bilimsel bir merakın ürünü olmanın ötesinde uygulamalı ekonometri 

yöntemlerini kullanan araştırmacılar için yol gösterici/rehber olma amacını 

taşımaktadır. Bunun yanı sıra kitabın, alanın en iyisi olma gibi bir iddiası yoktur. 

Bu kitabın, uygulamalı çalışmaların niteliğini ve niceliğini artırmaya yardımcı 

olarak literatüre katkı sağlaması beklenmektedir.  

Bu kitapla herhangi bir kâr amacı güdülmemiş olup kitap açık erişim 

olarak araştırmacıların dikkatine sunulmuştur. Kitabın ilk baskısı olması 

nedeniyle gözden kaçan hataların tarafımıza bildirilmesinden memnuniyet 

duyacağımızı belirtmek isteriz. Her geri bildirimin takip eden baskılarda bu 

kitabı daha iyi noktalara taşıyacağına inanıyoruz. Bu süreçte bize destek olan ve 

yardımlarını esirgemeyen değerli hocalarımıza ve Öğr. Grv. Dr. Erhan Çelik’e 

teşekkürü bir borç biliriz. 

 

Serkan Göksu - Ali Balkı 

Afyonkarahisar 
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GİRİŞ 

İktisat, istatistik ve matematik disiplinlerinin birleşimi olarak 

tanımlanabilecek ekonometri bilimi, kullandığı yöntemler açısından politika 

yapıcılara ve uygulayıcılara oldukça değerli bilgiler sunmaktadır. Bu kapsamda 

kitap, zaman serisi analiz yöntemlerinden ARDL, A-ARDL ve NARDL 

eşbütünleşme testleri ile Toda-Yamamoto nedensellik testlerine 

odaklanmaktadır. Eviews uygulama aşamalarının adım adım anlatılmaya 

çalışıldığı bu kitap dokuz bölümden oluşmaktadır.  

İlk bölüm, verilerin analizlere hazır hale getirilmesi ile ilgili olup 

verilerin farklı yöntemler kullanarak Eviews paket programına aktarılmasını, 

verilerin reelleştirilme süreçlerini, logaritmik dönüşüm işlemlerinin 

uygulanmasını, mevsimsel etkilerden arındırma işlemlerini ve grafiklerin 

oluşturulma süreçlerini kapsamaktadır. İkinci bölümde, tanımlayıcı ya da 

betimleyici istatistik tablolarının oluşturulmasına ve yorumlanmasına ilişkin 

ayrıntılı bilgiler sunulmuştur. Üçüncü bölümde, korelasyon matrisinin 

oluşturulma aşamaları anlatılarak korelasyon katsayıları yorumlanmıştır. 

Dördüncü bölümde ise kullanılacak yönteme karar vermede ve sahte 

regresyon sorununu ekarte etmede değerli bilgiler sunan birim kök testlerinin 

uygulama aşamaları anlatılmıştır. Bu bölümde literatürde geleneksel hale gelmiş 

ADF, PP ve KPSS birim kök testlerinin yanında yapısal kırılmaları da dikkate 

alan kırılmalı birim kök testlerinden LS ve ZA birim kök testlerinin uygulama 

aşamaları aktarılmış ve sonuçların nasıl değerlendirilebileceği üzerinde 

durulmuştur. 

Beşinci bölümde bağımlı ve bağımsız değişkenler arasındaki dinamik 

etkileşimlerin modellenmesine ve değişkenler arasındaki uzun dönemli 

ilişkilerin anlaşılmasına yardımcı olan ARDL yöntemi ayrıntılı bir şekilde ele 

alınmıştır. Ayrıca ARDL yönteminin modifiye edilmiş hali olarak 

tanımlanabilecek ve nispeten yeni bir yöntem olan A-ARDL yönteminin 

uygulama adımları da aktarılmıştır. Bu bölümde ilk olarak adı geçen yöntemlerin 

seçiminde dikkat edilmesi gereken hususların neler olduğu, eşbütünleşme 

testlerinin, kısa ve uzun dönem katsayı tahminlerinin ve diagnostik/tanısal 

testlerin nasıl yapılacağı ve elde edilen sonuçların nasıl yorumlanacağı 

açıklanmıştır. 

Altıncı bölümde değişkenler arasındaki saklı eşbütünleşmeleri ortaya 

çıkarmaya yardımcı olan asimetrik yöntemlerden NARDL analiz yöntemi 

üzerinde durulmuştur. Bu bölümde ilk olarak hangi durumlarda bu yöntemin 

tercih edilmesi gerektiğine ilişkin gerekçeler açıklanmış olup daha sonra 

uygulama adımları ayrıntılı bir şekilde sunulmuştur. Kurgu olarak ARDL 

yöntemindeki aşamalar takip edilmiştir. 
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Yedinci bölümde ise diğer nedensellik yöntemlerine göre daha esnek bir 

yöntem olan Toda-Yamamoto nedensellik analizi ele alınmıştır. Yöntemin 

metodolojik sunumunun ardından uygulama adımları ayrıntılı bir şekilde 

sunulmuş olup elde edilen katsayıların ve nedensellik ilişkilerinin nasıl 

yorumlanacağına ilişkin açıklamalar yapılmıştır.  

Sekizinci ve dokuzuncu bölümde ise örnek bir model üzerinden kitapta 

bölümler halinde anlatılan hususların tamamının işletildiği ARDL ve NARDL 

uygulama adımları yer almaktadır. 
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1. BÖLÜM 

VERİLERİN HAZIRLANMASI 

Verilerin Eviews paket programına aktarılmasında kullanılabilecek 

farklı yöntemler vardır. Bu yöntemlerden ilki verilerin manuel olarak işlenmesi 

yöntemidir. Ancak bu yöntemin operasyonel hata yapma riski gibi bazı 

dezavantajları bulunmaktadır. Bu yüzden verilerin programa aktarılmasında 

transfer yönteminin kullanılması daha uygun olacaktır. 

1.1. Verilerin Manuel Olarak İşlenmesi 

➢ Eviews programı açıldığında ekranın sol üst köşesinde bulunan “File ⇒ New 

⇒ Workfile” sekmesi işaretlenerek ya da “Ctrl + N” kısa yol kombinasyonu 

ile de Şekil 1.1’deki ekran açılabilir. 

Şekil 1.1. Verilerin Eviews Paket Programına Aktarılması: Birinci Adım 
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➢ Açılan ekranda yer alan “Workfile structure type” kısmında düzenli frekans 

aralıklarının olduğu veriler için “Dated-regular frequency” seçeneği, 

yapılandırılmamış düzenli frekans aralıklarının olmadığı durumlarda ise 

“unstructured/undated” seçeneği işaretlenir. Panel veri analizi yöntemiyle 

çalışılacaksa ve dengeli (gözlem değerleri tam olan) bir panel kullanılacaksa 

“Balanced Panel” seçeneği işaretlenir. Bu çalışma kapsamında zaman serisi 

analiz yöntemlerine ilişkin açıklamalar yapılacağından uygulamalı 

örneklerde “Dated-regular frequency” seçeneği işaretlenmiştir. 

➢ Frequency kısmından çalışma kapsamındaki veriler yıllık ise “Annual”, 

çeyreklik ise “Quarterly”, aylık ise “Monthly”, haftalık ise “Weekly”, 

günlük ise “Daily-5 day week veya Daily-7 day week” vb. seçeneklerden 

uygun olanı seçilir.  

➢ Uygun başlangıç ve bitiş tarihleri yazılıp “OK” sekmesi tıklanır. 

➢ Aşağıda Şekil 1.2’de görüldüğü üzere açılan ana ekranda sağ tıklanıp “New 

Object” sekmesi işaretlenir. Buradan “Series” seçilip “Name for object” 

kısmına serinin ismi yazılır ve “OK” sekmesi tıklanır. Ayrıca aynı işlem üst 

tarafta yer alan “Object” kısmından da gerçekleştirilebilir. 

Şekil 1.2. Verilerin Eviews Paket Programına Aktarılması: İkinci Adım 

 

➢ Yeni gelen X1 serisi çift tıklanıp gözlem değerleri boş (NA) ve korumalı 

olarak açılacaktır.  

➢ Açılan X1 serisi sağ tıklanıp “Edit +/-” sekmesi işaretlendiğinde pasif olan 

hücreler düzenlenebilir hale gelecektir.   

➢ Veriler aşağıda Şekil 1.3’te görüldüğü üzere ister klavyeden manuel olarak 

yazılabilir istenirse de kopyalanıp yapıştırılabilir. 

 



17 

 

Şekil 1.3. Verilerin Eviews Paket Programına Aktarılması: Üçüncü Adım 

 

1.2. Verilerin Transfer Edilmesi 

Verilerin manuel oluşturulması zaman kaybına ve operasyonel hatalara 

neden olabilir. Bu yüzden daha farklı yöntemler kullanılabilir. Bu yöntemlerden 

en pratiği verilerin Excel’den Eviews programına aktarılması ya da transfer 

edilmesidir. Aşağıda Şekil 1.4’te örneği sunulan Excel paket programında ilk 

sütunda tarih verisinin ardından bağımlı ve bağımsız değişkenlerin yer aldığı 

sütun başlıklarında Türkçe karakterlerin ve boşlukların olmadığı veriler için bu 

yöntem şu şekilde işletilebilir: 

Şekil 1.4. Örnek Veri Seti 

 

➢ Verilerin içerisinde olduğu Excel dosyası sağ tıklanır. 

➢ “Birlikte aç” sekmesinden Eviews programı seçilir. 
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➢ Ardından sırasıyla üç kez “sonraki” butonu, “Finish” ve “No” seçenekleri 

tıklanır. 

Böylece veriler Eviews programına aktarılmış olur. Benzer biçimde bir 

başka yöntem de şu şekildedir: 

➢ Eviews programında açılan ekranın sol üst köşesinde bulunan “File ⇒ 

Import ⇒ Import form file” sekmeleri işaretlenir. 

➢ Açılan ekranda “Dosya adı” penceresinden Excel dosyası bulunarak “Aç” 

seçeneği tıklanır.  

➢ Ardından sırasıyla üç kez “sonraki” butonu, “Finish” ve “No” seçenekleri 

tıklanır. 

Veriler bu şekilde de Eviews programına aktarılabilir. Bu sürecin her 

defasında işletilmemesi için verilerin kaydedilmesi araştırmacıya zaman 

kazandıracaktır. Verilerin Eviews dosyası olarak kaydedilmesi için aşağıdaki 

adımlar izlenmelidir: 

➢ Eviews ana ekranındayken “File ⇒ Save As” sekmesi işaretlenir. 

➢ Açılan ekranda kaydedilmek istenen yer seçilerek “Kaydet” seçeneği 

tıklanır. 

➢ Böylece “.wf1” uzantılı Eviews Workfile dosyası kaydedilmiş olur. Bundan 

sonra “.wf1” uzantılı bu dosyaya çift tıklanarak veya sağ tıklanıp “birlikte 

aç” sekmesinden Eviews işaretlenerek kolayca açılabilir. 

 1.3. Verilerin Reelleştirilmesi 

Uygulanacak analiz yöntemlerinin tamamında, analize başlamadan önce 

verilerin analizlere uygun hale getirilmesi gerekmektedir. Bu amaç 

doğrultusunda ilk olarak verilerin deflate edilmesi ya da reelleştirilmesi işlemi 

üzerinde durulacaktır. Verilerin reel olarak analizlere dahil edilmesi önemlidir 

çünkü fiyat artışlarının etkisini bünyelerinde barındıran nominal değişkenlerden 

elde edilen bulguları reel bir değermiş gibi yorumlamak yanıltıcı sonuçlara 

neden olacaktır. Öte yandan literatürde nominal değişkenlerle yapılan pek çok 

çalışma bulunmaktadır. Ancak bu çalışmaların büyük bir kısmı, bulguların 

yorumlanmasında verilerin nominal olduğunu göz ardı etmediği için sorun teşkil 

etmeyecektir. Bununla birlikte açıklayıcı-bağımsız değişkenlerin açıklanan-

bağımlı değişken üzerindeki etkisi reel olarak tespit edilmek istenildiğinde analiz 

kapsamındaki değişkenlerin reel hale getirilmesi gerekecektir. 

1.3.1. Yüzdesel Değişkenlerin Reelleştirilmesi 

Bu başlık altında öncelikle yüzdesel değerlerin reelleştirilmesi işlemi 

üzerinde durulacak olup bir sonraki başlıkta yüzdesel olmayan değerler için 

reelleştirme adımları açıklanacaktır.  
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Örnek olay: Reel faiz oranı verisine ya da reel getiri oranına ihtiyaç duyulması 

halinde Irving Fisher’e ait olan aşağıdaki formül kullanılabilir (Granville ve 

Mallick, 2004: 87):  

1 + 𝑟 =
1 + 𝑛

1 + 𝑒
                                                                                                                             (1) 

Denklem 1’de ifade edilen; “r” reel faizi (getiri), “n” nominal faizi 

(getiri), “e” enflasyon oranını göstermektedir. 

Örneğin beklenen enflasyon oranının %15 olduğu bir konjonktürde nominal faiz 

oranı %30 olan devlet tahvilinden beklenen reel getiri oranının hesaplanması şu 

şekildedir: 

1 + 𝑅𝑒𝑒𝑙 𝑔𝑒𝑡𝑖𝑟𝑖 =
(1 + 0,30)

(1 + 0,15)
=

1,30

1,15
 

1 + 𝑅𝑒𝑒𝑙 𝑔𝑒𝑡𝑖𝑟𝑖   1,13 

𝑅𝑒𝑒𝑙 𝑔𝑒𝑡𝑖𝑟𝑖   0,13 veya yüzde olarak ifade edilmek istenirse %13’tür. 

Bu işlemler Excel paket programı üzerinden örnek veri setine rahatlıkla 

uygulanabilir.  

➢ Boş hücreye “=” (eşittir) yazılır. 

➢ Ardından parantez açılır “(”. 

➢ 1+ yazılıp A2 hücresine tıklanıp parantez kapatılır “)”. 

➢ Devamında bölme işareti “/” seçilip tekrardan parantez açılır “(”.   

➢ Daha sonra 1+ yazılıp B2 hücresi tıklanarak parantez kapatılır “)”.  

➢ Son olarak “enter” tuşuna basılır. 

➢ Yapılan hesaplamanın tüm gözlem değerlerine veya sütuna uygulanmak 

istenmesi durumunda yeşil dikdörtgen kutunun sağ alt köşesi çift tıklanır. 

Böylece veriler aşağıda Şekil 1.5’teki gibi deflate edilmiş ya da reelleştirilmiş 

olur. 

Şekil 1.5. Excel’de Reel Getirinin Hesaplanması 
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1.3.2. Yüzdesel Olmayan Değişkenlerin Reelleştirilmesi 

Yüzdesel olmayan değişkenlerin reel hale getirilmesinde ya da deflate 

edilmesinde ise şöyle bir yöntem izlenebilir: 

Örnek olay: Çalışmada reel para arzı verisine ihtiyaç duyulması halinde 

aşağıdaki formül kullanılabilir.  

𝑅𝑒𝑒𝑙 𝑃𝑎𝑟𝑎 𝐴𝑟𝑧𝚤 =
𝑁𝑜𝑚𝑖𝑛𝑎𝑙 𝑃𝑎𝑟𝑎 𝐴𝑟𝑧𝚤

𝑇ü𝑘𝑒𝑡𝑖𝑐𝑖 𝐹𝑖𝑦𝑎𝑡 𝐸𝑛𝑑𝑒𝑘𝑠𝑖 (2003 𝐵𝑎𝑧 𝑌𝚤𝑙𝑙𝚤)
× 100 

Bu işlemler Excel paket programı üzerinden örnek veri setine rahatlıkla 

uygulanabilir. 

➢ Boş hücreye “=” (eşittir) yazılır. 

➢ Ardından B2 hücresi tıklanıp “/” (bölme işareti) tuşuna basılır. 

➢ Daha sonra C2 hücresi tıklanır. 

➢ “*”(çarpı) tuşuna basıp 100 yazılır. Son olarak “enter” tuşuna basılır. 

➢ Yapılan hesaplamanın tüm gözlem değerlerine veya sütuna uygulanmak 

istenmesi durumunda yeşil dikdörtgen kutunun sağ alt köşesi çift tıklanır.  

Böylece veriler aşağıda Şekil 1.6’daki gibi deflate edilmiş ya da reelleştirilmiş 

olur. 

Şekil 1.6. Excel’de Verilerin Reelleştirilmesi: Örnek Uygulama 

 

1.4. Verilerin Logaritmalarının Alınması 

Oransal olmayan değişkenlere ait analiz sonuçlarının yüzdesel olarak 

yorumlanmak istenmesi halinde değişkenlerin logaritmik dönüşüm işlemleri 

gerek Excel gerekse de Eviews paket programında kolaylıkla yapılabilir. Ayrıca 

değişkenlerin doğal logaritmalarının alınması aykırı değerleri törpüler.  

Örnek olay: Excel paket programı kullanılarak X1 değişkeninin doğal 

logaritmasının alınmak istenmesi durumunda; 

➢ Boş hücreye “=” (eşittir) yazılır. 
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➢ Ardından “LN” yazılır. Sonra parantez “(” açılır. 

➢ Devamında sayı seçilip parantez “)” kapatılır.   

➢ Daha sonra “enter” tuşuna basılır. 

➢ Yapılan hesaplamanın tüm gözlem değerlerine veya sütuna uygulanmak 

istenmesi durumunda yeşil dikdörtgen kutunun sağ alt köşesi çift tıklanır. 

Böylece aşağıda Şekil 1.7’de sunulduğu üzere değişkenlerin doğal logaritmaları 

alınmış olur. 

Şekil 1.7. Excel’de Logaritmik Dönüşüm İşleminin Uygulanması 

 

Örnek olay: Eviews paket programı kullanılarak X1 değişkeninin doğal 

logaritması alınmak istenmesi durumunda; 

➢ Bir veri seti Eviews programında açıldıktan sonra gelen ekranda 

“Command” sekmesi tıklanır. 

➢ Açılan ekrana “genr lnx1=log(x1)” yazılıp “enter” tuşuna basılır. 

➢ Eviews ekranında logaritması alınmış yeni bir seri olarak “lnx1” serisi 

türetilmiş olur. Uygulama adımlarının Eviews çıktısı aşağıda Şekil 1.8’de 

sunulmuştur. 

Şekil 1.8. Eviews Logaritma Alma Örnek Uygulaması 
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1.5. Verilerin Mevsimsel Etkilerden Arındırılması 

Özellikle aylık, üç aylık gibi veriler mevsimsel etkileri bünyelerinde 

taşımaktadır. Sonuçların güvenilirliği için mevsimsel etkilerden arındırma 

işlemlerinin uygulanması büyük önem arz etmektedir. Mevsimsel etkilerden 

arındırma işlemleri için “Census-X12, Census-X13, TRAMO/SEATS, STL 

decomposition ve moving average” gibi farklı yöntemler vardır. Bu çalışmada 

örnek olarak “STL decomposition” yöntemi uygulanacaktır.  

➢ Eviews programında logaritması alınmış seri çift tıklanır. 

➢ Açılan ekranda aşağıda Şekil 1.9’da görüldüğü üzere “Proc ⇒ Sesioanl 

Adjustment ⇒ STL decomposition” sekmeleri sırasıyla seçilir ve “OK” 

seçeneği tıklanır.  

Şekil 1.9. Eviews Mevsimsel Etkilerden Arındırma İşlemi 

 

Böylece Eviews ana ekrana “_sa” uzantılı “lnx1_sa” serisi mevsimsel etkilerden 

arındırılmış yeni seri olarak üretilmiş olur.  

1.6. Verilerin Grafiklerinin Çizilmesi 

Ekonometrik analizlerde değişkenlerin güçlü bir trend taşımaması 

gerekmektedir. Zaman yolu grafikleri, değişkenlerin trend taşıyıp 

taşımadıklarına ilişkin bir ön izlenim verir. Ayrıca değişkenlerin sahip olduğu 

önemli yapısal kırılmalar, eğim katsayılarının işaretleri ya da sabitli bir modelle 

çalışılıp çalışılmayacağı hakkında değerli bilgiler sunmaktadır. 

Bu grafikler gerek Excel gerekse de Eviews paket programında 

kolaylıkla çizilebilir.  

➢ Eviews programında logaritması alınmış ve mevsimsel etkilerden 

arındırılmış seri çift tıklanır. 

➢ Açılan ekranda “View ⇒ Graph” sekmeleri sırasıyla seçilir ve “OK” 

seçeneği tıklanır.  
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➢ Serinin grafiği çizilmiş bir halde ekrana gelir. Grafiğe sağ tıklayıp “Copy to 

clipboard” seçeneği tıklanıp ya da “Ctrl + C” kısa yoluyla Word dosyasına 

grafik yapıştırılabilir. 

Bu işlem yukarıda anlatıldığı gibi tek bir veri için yapılabileceği gibi birden çok 

değişken veya değişkenlerin tamamı için de uygulanabilir. 

➢ Eviews programında grafiği çizilmek istenen tüm seriler seçilir. Bu seçim 

şöyle yapılır: klavyeden “Ctrl” tuşu basılı iken “Enter” tuşuna basılır. 

➢ İmleç seçili verilerin üzerindeyken sağ tıklanır. Açılan ekranda “Open ⇒ As 

Group” sekmeleri sırasıyla seçilir. Seçilen tüm değişkenlere ilişkin gözlem 

değerleri aynı ekranda açılır. 

➢ Açılan bu ekranda “View ⇒ Graph” sekmeleri sırasıyla seçilir. Eğer 

verilerin tamamı tek grafik üzerinden gösterilmek isteniyorsa “Details” 

kısmında yer alan “Multiple series” kısmından “Single graph” seçilerek 

“OK” seçeneği aşağıda Şekil 1.10’da görüldüğü gibi tıklanır. (Not: “View 

⇒ Graph” sekmelerinden direkt “OK” seçeneği tıklanarak da aynı grafik 

elde edilmiş olur.) 

Şekil 1.10. Eviews Tekli Grafik Oluşturma Aşamaları 

 

➢ Eğer seriler ayrı ayrı grafikler halinde çizilmek istenirse “View ⇒ Graph” 

sekmeleri seçilir. “Details” kısmında yer alan “Multiple series” kısmından 

“Multiple graphs” seçilerek “OK” seçeneği aşağıda Şekil 1.11’de görüldüğü 

gibi tıklanır.  
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Şekil 1.11. Eviews Çoklu Grafik Oluşturma Aşamaları 

 

➢ Grafik ekranına sağ tıklayıp “Copy to clipboard” seçeneği işaretlenerek ya 

da “Ctrl + C” kısa yoluyla Word dosyasına yapıştırılabilir. 

➢ Grafik sekmesinin içerisinde grafiklerin türüne (çizgi, sütun, pasta grafik) ve 

eksenlerin biçimlendirmesine (yazı tipi, boyutu veya grafik başlığını 

konumlandırma) ilişkin çok sayıda seçenek bulunmaktadır.  
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2. BÖLÜM 

TANIMLAYICI/BETİMLEYİCİ İSTATİSTİKLER 

Tanımlayıcı istatistik değerleri çalışma kapsamında ele alınan 

değişkenlere ilişkin önemli bilgiler sunmaktadır. Ele alınan zaman periyodu 

çerçevesinde, oluşturulan modelde yer alan değişkenlerin normal dağılıp 

dağılmadığı, en küçük ve en büyük değerleri, ortalama ve medyan değerleri, 

basıklığı, çarpıklığı, gözlem sayısı hakkında bilgiler edinilebilir. Değişkenlerin 

tanımlayıcı istatistiklerinin hesaplanmasında farklı programlar kullanılmakla 

birlikte bu çalışmada Excel ve Eviews uygulamaları anlatılacaktır. 

2.1. Excel’de Tanımlayıcı İstatistiklerin Oluşturulması  

Tanımlayıcı, betimleyici ya da özet istatistik tablosunun 

oluşturulmasında farklı yöntemler kullanılabilir. Bu yöntemlerden ilki 

tanımlayıcı istatistiklerin Excel paket programında oluşturulmasıdır. Excel paket 

programında “Veri” sekmesinin altında “Veri Çözümleme” sekmesi mevcut ise 

direkt hesaplama yapılabilir. Bu sekme mevcut değilse ilk olarak bu sekmenin 

eklenmesi gerekmektedir. “Veri Çözümleme” eklentisi aşağıdaki adımlar 

izlenerek eklenebilir: 

➢ Excel paket programında sol en üst köşede bulunan “Dosya” sekmesi 

tıklanır.  

➢ Açılan pencerenin sol en alt kısmında bulunan “Seçenekler” kısmı tıklanarak 

aşağıda Şekil 2.1’de sunulan pencere açılır. 

Şekil 2.1. Veri Çözümleme Sekmesinin Eklenmesi 
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➢ Açılan pencerede “Eklentiler” sekmesi tıklanır. 

➢ “Çözücü Eklentisi” ve “Çözümleme Araç Takımı” eklentisi işaretlenip 

“Tamam” tuşu işaretlenir. 

➢ Bu adımların ardından Excel ana sayfasında bulunan “Veri” sekmesi 

tıklandığında Aşağıda Şekil 2.2’de görüldüğü üzere sağ üst tarafına 

“Çözücü” ve “Veri Çözümleme” araçlarının (siyah dikdörtgen alan) geldiği 

görülür. 

Şekil 2.2. Veri Çözümleme Araçlarının Eklenmiş Hali 

 

“Veri Çözümleme” sekmesinin eklenmesinin ardından tanımlayıcı istatistikler 

hesaplanabilir. Excel paket programında tanımlayıcı istatistikleri oluşturma 

adımları şu şekildedir: 

➢ Excel paket programının “Veri” sekmesinin sağ üst köşede bulunan “Veri 

Çözümleme” sekmesi tıklanır.  

➢ Ardından açılan veri çözümleme penceresinden “Tanımlayıcı İstatistik” 

seçilerek “Tamam” sekmesine tıklanır. Böylece aşağıda Şekil 2.3’te sunulan 

“Tanımlayıcı İstatistik” penceresi açılır. 

Şekil 2.3. Tanımlayıcı İstatistiklerin Hesaplanma Aşamaları 

 

➢ “Tanımlayıcı İstatistik” penceresinin üst tarafında yer alan “Giriş Aralığı” 

sekmesinin içerisine bir kez tıklanarak sütunların en üstünde yer alan sütun 

isimleri de dahil olmak üzere verilerin tamamı seçilir. (Not: Bu seçim 

klavyeden de yazılabilir). 
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➢ Gruplandırma sekmesinde “Sütunlarda” seçeneği işaretliyken “Etiketler İlk 

Satırda” sekmesi işaretlenir. Bu kısım işaretlenmezse sayısal olmayan veri 

içerdiğine ilişkin uyarı ile karşılaşılır ve hesaplama yapılamaz. (Not: Veri 

isimleri olmadan yapılan seçimlerde bu uyarı alınmaz). 

➢ Ardından “Çıkış” seçenekleri kısmı için arzu edilen seçenek işaretlenir. Bu 

çalışmada “Yeni sayfa” tercih edilmiştir.  

➢ “Tanımlayıcı İstatistik” penceresinin alt tarafında yer alan “Özet 

İstatistikler” kısmı seçilir. İhtiyaç duyulması halinde “Ortalama Güvenirlik 

Düzeyi”, “En Büyük” ve “En Küçük” kısımları da seçilebilir. 

➢ “Tamam” sekmesi tıklanır ve böylece aşağıda Şekil 2.4’te gösterilen 

tanımlayıcı istatistik tablosu elde edilmiş olur. 

Şekil 2.4. Excel Tanımlayıcı İstatistik Tablosu 

 

2.2. Eviews’te Tanımlayıcı İstatistiklerin Oluşturulması 

Tanımlayıcı, betimleyici ya da özet istatistik tablosunun 

oluşturulmasında kullanılabilecek daha pratik bir yöntem Eviews paket 

programının kullanılmasıdır. Tanımlayıcı istatistikler, Eviews paket programı 

aracılığıyla aşağıdaki adımlar izlenerek kolaylıkla oluşturulabilir (Not: Verilerin 

eviews paket programına transferi için bir önceki başlık incelenebilir). 

➢ Aşağıda Şekil 2.5’te sunulduğu üzere Eviews paket programında tanımlayıcı 

istatistik bilgileri istenen tüm seriler seçilir. Bu seçim şöyle yapılır: klavyede 

“Ctrl” tuşu basılı iken tüm serilere tıklanır. Bu seçimde zorunluluk olmasa 

da literatürde yaygın olan ilk olarak bağımlı değişkenin daha sonra bağımsız 

değişkenlerin seçilmesi şeklindedir. 
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➢ İmleç seçili verilerin üzerindeyken sağ tıklanır açılan ekranda “Open ⇒ As 

Group” sekmeleri sırasıyla seçilir. Seçilen tüm değişkenlere ilişkin gözlem 

değerleri aynı ekranda açılır. 

➢ Bu açılan ekran üzerinden “View ⇒ Descriptive Stats” tıklandıktan sonra 

“Comman Sample” ya da “Individual Sample” seçeneklerinden birisi seçilir. 

Bu iki seçenek arasındaki fark şudur: “Comman Sample” seçeneği seçilirse 

en büyük ortak gözlem sayısına göre bu istatistiksel sonuçlar hesaplanır.  

Şekil 2.5. Eviews Tanımlayıcı İstatistik Tablosu 

 

Örneğin serilerden bir tanesinin gözlem sayısı 63 diğerlerinin gözlem 

sayısı 68 olsun. “Comman Sample” seçeneği seçilirse Şekil 2.6’da 

görülebileceği üzere tüm değişkenlerin tanımlayıcı istatistik değerleri 63 

gözleme karşılık gelen ortak gözlemler için hesaplanacaktır.  

Şekil 2.6. Eviews Ortak Gözleme Göre Tanımlayıcı İstatistik Tablosu 
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➢ Öte yandan “Individual Sample” seçeneği seçilirse her bir değişkenin 

maksimum gözlem sayısına göre hesaplama yapacaktır. Şekil 2.7’de 

görülebileceği üzere serilerden bir tanesi için tanımlayıcı istatistik değerleri 

63 gözlem değeri için hesaplanacakken diğer seriler için 68 gözleme göre 

hesaplama yapılacaktır. 

Şekil 2.7. Eviews Değişken Odaklı Tanımlayıcı İstatistik Tablosu 

 

Tanımlayıcı istatistik tablosu toplu bir şekilde değil de her bir değişken 

için ayrı ayrı hesaplanmak istenirse şu adımlar takip edilmelidir. 

➢ Eviews paket programı ana ekranında tanımlayıcı istatistik bilgileri istenen 

seri çift tıklanarak açılır.  

➢ Açılan seriye ilişkin pencerede “View ⇒ Descriptive Statistics&Tests ⇒ 

Stats Table” sekmeleri sırasıyla seçilir. Böylece tek bir değişkene ilişkin 

tanımlayıcı istatistikler aşağıda Şekil 2.8’deki gibi elde edilmiş olur. 

Şekil 2.8. Tek Değişken İçin Eviews Tanımlayıcı İstatistik Tablosu 
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Tanımlayıcı istatistik tablosunda yer alan değerlerin açıklamaları şu şekildedir: 

➢ Mean: Değişkenin ortalama değerini gösterir. Değişkenin aldığı değerler 

toplamının gözlem sayısına bölünmesiyle elde edilir.  

➢ Median: Değişkenin medyan değerini ya da ortanca değerini gösterir. 

Veriler küçükten büyüğe sıralandığında serinin tam ortasında yer alan 

değerdir. Aykırı ya da uç değerlerden etkilenmemesi bu değerin en önemli 

özelliklerinden biridir. Örneğin serinin içerisinde diğer gözlem değerlerine 

göre çok yüksek (aykırı-uç) bir değer varsa ortalama değeri artıracaktır. 

Ancak bu yüksek değer ortanca değeri etkilemeyecektir (Acar, 2001: 67). 

➢ Maximum: Değişkenin gözlem sayısı kapsamında aldığı en yüksek değeri 

gösterir. 

➢ Minimum: Değişkenin gözlem sayısı kapsamında aldığı en düşük değeri 

gösterir. 

➢ Std. Dev.: Değişkenin standart sapma değerini gösterir. Verilerin 

ortalamadan en az ne kadar uzaklıkta yoğunlaştığını gösterir. Standart sapma 

büyüdükçe dağılım yaygınlaşır. 

Öte yandan gözlem sayısı ne kadar fazla ise standart sapma değerinin de o 

kadar küçük olması beklenir. Standart sapma değerinin küçük olması, 

parametrelerin daha isabetli tahmin edilmesini sağlayacaktır. 

➢ Skewness: Değişkenin çarpıklık değerini gösterir. Normal dağılım için 

“Skewness” değerinin sıfır (0) olması beklenir. “Skewness” değerinin 

negatif olması serinin sola çarpık ve sağ kuyruğunun daha uzun olduğuna 

işaret ederken pozitif olması sağa çarpık ve sol kuyruğunun daha uzun 

olduğu anlamına gelir (Kula ve Baykut, 2017: 32). 

➢ Kurtosis: Değişkenin basıklık değerini gösterir. Normal dağılım için 

“Kurtosis” değerinin üç (3) olması beklenir. “Kurtosis” değerinin üçten 

küçük olması serinin normal dağılımdan daha basık olduğunu ve daha geniş 

bir alana yayıldığına işaret eder. Öte yandan “Kurtosis” değerinin üçten 

büyük olması serinin normal dağılıma göre daha sivri olduğunu gösterir 

(Şahin vd., 2015: 113). 

➢ Jarque-Bera test istatistiği: Değişkenlerin normal dağılıma uygun olup 

olmadığını gösterir. Serinin normal dağılıma uygun olabilmesi için “Jarque-

Bera” test istatistiğinin olasılık değerinin (Probability) 0.1’den büyük olması 

gerekir (Demir ve Balkı, 2019: 20; Göksu, 2022: 855). 

➢ Observations: Gözlem sayısını gösterir.  
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3. BÖLÜM 

KORELASYON MATRİSİ 

Korelasyon matrisi tablosunda, modelde yer alan tüm değişken çiftlerine 

ilişkin korelasyon katsayıları yer alır. Korelasyon katsayıları ise değişken çiftleri 

arasındaki doğrusal ilişkinin yönü ve gücünü ölçer. Ayrıca bağımsız 

değişkenlerin beklenen işaret değerleri (+/-) için fikir verir. Bu bilgilerin dışında 

korelasyon matrisi, oluşturulan modelde çoklu doğrusal bağlantı sorunu olup 

olmadığını tespit etmeye yarar. Çoklu doğrusal bağlantı (multicollinearity); 

modelde yer alan bağımsız değişkenler arasında yüksek korelasyon 

katsayılarının olması durumudur. Zaman serisi analizlerinin önemli bir 

varsayımı, bağımsız değişkenler arasında yüksek korelasyonun olmamasıdır 

(Voss, 2005). Bu sorun her bir bağımsız değişkenin bağımlı değişken üzerindeki 

etkilerini görmemizi engeller. Başka bir deyişle bu sorun olduğu durumda, 

bağımlı değişkendeki değişmelerin hangi bağımsız değişkenden kaynaklandığını 

tam olarak tespit etmemize imkân yoktur. Bu yüzden analizlerde mutlaka dikkate 

alınmalıdır. 

Korelasyon matrisinde yer alan katsayılar -1 ile +1 arasında değişen 

değerler alır. Katsayının pozitif olması, değişkenlerden biri arttıkça diğerinin de 

arttığını gösterirken katsayının negatif olması değişkenlerden biri artarken 

diğerinin azaldığını gösterir. Katsayının 0 (sıfır) olması ise değişkenlerin ilişkili 

olmadığını gösterir (Akoglu, 2018). Çoklu doğrusal bağlantı sorunu olmaması 

için bağımsız değişken ikilileri arasındaki korelasyon katsayılarının 0,80’in 

altında olması beklenir (Grewal vd., 2004). Değişkenlerin korelasyon matrisi 

oluşturmada farklı programlar kullanılmakla birlikte bu çalışmada ilk önce Excel 

daha sonra Eviews uygulamaları anlatılacaktır. 

3.1. Excel’de Korelasyon Matrisi Oluşturma Aşamaları 

Excel paket programında “Veri” sekmesinin altında “Veri Çözümleme” 

eklentisi mevcut ise korelasyon matrisi direkt olarak oluşturulabilecekken bu 

eklenti mevcut değilse ilk olarak bu eklentinin eklenmesi gerekmektedir. Bu 

eklentinin nasıl eklendiği bir önceki başlıkta detaylı bir şekilde anlatıldığından 

bu başlıkta tekrarı yapılmayacaktır. Excel paket programında korelasyon matrisi 

oluşturma adımları şu şekildedir: 

➢ Excel paket programının “Veri” sekmesinin sağ üst köşesinde bulunan “Veri 

Çözümleme” sekmesi tıklanır.  

➢ Ardından aşağıda Şekil 3.1’de sunulan veri çözümleme penceresinden 

“Korelasyon” seçilerek “Tamam” sekmesine tıklanır.  
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Şekil 3.1. Korelasyon Penceresinin Açılması 

 

Böylece aşağıda Şekil 3.2’de sunulan “Korelasyon” penceresi açılır. 

Şekil 3.2. Korelasyon Penceresi 

 

➢ “Korelasyon” penceresinin üst tarafında yer alan “Giriş Aralığı” sekmesinin 

içerisine bir kez tıklanır. İlk satırda yer alan sütun isimleri (veri etiketleri) de 

dahil olmak üzere verilerin tamamı seçilir. (Not: Bu seçim klavyeden de 

yazılabilir). 

➢ Gruplandırma sekmesinde “Sütunlarda” seçeneği işaretliyken “Etiketler İlk 

Satırda” sekmesi işaretlenir. Bu kısım işaretlenmezse sayısal olmayan veri 

içerdiğine ilişkin uyarı ile karşılaşılır ve hesaplama yapılamaz. (Not: Veri 

isimleri olmadan yapılan seçimlerde bu uyarı alınmaz). 

➢ Ardından “Çıkış” seçenekleri kısmı için arzu edilen seçenek işaretlenir. Bu 

çalışmada “Yeni sayfa” tercih edilmiştir.  

➢ “Tamam” sekmesi tıklanır ve böylece aşağıda Şekil 3.3’te gösterilen 

korelasyon matrisi tablosu elde edilmiş olur. 
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Şekil 3.3. Excel Korelasyon Matrisi Tablosu 

 

Bu tablonun yorumlanmasına ilişkin açıklamalar, Eviews paket program 

aşamalarının gösterilmesinin ardından yapılacaktır. 

3.2. Eviews’te Korelasyon Matrisi Oluşturma Aşamaları 

Korelasyon matrisi tablosunun oluşturulmasında kullanılabilecek bir 

diğer yöntem Eviews paket programının kullanılmasıdır. Korelasyon matrisi, 

Eviews paket programı aracılığıyla aşağıdaki adımlar izlenerek kolaylıkla 

oluşturulabilir (Not: Verilerin eviews paket programına transferi için 1.Bölüm 

incelenebilir). 

➢ Eviews paket programında ilk olarak bağımlı değişken daha sonra da 

bağımsız değişkenler seçilir. Bu seçim şöyle yapılır: klavyede “Ctrl” tuşu 

basılı iken Mouse’un sol tuşu kullanılarak ilk önce bağımlı değişkene daha 

sonra bağımsız değişkenlere tıklanır. 

➢ İmleç seçili verilerin üzerindeyken sağ tıklanır. Açılan ekranda “Open ⇒ As 

Group” sekmeleri sırasıyla seçilir. Seçilen değişkenlere ilişkin gözlem 

değerleri aynı ekranda açılır. 

➢ Aşağıda Şekil 3.4’te sunulan ekran üzerinden “View ⇒ Covariance 

Analysis” sekmesi tıklanır. 

Şekil 3.4. Eviews Korelasyon Matrisi Oluşturma: Birinci Adım 
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➢ Böylece aşağıda Şekil 3.5’te sunulan “Covariance Analysis” penceresi 

açılmış olur. Bu pencerede “Correlation” seçeneği işaretlenir. “Layout” 

kısmından nasıl bir raporlama yöntemi isteniyorsa o yöntem seçilir. Bu 

çalışmada “Single table” seçeneği tercih edilmiştir. Son olarak “OK” 

seçeneği tıklanır. 

Şekil 3.5. Eviews Korelasyon Matrisi Oluşturma: İkinci Adım 

 

Böylece aşağıda Şekil 3.6’da sunulan korelasyon matrisi tablosu elde edilmiş 

olur. 

Şekil 3.6. Eviews Korelasyon Matrisi Tablosu 

 

Şekil 3.3 ve Şekil 3.6’da sunulan korelasyon matrisi tabloları 

incelendiğinde her iki programdan elde edilen sonuçların aynı olduğu görülür. 

Böylece sonuçların sağlaması yapılmış olup operasyonel hataların önüne 

geçilmiştir. Modelde bağımsız değişken olarak yer alan X1 değişkeninin X2 
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değişkeniyle olan korelasyon katsayısı 0.78, X1 değişkeninin X3 değişkeniyle 

olan korelasyon katsayısı 0.29 ve X3 değişkeninin X2 değişkeniyle olan 

korelasyon katsayısı 0.23’tür. Bu sonuçlara göre bağımsız değişkenler arasında 

çoklu doğrusal bağlantı (multicollinearity) sorunu olmadığı açıktır. Çünkü 

korelasyon katsayılarının tamamı 0,80’in altındadır (Balkı, 2023). 

Bağımlı değişken olan Y ile bağımsız değişkenlerden X1 ve X2 

arasındaki yüksek ve pozitif korelasyon dikkat çekicidir. Öte yandan Y ile X3 

arasında düşük ve pozitif korelasyon vardır. Dolayısıyla oluşturulan model 

çerçevesinde bağımsız değişkenlerin tamamının beklenen işaret değerleri 

pozitiftir. 

Korelasyon analizi kapsamında verilerin görselleştirilmesi açısından her 

bir değişkenin kendisiyle ve diğer değişkenlerle olan ilişkisi saçılım grafiğiyle 

de gösterilebilir. Bu grafiği elde etmek için şu adımlar izlenir: 

➢ Eviews paket programında ilk olarak bağımlı değişken daha sonra da 

bağımsız değişkenler seçilir.  

➢ İmleç seçili verilerin üzerindeyken sağ tıklanır. Açılan ekranda “Open ⇒ As 

Group” sekmeleri sırasıyla seçilir. Seçilen değişkenlere ilişkin gözlem 

değerleri aynı ekranda açılır. 

➢ Aşağıda Şekil 3.7’de sunulan ekran üzerinden “View ⇒ “Graph” sekmesi 
tıklanır. 

Şekil 3.7. Eviews Saçılım Grafiği: Birinci Adım 

 

➢ Aşağıda Şekil 3.8’de sunulan “Graph Option” penceresi üzerinden “Scatter” 

ve “Scatterplot matrix” seçilir ve son olarak da “OK” seçeneği tıklanır.  
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Şekil 3.8. Eviews Saçılım Grafiği: İkinci Adım 

 

Böylece korelasyon matrisi tablosunun görselleştirilmiş halini ifade eden ve 

aşağıda Şekil 3.9’da sunulan saçılım grafikleri elde edilmiş olur.  

Şekil 3.9. Eviews Saçılım Grafiği 

0

200,000,000

400,000,000

600,000,000

Y

300,000,000

400,000,000

500,000,000

600,000,000

X
1

200

300

400

500

600

700

X
2

10

15

20

25

30

35

0 200,000,000 600,000,000

Y

X
3

300,000,000 500,000,000

X1

200 300 400 500 600 700

X2

10 15 20 25 30 35

X3  

 



37 

 

4. BÖLÜM 

BİRİM KÖK TESTLERİ 

Serilerin birim kök içermeleri ya da durağan olmaması serinin geçmişte 

aldığı değerlerin etkisi altında kaldığını gösterir. Örneğin gayri safi yurtiçi hasıla 

değişkenin düzey değerinde durağan olmaması ya da birim kök içermesi 

sebebiyle alınan birinci dereceden fark alma işleminin ardından uygulanan 

testler sonucunda durağan çıkması ya da birim kök içermemesi şöyle 

yorumlanabilir: Gayri safi yurtiçi hasıla değişkenin üzerinde, bu değişkenin bir 

dönem gecikmeli değerlerinin (bir dönem önce aldığı değerlerin) etkili olduğunu 

gösterir.  

Ekonomik değişkenlerin büyük bir kısmı doğası gereği genellikle 

durağanlıktan yoksundur. Durağan olmayan serilerle yapılan analizler ise hatalı 

sonuçlar verebilir. Ekonometrik analizlerde bağımlı değişkenle bağımsız 

değişken(ler) arasındaki ilişkilerin anlamlı olması için değişkenlerin güçlü 

eğilimler/trendler taşımaması istenir. Başka bir deyişle değişkenlerin sabit bir 

ortalama etrafında dalgalanması istenir. Ancak zaman serileri belirgin bir trend 

içeriyorsa değişkenler arasındaki ilişkilerin sahte olma olasılığı yüksektir. 

Dolayısıyla değişkenler arasındaki ilişkilerin gerçek bir ilişkiyi mi yoksa sahte 

bir ilişkiyi mi yansıttığı zaman serilerinin durağan olup olmamasıyla yakından 

ilişkilidir. Bu sebeple değişkenlerin birim kök içermemesi analizler açısından 

hayati önem taşır.  

Birim kök testlerinin bir diğer önemi, kullanılacak olan analiz yöntemine 

karar vermemize olanak sağlamasıdır. Kullanılacak analiz yöntemi, bağımlı ve 

bağımsız değişkenlere uygulanacak birim kök testi sonuçlarına göre 

değişecektir.  

Birim kök testlerinin içerisinde yer alan modellerin hangisine göre 

yorumlanacağı grafiklere bakılarak tespit edilebilir. Örneğin oluşturulan 

grafikler neticesinde seri bünyesinde bir trend barındırıyorsa trendli modellere 

göre değerlendirme yapmak gerekir. Öte yandan oluşturulan grafiklerin 

başlangıç noktası orijin değilse sabitli modelleri dikkate almak gerekir. Ancak 

serinin çıkış noktası orijin ise sabitsiz modellere göre değerlendirme yapmak 

gerekecektir. Çalışma kapsamında birim kök testine ilişkin tüm modeller (sabitli, 

sabitli ve trendli, sabitsiz ve trendsiz) oluşturulmuştur. Bu bölümde anlatılacak 

olan birim kök testleri geleneksel ve yapısal kırılmalı birim kök testi olarak iki 

alt başlıkta sunulacaktır. 

4.1. Geleneksel Birim Kök Testleri 

Bu başlık altında sunulacak olan birim kök testlerini geleneksel olarak 

tanımlamamızın sebebi literatürde en sık kullanılan birim kök testleri 

olmalarından kaynaklanmaktadır. Literatürde en sık kullanılan birim kök testleri 
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ADF (Augmented Dickey-Fuller) (Dickey ve Fuller, 1979), PP (Phillips-Perron) 

(Phillips ve Perron, 1988) ve KPSS (Kwiatkowski-Phillips-Schmidt-Shin) 

(Kwiatkowski vd. 1992) testleridir. Ancak hemen belirtmek gerekir ki 

anlatılacak olan bu testlerin yapısal kırılmaları dikkate almaması önemli bir 

eksiklik olarak karşımıza çıkar. Eğer çalışmada geleneksel birim kök testleri 

raporlanacaksa çalışmaya ekonometri alan yazınında yaşanan gelişmeler 

ışığında ortaya çıkan yapısal kırılmalı birim kök testleri de eklenerek sağlamlığı 

kontrol edilmelidir.  

4.1.1. ADF Birim Kök Testi 

ADF birim kök testinin null/boş ve alternatif hipotezleri şu şekildedir:  

H0: Seri birim köke sahiptir ya da durağan değildir. 

HA: Seri durağandır. 

ADF birim kök testi, Eviews paket programı aracılığıyla aşağıdaki 

adımlar izlenerek oluşturulabilir (Not: Verilerin Eviews paket programına 

transferi için 1.Bölüm incelenebilir). 

➢ Eviews paket programında ilk olarak birim kök testi yapılacak olan değişken 

çift tıklanarak aşağıda Şekil 4.1’de sunulan pencere açılır. 

➢ Bu açılan pencere üzerinden “View ⇒ Unit Root Test” sekmeleri sırasıyla 

seçilir.  

Şekil 4.1. ADF Birim Kök Testi: Birinci Adım 

 

➢ Aşağıda Şekil 4.2’de görüldüğü üzere “Test type” kısmından “Augmented 

Dickey-Fuller” seçeneği seçilir (pencere ilk açıldığında bu seçenek otomatik 

olarak gelir).  

➢ “Test for unit root in” kısmından ilk olarak level (düzey) işaretlenir.  
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➢ Ardından “Include in test equation” kısmından ilk olarak “Intercept” 

işaretlenir. 

➢ “Lag lenght” kısmı otomatik olarak “Schwarz Info Criterion” gelecektir. 

Ancak ihtiyaç duyulması halinde “Akaike Info Criterion”, “Hannan-quinn 

Criterion” vb. bilgi kriterleriyle de aynı test gerçekleştirilebilir. “Maximum 

lags” gözlem sayısına göre otomatik olarak seçili gelecektir.  

Şekil 4.2. Düzeyde Sabitli ADF Birim Kök Testi Seçim Prosedürü 

 

➢ Son olarak “OK” seçeneği tıklanarak Şekil 4.3’teki sunulan düzeyde sabitli 

ADF test sonucu ekranı gelecektir. 

Şekil 4.3. Düzeyde, Sabitli ADF Birim Kök Test Sonucu 
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➢ Yukarıda Şekil 4.3’ün üst kısmında serinin birim köke sahip olduğunu ifade 

eden H0 hipotezi ve alt kısmında test istatistiği yer almaktadır. Bu test 

istatistiği şu şekilde değerlendirilir: “t-Statistic” değeri olan 2.69 değeri 

“Test critical values” değerleriyle mutlak değer olarak karşılaştırılır. Şekil 

4.3’te görüldüğü üzere “t-Statistic” değeri %1 ve %5 kritik değerlerden (-

3.70 ve -2.98) mutlak değer olarak küçüktür. Bu yüzden istatistiki olarak %5 

anlamlılık düzeyinde H0 hipotezi kabul edilerek HA hipotezi reddedilir. 

Böylece serinin birim köke sahip olduğu diğer bir ifadeyle durağan olmadığı 

sonucuna ulaşılır.  

➢ Sabitli ve trendli model için açık olan ekran üzerinden tekrar “View ⇒ Unit 

Root Test” seçilir. Bu durumda aşağıda Şekil 4.4’te görüldüğü gibi “Trend 

and Intercept” seçilir. 

Şekil 4.4. Düzeyde Trendli ve Sabitli ADF Birim Kök Testi Seçim Prosedürü 

 

➢ “OK” seçeneğinin tıklanmasının ardından aşağıda Şekil 4.5’te sunulan 
düzeyde trendli ve sabitli ADF test sonucu ekranı gelecektir. 

Şekil 4.5. Düzeyde, Trendli ve Sabitli ADF Birim Kök Test Sonucu 
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➢ Yukarıda Şekil 4.5’te görüldüğü üzere “t-Statistic” değeri olan 2.62 değeri 

tüm kritik değerlerden (-4.34, -3.59 ve -3.23) mutlak değer olarak küçüktür. 

Bu yüzden H0 hipotezi kabul edilerek HA hipotezi reddedilir. Böylece sabitli 

model sonuçlarına benzer bir şekilde serinin birim köke sahip olduğu diğer 

bir ifadeyle durağan olmadığı sonucuna ulaşılır.  

➢ Sabitsiz ve trendsiz model için açık olan ekran üzerinden tekrar “View ⇒ 

Unit Root Test” seçilir. Bu sefer aşağıda Şekil 4.6’da görüldüğü gibi “None” 

seçeneği işaretlenir. 

Şekil 4.6. Düzeyde Trendsiz ve Sabitsiz ADF Birim Kök Testi Seçim 

Prosedürü 

 

➢ Ardından “OK” seçeneği tıklanarak aşağıda Şekil 4.7’de sunulan düzeyde 

trendsiz ve sabitsiz ADF test sonucu ekranı gelecektir. 

Şekil 4.7. Düzeyde Trendsiz ve Sabitsiz ADF Birim Kök Testi Sonucu 

 

➢ Benzer değerlendirmeler bu model için de yapılabilir. Yukarıda Şekil 4.7’de 

görüldüğü üzere “t-Statistic” değeri olan 0.40 değeri tüm kritik değerlerden 
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(-2.66, -1.95 ve -1.61) mutlak değer olarak küçüktür. Bu yüzden H0 hipotezi 

kabul edilerek HA hipotezi reddedilir. Böylece serinin birim köke sahip 

olduğu diğer bir ifadeyle durağan olmadığı sonucuna ulaşılır.  

➢ Sonuç olarak özetlemek gerekirse Y değişkeni “sabitli”, “sabitli ve trendli” 

ve “sabitsiz ve trendsiz” modellerin tamamında durağan değildir. 

Dolayısıyla serinin birinci farkında durağan olup olmadığını araştırmak için 

aynı işlemlerin “1st difference” seçilip tekrarlanması gerekir. Bu işlem için 

aşağıdaki adımlar takip edilir. 

➢ Açık olan ekran üzerinden tekrar “View ⇒ Unit Root Test” seçilir. Açılan 

ekran üzerinden “1st difference” seçilir sırasıyla “Intercept”, “Trend and 

Intercept” ve “None” seçilerek “OK” seçeneği her birisi için aşağıda Şekil 

4.8’deki gibi ayrı ayrı tıklanır. 

Şekil 4.8. Birinci Farkta ADF Birim Kök Testi Seçim Prosedürü 

 

➢ Birinci farktaki ADF test sonuçları aşağıda Şekil 4.9’da sunulmuştur. 

➢ Şekil 4.9’da sunulan birinci farklarda “trendli” ile “trendsiz ve sabitsiz” 

ADF birim kök testi sonuçlarına göre tüm “t-Statistic” değerleri mutlak 

değer olarak tüm kritik değerlerden büyüktür. “trendli ve sabitli” modelde 

ise %10 ve %5 seviyesinde büyüktür. Bu yüzden tüm modeller için H0 

hipotezi reddedilerek HA hipotezi kabul edilir. Böylece serinin birinci 

farkında birim köke sahip olmadığı diğer bir ifadeyle durağan olduğu 

sonucuna ulaşılmış olur. Dolayısıyla Y değişkeni “trendli” ve “trendsiz ve 

sabitsiz” modeller için %1 anlamlılık seviyesinde, “trendli ve sabitli” model 

için %5 anlamlılık seviyesinde I(1)’dir. 

➢ Son olarak eğer seri durağan çıkmasaydı aynı işlemler ikinci farkında da 

uygulanırdı. 
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Şekil 4.9. Birinci Farkta ADF Birim Kök Testi Sonuçları (Tüm Modeller İçin) 

  

4.1.2. PP Birim Kök Testi 

PP birim kök testinin null/boş ve alternatif hipotezleri ADF testiyle aynı 

olup şu şekilde ifade edilebilir:  

H0: Seri birim köke sahiptir ya da durağan değildir. 

HA: Seri durağandır. 

PP birim kök testi, Eviews paket programı aracılığıyla aşağıdaki adımlar 

izlenerek oluşturulabilir (Not: Verilerin Eviews paket programına transferi için 

1.Bölüm incelenebilir). 
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➢ Eviews paket programında ilk olarak birim kök testi yapılacak olan değişken 

çift tıklanarak açılan pencere üzerinden “View ⇒ Unit Root Test” sekmeleri 

sırasıyla seçilir.  

➢ Aşağıda Şekil 4.10’da görüldüğü üzere “Test type” kısmından “Phillips-

Perron” seçeneği işaretlenir. 

Şekil 4.10. Düzeyde Sabitli PP Birim Kök Testi Seçim Prosedürü 

 

➢ Sürecin işletilmesi ADF birim kök testi ile aynı olduğu için adımlar 

tekrardan görselleştirilmeyecektir. Ancak süreci özetlemek gerekirse Y 

değişkeni için “Phillips-Perron” ve “Level” seçili iken sırasıyla “Intercept”, 

“Trend and Intercept” ve “None” seçilip “OK” seçeneği tıklanarak 

değerlendirmeler yapılır. PP birim kök testinin hipotezleri ADF birim kök 

testinin hipotezleriyle aynı olduğundan değerlendirmeler de aynı kriterlere 

göre yapılır (Değerlendirme ölçütleri bir önceki başlıkta detaylandırılmıştır). 

Eğer seri düzeyde durağan çıkarsa başka herhangi bir işleme gerek yoktur. 

Ancak seri durağan çıkmaz ise aynı prosedür “1st difference” birinci fark 

seçilerek devam ettirilir. 

4.1.3. KPSS Birim Kök Testi 

KPSS birim kök testinin null/boş ve alternatif hipotezleri şu şekildedir:  

H0: Seri durağandır. 

HA: Seri birim köke sahiptir ya da durağan değildir. 

Dikkat edilirse bu hipotezler ADF ve PP birim kök testinin hipotezlerine 

göre ters kurulmuştur. KPSS birim kök testi Eviews paket programı aracılığıyla 

aşağıdaki adımlar izlenerek oluşturulabilir. 
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➢ Eviews paket programında ilk olarak birim kök testi yapılacak olan değişken 

çift tıklanır. 

➢ Açılan pencere üzerinden “View ⇒ Unit Root Test” sekmeleri sırasıyla 

seçilir.  

➢ “Test type” kısmından “Kwiatkowski-Phillips-Schmidt-Shin” seçeneği 

işaretlenir.  

➢ “Test for unit root in” kısmından ilk olarak level (düzey) işaretlenir.  

➢ Ardından “Include in test equation” kısmından önce “Intercept” ardından 

“Trend and Intercept” seçilerek “OK” seçeneği tıklanarak aşağıda Şekil 

4.11’de sunulan KPSS birim kök test sonuçları elde edilir.  

➢ Aşağıda Şekil 4.11’in en üst kısmında H0 hipotezi ve LM-test istatistiği yer 

almaktadır. Bu test istatistiği şu şekilde değerlendirilir: “Constant” (sabitli) 

modelde 0.12 değeri ve “Constant, linear Trend” modelde 0.06 olan “LM-

Stat” değeri “Asymptotic critical values” değerlerle karşılaştırılır. Şekil 

4.11’de görüldüğü üzere bu değer tüm asimptotik kritik değerlerden mutlak 

değer olarak küçüktür. Bu yüzden serinin durağan olduğunu ifade eden H0 

hipotezi kabul edilerek HA hipotezi reddedilir. Böylece serinin durağan 

olduğu diğer bir ifadeyle birim kök içermediği sonucuna ulaşılır. Dolayısıyla 

X serisi I(0) çıktığından farklarda bu işlemin uygulanmasına gerek 

kalmamıştır. Eğer düzeyde durağan çıkmasaydı aynı işlemler ve 

değerlendirmeler “1st difference” seçililerek birinci farkta uygulanırdı. 

Şekil 4.11. Düzeyde KPSS Birim Kök Test Sonuçları 
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4.1.4. ADF, PP ve KPSS Birim Kök Testlerinin Toplu Olarak Raporlanması 

ADF, PP ve KPSS birim kök testlerinin raporlama sürecinde, işlemlerin 

tek tek uygulanması oldukça zahmetli olup araştırmacının operasyonel hata 

yapma riski artar. Bu testlerin toplu olarak raporlanabilmesi için öncelikle “Add-

ins” kısmından “urall” eklentisinin yüklenmesi gerekecektir. Bu işlem için şu 

adımlar takip edilir: 

➢ İlk olarak Eviews paket programı ana ekranın üst tarafında yer alan “Add-

ins” kısmından “Download Add-ins” seçeneği seçilir. Bu işlemler aşağıda 

Şekil 4.12’de görselleştirilmiştir.  

Şekil 4.12. “Urall” Eklentisini Yükleme: Birinci Adım 

 

➢ Bu işlemlerin ardından aşağıda Şekil 4.13’te sunulan pencereden “urall” 

eklentisi seçilir ve sol tarafta bulunan “Install” seçeneği tıklanır. Ardından 

gelen ekranda “OK” ve iki defa da “Yes” seçenekleri sırasıyla tıklanır. 

➢ Bu işlemlerin ardından “urall: Installed successfully” uyarısı alınıp “OK” 

seçeneği tıklanarak süreç tamamlanır. 

Şekil 4.13. “Urall” Eklentisini Yükleme: İkinci Adım 
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➢ Böylece Add-ins kısmına tıklandığı zaman “All Unit Root Tests” sekmesi 

aşağıda Şekil 4.14’te sunulduğu gibi gelecektir. 

Şekil 4.14. “Urall” Eklentisi Ekran Görüntüsü 

 

Şekil 4.15. “Urall” Veri Girişi ve Test Seçimi 

 

➢ Bu eklenti şu şekilde çalışır: Eviews paket programı ana ekranın üst tarafında 

yer alan “Add-ins” kısmına ardından da “All Unit Root Tests” sekmesine 

tıklanarak yukarıda Şekil 4.15’te sunulan pencere açılır. 

➢ Bu pencereye değişkenlerin isimleri araya birer boşluk bırakılarak doğru bir 

şekilde yazılır. Ardından “ADF, PP ve KPSS” teker teker seçilerek “OK” 

tuşuna tıklanır. Hemen belirtmek gerekir ki bilgi kriteri olarak “AIC” ya da 

“SIC” seçilebilir. Araştırmacı isterse sadece ADF ve PP test sonuçlarını da 

aynı ekrandan alabilir. Bu eklenti tüm değişkenler için tüm prosedürü tek 

seferde gerçekleştireceğinden araştırmacı açısından oldukça zaman 
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kazandırıcıdır. Örnek uygulamalar aşağıda Şekil 4.16, 4.17 ve 4.18’de 

sunulmuştur. 

Şekil 4.16. Tüm Değişkenlerin Düzeyde ve Birinci Farkında ADF Test 

Sonuçları 

 

Şekil 4.17. Tüm Değişkenlerin Düzeyde ve Birinci Farkında PP Test Sonuçları 
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Şekil 4.18. Tüm Değişkenlerin Düzeyde ve Birinci Farkında KPSS Test 

Sonuçları 

 

4.2. Yapısal Kırılmalı Birim Kök Testleri 

Geleneksel ADF, PP ve KPSS birim kök testleri doğası gereği yapısal 

kırılmaları dikkate almaz. Yapısal kırılmaları dikkate almaksızın yapılan birim 

kök sınamaları ise yanıltıcı sonuçlar verebilecektir. Bu yüzden değişkenlere 

ilişkin yapısal kırılmaları da dikkate alan ZA (Zivot-Andrews) (Zivot ve 

Andrews, 2002) ve LS (Lee-Strazicich) (Lee ve Strazicich, 2003) birim kök 

testleri uygulanmış ve sonuçlar değerlendirilmiştir. Bu testleri uygulayabilmek 

için Eviews ana ekranında bulunan “Add-ins” sekmesinin altında bulunan 

“Download Add-ins” kısmından “ZAURoot” ve “lsunit” eklentilerinin 

yüklenmesi gerekecektir. Bu işlem için bir önceki başlık olan 4.1.4. başlığı 

incelenebilir.  

4.2.1. Zivot-Andrews (ZA) Birim Kök Testi 

Zivot Andrews birim kök testi için sırasıyla aşağıdaki adımlar izlenir: 

➢ Eklentinin yüklenmesinin ardından test yapılacak değişken çift tıklanarak 

açılır. 

➢ Ardından “Add-ins” sekmesinin altında bulunan “Zivot-Andrews unit root 

test” sekmesi aşağıda Şekil 4.19’daki gibi açılır. 
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Şekil 4.19. Zivot-Andrews Testi: Birinci Adım 

 

➢ Açılan ekrandan sırasıyla “A-Intercept”, “B-Trend” ve “C-Both” seçenekleri 

için ayrı ayrı sonuçlar alınır.  

➢ “Select a maximum lag lenght” sekmesinden maksimum gecikme uzunluğu 

yıllık seriler için 2, çeyreklik seriler için 4, aylık seriler için 8 girilmelidir. 

Bu seriler yıllık olduğu için maksimum gecikme uzunlukları aşağıda Şekil 

4.20’de görüldüğü gibi 2 seçilmiştir. 

Şekil 4.20. Zivot-Andrews Testi: İkinci Adım 

 

➢ Aşağıda Şekil 4.21’de Zivot-Andrews düzeyde olan birim kök test sonuçları 

toplu olarak sunulmuştur. 

Şekil 4.21. Düzeyde Zivot-Andrews Test Sonuçları 
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➢ Şekil 4.21 incelendiğinde Y değişkeninin tüm “t-Statistic” değerleri mutlak 

değer olarak kritik değerlerin tamamından küçüktür. Dolayısıyla Y 

değişkeninin birim köke sahip olduğunu ifade eden H0 hipotezi kabul edilir. 

Bu sonuç, düzeyde Y değişkeninin birim köke sahip olduğunu 

göstermektedir. Yani, Y değişkeni düzeyde durağan değildir. 

➢ Y değişkeninin düzeyde durağan çıkmaması aynı prosedürün birinci farkta 

uygulanmasını gerektirir.  

➢ Serinin birinci dereceden farkını almak için “Command” ekranı tıklanır. 

Açılan pencereye “genr farky=d(y)” komutu yazılıp klavyeden “enter” 

tuşuna basılır. Böylece aşağıda Şekil 4.22’de sunulan “farky” değişkeni 

oluşturulur. 

Şekil 4.22. Birinci Derece Fark Alma İşlemi 

 

➢ Y değişkeni için işletilen prosüdürün aynısı “farkY” değişkeni için de 

işletilir.  

➢ “farkY” değişkeni çift tıklanarak açılır. Ardından “Add-ins” sekmesinin 

altında bulunan “Zivot-Andrews unit root test” sekmesi tıklanır. 

➢   Açılan ekrandan “Select a maximum lag lenght” 2 seçilerek sırasıyla “A-

Intercept”, “B-Trend” ve “C-Both” seçenekleri için ayrı ayrı sonuçlar alınır.  

➢ Aşağıda Şekil 4.23’te Zivot-Andrews birinci farklarda olan birim kök test 

sonuçları toplu olarak sunulmuştur. 

➢ Şekil 4.23 incelendiğinde “farkY” değişkeninin tüm “t-Statistic” değerleri 

mutlak değer olarak kritik değerlerin tamamından büyüktür. Dolayısıyla H0 

hipotezi reddedilerek HA hipotezi kabul edilir. Bu sonuç, Y değişkeninin 

birinci farklarda birim köke sahip olmadığını yani durağan olduğunu 

göstermektedir. Özetle, Y değişkeni I(1)’dir. 
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➢  Bu test yapısal kırılmaları dikkate aldığı için “kırılma yılı” modele 

eklenecek olan kukla (dummy) değişken için anlamlı bir gerekçe olabilir. 

Şekil 4.23. Birinci Farkta Zivot-Andrews Test Sonuçları 

 

➢ Yukarıda sunulan Şekil 4.23 incelendiğinde Y değişkeninin tüm “t-Statistic” 

değerleri mutlak değer olarak kritik değerlerin tamamından büyüktür. 

Dolayısıyla H0 reddedilerek HA kabul edilir. Bu sonuç birinci farkta Y 

değişkeninin birim köke sahip olmadığını yani durağan olduğunu 

göstermektedir. Özetle, Y değişkeni I(1)’dir. 
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4.2.2. Lee-Strazicich (LS) Birim Kök Testi 

Bu başlık altında LS(Lee-Strazicich) (Lee ve Strazicich, 2003) birim 

birim kök testleri uygulanmış ve sonuçlar değerlendirilmiştir. Bu testi 

uygulayabilmek için Eviews ana ekranında bulunan “Add-ins” sekmesinin 

altında bulunan “Download Add-ins” kısmından “lsunit” eklentisinin 

yüklenmesi gerekecektir. Bu işlem için 4.1.4. başlığı incelenebilir. Lee-

Strazicich birim kök testi için sırasıyla aşağıdaki adımlar izlenir: 

➢ Eklentinin yüklenmesinin ardından test yapılacak değişken çift tıklanarak 

açılır. 

➢ Ardından “Add-ins” sekmesinin altında bulunan “Lee Strazicich unit root 

test” sekmesi aşağıda sunulan Şekil 4.24’teki gibi açılır. 

Şekil 4.24. LS Birim Kök Testi: Birinci Adım 

 

➢ Aşağıda Şekil 4.25’te sunulduğu üzere açılan ekrandan sırasıyla “Break”, 

kırılma sayısı isteğe göre “One” ya da “Two”, “Percent of End Point” 0.05 

girilir. 

Şekil 4.25. LS Birim Kök Testi: İkinci Adım 

 

➢ Ardından “OK” seçeneği tıklanarak aşağıda sunulan Şekil 4.26’da sunulan 

test sonucu elde edilir.  
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Şekil 4.26. Düzeyde LS Birim Kök Test Sonucu 

 

➢ Yukarıda şekil 4.26’da sunulan Lee-Strazicich birim kök test sonucuna göre 

X1 değişkeninin “Minimum test statistic(tau)” değeri mutlak değer olarak 

kritik değerlerin tamamından küçüktür. Dolayısıyla Y değişkeninin birim 

köke sahip olduğunu ifade eden H0 kabul edilir. Bu sonuç, X1 değişkeninin 

düzeyde birim köke sahip olduğunu göstermektedir. Yani, X1 değişkeni 

düzeyde durağan değildir. 

➢ X1 değişkeninin düzeyde durağan çıkmaması aynı prosedürün birinci 

farklarda uygulanmasını gerektirir.  

➢ Serinin farkını almak için “Command” ekranı tıklanır. Açılan pencereye 

“genr farkX1=d(X1)” komutu yazılıp klavyeden “enter” tuşuna basılır. 

Böylece “farkX1” değişkeni oluşturulur. 

➢ X1 değişkeni çift tıklanarak açılır ardından “Add-ins” sekmesinin altında 

bulunan “Lee Strazicich unit root test” sekmesi tıklanır. 

➢ Açılan ekrandan sırasıyla “Break”, kırılma sayısı isteğe göre “One” ya da 

“Two”, “Percent of End Point” ise 0.05 olarak girilir. 

➢ Ardından “OK” seçeneği tıklanarak aşağıda Şekil 4.27’de sunulan birinci 

farkta Lee-Strazicich test sonucu elde edilir.  

Şekil 4.27. Birinci Farkta LS Test Sonucu 
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➢ Yukarıda Şekil 4.27’de birinci farkta uygulanan Lee Strazicich birim kök 

test sonucuna göre X1 değişkeninin “Minimum test statistic(tau)” değeri 

mutlak değer olarak kritik değerlerin tamamından büyüktür. Dolayısıyla H0 

reddedilir. Bu sonuç, birinci farklarda X1 değişkenin birim kök içermediği 

yani durağan olduğu anlamına gelir. Özetle, X1 değişkeni I(1)’dir. 

➢ Bu test Zivot Andrews testinden farklı olarak iki kırılmaya izin verdiğinden 

modele eklenecek kukla (dummy) değişkenler açısından daha fazla esneklik 

sağlar.  “Kırılma yılları” modele eklenecek olan kukla değişken(ler) için 

anlamlı bir gerekçe olabilir. 
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5. BÖLÜM 

ARDL EŞBÜTÜNLEŞME YÖNTEMİ 

ARDL kavramı İngilizce “Auto-regressive Distributed Lag” 

kelimelerinin baş harflerine karşılık gelir. Türkçede “gecikmesi dağıtılmış 

otoregresif yöntem” şeklinde ifade edilen bu yöntem M. Hashem Pesaran, 

Yongcheol Shin ve Richard J. Smith (2001) tarafından geliştirilmiştir. Bu 

yöntem, düzeyde durağan olmayan en az iki değişkenin durağan bir 

bileşimlerinin olduğunu ifade eden “eşbütünleşme” kavramını test etmek için 

kullanılır. Dolayısıyla ARDL yöntemi, farklı durağanlık seviyelerine sahip olan 

değişkenlerin durağan bir bileşimini tespit etmeye yarar.  Bu yaklaşım Engle ve 

Granger (1987), Johansen ve Juselius (1990), Phillips ve Hansen (1990) gibi 

geleneksel eşbütünleşme testlerine göre daha esnektir. ARDL yönteminde tüm 

değişkenlerin aynı derecede entegre olma şartı aranmaz. Küçük örneklemli 

modeller için tutarlı ampirik kanıtlar sağlar (Narayan ve Smyth, 2005). 

Sonuç olarak, bağımlı ve bağımsız değişkenlerin mevcut ve geçmiş 

dönemli verileri arasındaki dinamik etkileşimlerin modellenmesine yardımcı 

olan ARDL yöntemi, değişkenler arasındaki uzun dönemli ilişkilerin 

anlaşılmasına katkı sağlar. Çalışma kapsamında ARDL prosedürü matematiksel 

gösterimler de dahil olmak üzere Eviews paket programı üzerinden adım adım 

uygulanacaktır. 

5.1. Yönteme Karar Verme 

ARDL yöntemi bağımlı değişkenin I(1), bağımsız değişkenlerin I(0) ya 

da I(1) olması (Shahbaz vd. 2013) durumunda etkin sonuçlar sunar. Birim kök 

testleri açısından çelişkili sonuçlar elde edildiği ya da bağımlı değişkenin I(0) 

olduğu durumlarda da ARDL yönteminin uygulanmasına imkân sunan McNown 

vd. (2018)  tarafından “bootstrap” ARDL, Sam vd.’nin (2019) ise Augmented-

ARDL (A-ARDL) prosedürü olarak isimlendirdiği yeni bir yaklaşım ortaya 

çıkmıştır (Göksu, 2023: 228). Ancak her durumda değişkenler arasında I(2) 

olmamalıdır (Akçay, 2022). Kullanılacak yönteme karar vermede yukarıda 

anlatılan hususlar aşağıda Tablo 5.1’de özetlenmiştir. Bu tabloda Y bağımlı 

değişkeni, X1 ve X2 bağımsız değişkenleri, I(0) ve I(1) durağanlık seviyelerini 

göstermektedir. I(0) serinin düzeyde ya da seviyede durağan olduğunu 

gösterirken I(1) serinin birinci farkta durağan olduğunu gösterir. Kullanılacak 

olan yönteme karar vermek için öncelikle birim kök testleri uygulanmalıdır ki 

bu çalışmanın 4. bölümünde detaylı bir şekilde ele alınmıştır. Birim kök test 

sonuçlarına göre hangi yöntemin uygulanacağına karar verilir.  Tablo 5.1 

incelendiğinde çok rahatlıkla ifade edilebilir ki ARDL yöntemi çoğu zaman bir 

tercihten değil zorunluluktan ortaya çıkar.  
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Tablo 5.1. Değişkenlerin I(0) ve/veya I(1) Olduğu Durumlarda Yönteme Karar 

Verme 

Bağımlı 

Değişken 

Y 

Bağsız 

Değişken 

X1 

Bağsız 

Değişken 

X2 

Kullanılabilecek Yöntem 

I(1) I(1) I(0) ARDL 

I(1) I(0) I(1) ARDL 

I(0) I(1) I(0) A-ARDL 

I(0) I(0) I(1) A-ARDL 

I(1) I(1) I(1) 
ARDL 

Geleneksel eşbütünleşme yöntemleri 

I(0) I(0) I(0) Klasik OLS (Ordinary least squares) 

5.2. Gecikme Uzunluklarının Belirlenmesi ve Trend Spesifikasyonlarının 

Seçimi 

ARDL yöntemi için gecikme uzunluklarının doğru bir şekilde tespit 

edilmesi analiz sonuçlarının güvenilirliği açısından hayati bir adımdır. 

Maksimum gecikme uzunluğu için AIC (Akaike information criterion), SC 

(Schwarz information criterion), HQ (Hannan-Quinn information criterion) gibi 

bilgi kriterleri kullanılabilmektedir. Literatürdeki genel eğilim, maksimum 

gecikme uzunluğunun yıllık olan verilerde 2, çeyreklik verilerde 4, aylık olan 

verilerde ise 8 olarak seçildiği şeklindedir. Gecikme uzunluğunun yüksek 

tutulmasının veri kaybına yol açacağına da dikkat etmek gerekir. Zaman serisi 

analizlerinde genel eğilim en az 30 gözlem değerinin olması gerektiği 

şeklindedir. Aylık verilere ilişkin 35 gözlemli bir çalışmada maksimum gecikme 

uzunluğunun 8 olarak belirlenmesi durumunda, geriye sadece 27 gözlem değeri 

kalacaktır ki bu durum çalışmaya ilişkin gözlem değerlerinin genel kabul gören 

alt sınırın (30’un) altında kalmasına neden olacaktır. 

Trend spesifikasyonun doğru olarak seçilmesi de analiz açısından hayati 

öneme sahiptir. Eviews paket programı, “Fixed Regressors” bölümünde 

deterministik spesifikasyonların uzun vadeli ilişkiye nasıl gireceğine ilişkin 5 

farklı trend spesifikasyon seçeneği sunar (Eviews, 2017). 

➢ None: Bu seçim Case 1’e karşılık gelir ve sabitsiz ve trendsiz durumu ifade 

eder.  

➢ Rest. constant: Bu seçim Case 2’ye karşılık gelir ve kısıtlı sabitli ve 

trendsiz durumu ifade eder. 

➢ Constant: Bu seçim Case 3’e karşılık gelir ve kısıtsız sabitli ve trendsiz 

durumu ifade eder. 

➢ Rest. trend: Bu seçim Case 4’e karşılık gelir ve kısıtlı doğrusal trendli ve 

kısıtsız sabitli modeli ifade eder. 
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➢ Constant & trend: Bu seçim Case 5’e karşılık gelir ve kısıtsız trendli ve 

sabitli modeli ifade eder. 

Bu trend spesifikasyonlarından test edilecek model için uygun olanına 

karar verilmesi gerekecektir. Bu karar verme işlemi grafikler aracılığıyla 

serilerin bünyelerinde sabit ve trend içerip içermediğine göre şekillenebilir. 

Ancak belirtmek gerekir ki ARDL ile yapılan ampirik çalışmaların çoğunda 

Case 3’ü ifade eden (Constant) sabitli ancak trendsiz durum tercih edilmektedir.  

 ARDL ve A-ARDL uygulama adımlarının anlatılacağı bu bölümde 

öncelikle fiyat hareketlerinin değişkenler üzerindeki etkilerini ortadan 

kaldırabilmek için tüm değişkenler reelleştirilmiş olup logaritmik dönüşüm 

işlemleri yapılmıştır. Ardından modelde yer alan veriler çeyreklik oldğu için 

değişkenler mevsimsel etkilerden arındırılmıştır. Bu uygulama adımları için 

kitabın 1. bölümü incelenebilir. Daha sonra birim kök testleri uygulanmıştır. 

Uygulanan birim kök test sonuçlarına göre bağımlı değişken olan Y değişkeninin 

I(0), bağımsız değişkenlerin I(0) veya I(1) olduğu tespit edilmiştir. Dolayısıyla 

yukarıda yer alan Tablo 5.1’e göre A-ARDL yönteminin uygulanması uygundur. 

Bu bölümde anlatılan gecikme uzunlukları ile trend spesifikasyonlarının 

belirlenmesine ilişkin hususların Eviews üzerinden uygulaması şu şekilde 

yapılabilir: 

➢ Eviews programında önce bağımlı değişken olmak üzere daha sonra 

modelde yer alan bağımsız değişkenlerin tamamı seçilir.  

➢ İmleç seçili verilerin üzerindeyken sağ tıklanır. Açılan ekranda “Open ⇒ As 

Equation” sekmeleri sırasıyla seçilir. Bu adımların Eviews ekran görüntüsü 

aşağıda Şekil 5.1’de sunulmuştur. 

Şekil 5.1. ARDL Denklemi Oluşturma 
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➢ Bu açılan ekranın “Method” kısmından “ARDL-Auto-regressive Distributed 

Lag Models” seçeneği işaretlenir. Bu adımın Eviews ekran görüntüsü 

aşağıda Şekil 5.2’de sunulmuştur. 

Şekil 5.2. ARDL Metodunun Seçimi 

 

➢ Buraya kadar olan adımlar Eviews ana ekranında bulunan “Quick ⇒ 

Estimate Equation” tıklanıp “Method” kısmından “ARDL-Auto-regressive 

Distributed Lag Models” seçeneği işaretlenerek “Dynamic Specification” 

kısmına değişkenlerin isimlerinin yazılmasıyla da yapılabilir. 

➢ Metot seçiminin ardından aşağıda Şekil 5.3’te sunulan spesifikasyonlarının 

belirlendiği Ewiews ekranı gelecektir. Bu ekranda dikkat edilecek hususlar 

şunlardır: Veriler çeyreklik olduğu için “max lags”lar 4 olarak seçilmiştir. 

(Veriler yıllık olduğunda 2, aylık olduğunda 8 tercih edilebilir). Trend 

spesifikasyon kısmında, “Case 3” yani sabitli model olan “3.Constant” tercih 

edilmiştir. Bağımlı değişkenin yapısal kırılmalı birim kök test sonucuna göre 

belirlenen kırılma dönemleri modele kukla değişken olarak “List of fixed 

regressors” kısmından eklenmiştir. Sonrasında, “Tamam” seçeneği 

tıklanarak spesifikasyon belirleme işlemleri tamamlanmış olur. 
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Şekil 5.3. ARDL Spesifikasyonlarının Belirlemesi 

 

➢ Spesifikasyonların belirlenmesinin ardından aşağıda Şekil 5.4’te görüldüğü 

üzere gelen ekranda “View ⇒ Model Selection Summary ⇒ Criteria Graph” 

seçenekleri sırasıyla tıklanır.  

Şekil 5.4. ARDL Model Belirleme İşlemleri: Birinci Adım 
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➢ Bu seçim işlemlerinin ardından aşağıda Şekil 5.5’te sunulan grafik açılır. 

Şekil 5.5. ARDL Model Belirleme İşlemleri: AIC 
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➢ Yukarıda Şekil 5.5’te sunulan grafik AIC (Akaike Info Criterion)’e göre 

hesaplanan optimum gecikme uzunluklarını sunar. Bu grafiğe göre en uygun 

model ARDL (4, 1, 0, 3) modeli olup Eviews paket programı tahminlerini 

otomatik olarak bu modele göre yapacaktır. 

Şekil 5.6. ARDL Model Belirleme İşlemleri: AIC, SC, BIC ve HQ 
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➢ En uygun modeli belirleme işlemi AIC üzerinden grafikle değil de tablo 

üzerinden AIC yanında SC, BIC ve HQ gibi diğer bilgi kriterleri kullanılarak 

da gösterilebilir.  

➢ Bu gösterim için spesifikasyonların belirlenmesinin ardından açılan ekranda 

“View ⇒ Model Selection Summary ⇒ Criteria Table” seçeneği tıklanır ve 

yukarıda Şekil 5.6’da sunulan tablo açılır. 

➢ Şekil 5.6’da sunulan tabloya göre de en uygun model ARDL (4, 1, 0, 3) 

modelidir. 

5.3. Eşbütünleşmenin Sınanması: Sınır (Bounds) Testlerinin Uygulanması 

Çalışmanın bu bölümünde ilk olarak tahmin edilecek modellerin 

matematiksel gösterimi yapılmış ardından sınır testlerinin hipotezleri 

sunulmuştur. Ardından ise Eviews uygulamaları aşama aşama gösterilmiştir. Y 

bağımlı değişken, X1, X2 ve X3 bağımsız değişkenler olmak üzere “Unrestricted 

Error Correction Model (UECM)” kısıtsız hata düzeltme modeli aşağıda 

denklem 2’de yer almaktadır. 

∆𝑙𝑛𝑌𝑡 = 𝛽0 + 𝛽1𝑑𝑢𝑚1 + 𝛽2𝑑𝑢𝑚2 + ∑ 𝛽3𝑖

𝑝=4

𝑖=1

∆𝑙𝑛𝑌𝑡−𝑖 + ∑ 𝛽4𝑗

𝑟=1

𝑗=0

∆𝑙𝑛𝑋1𝑡−𝑗

+ ∑ 𝛽5𝑘

𝑠=0

𝑘=0

∆𝑙𝑛𝑋2𝑡−𝑘 + ∑ 𝛽6𝑙

𝑡=3

𝑙=0

∆𝑙𝑛𝑋3𝑡−𝑙 + 𝛼1𝑙𝑛𝑌𝑡−1 + 𝛼2𝑙𝑛𝑋1𝑡−1

+ 𝛼3𝑙𝑛𝑋2𝑡−1 + 𝛼4𝑙𝑛𝑋3𝑡−1 + 𝜇𝑡                                                             (2) 

Yukarıda denklem 2’de yer alan “Δ” fark operatörünü, değişkenlerin 

başındaki “ln” doğal logaritmalarının alındığını, “
t
” hata terimini, “dum1 ve 

dum2” kukla değişkenleri “β0” sabit terimi,  “β3, β4, β5 ve β6 ” kısa dönemli 

katsayıları, “α1, α2, α3 ve α4” uzun dönemli katsayıları, “p, r, s ve t” gecikme 

uzunluklarını ifade etmektedir. Hatırlanacağı üzere 5.2. numaralı başlık altında 

en uygun modelin ARDL (4, 1, 0, 3) olduğu sonucuna ulaşılmıştı. Dolayısıyla 

p=4, r=1, s=0 ve t=3 olarak belirlenmiştir. ARDL kısıtsız hata düzeltme modeli 

(ECM) aşağıda denklem 3’te sunulmuştur. Denklem 2 için yapılan açıklamalara 

ilave olarak “𝛾1" hata düzeltme terimi katsayısını, 𝜏𝑡 ise hata terimini 

göstermektedir. 

∆𝑙𝑛𝑌𝑡 = 𝛽0 + 𝛽1𝑑𝑢𝑚1 + 𝛽2𝑑𝑢𝑚2 + ∑ 𝛽3𝑖

𝑝=4

𝑖=1

∆𝑙𝑛𝑌𝑡−𝑖 + ∑ 𝛽4𝑗

𝑟=1

𝑗=0

∆𝑙𝑛𝑋1𝑡−𝑗

+ ∑ 𝛽5𝑘

𝑠=0

𝑘=0

∆𝑙𝑛𝑋2𝑡−𝑘 + ∑ 𝛽6𝑙

𝑡=3

𝑙=0

∆𝑙𝑛𝑋3𝑡−𝑙 + 𝛾1𝐸𝐶𝑇𝑡−1 + 𝜏𝑡                (3) 

Klasik ARDL yönteminde eşbütünleşmenin sınanmasında “F-Bounds” ve 

“t-Bounds” sınır testleri kullanılır. F-Bounds testi, modelde yer alan bağımlı ve 
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bağımsız tüm değişkenlerin gecikmeli değerlerini dikkate alır. F-Bounds testinin 

hipotezleri, 𝐻0: 𝛼1 = 𝛼2 = 𝛼3 = 𝛼4 = 0 ve 𝐻𝐴: 𝛼1 ≠ 𝛼2 ≠ 𝛼3 ≠ 𝛼4 ≠ 0  
şeklindedir. F-Bounds test istatistik değerleri, Narayan (2005) tarafından 

hesaplanan alt ve üst sınır kritik değeriyle karşılaştırılacaktır. Hesaplanan F-

Bounds istatistik değeri I(1) için belirtilen üst sınır kritik değerlerin üzerindeyse, 

eşbütünleşmenin olmadığını belirten H0 hipotezi reddedilerek eşbütünleşmenin 

olduğu sonucuna ulaşılır. F-Bounds istatistik değeri alt ve üst sınır kritik 

değerleri arasında yer alıyorsa, eşbütünleşmenin olmadığını belirten sıfır 

hipotezi sonuçsuzdur ve kararsız bölgeyi temsil eder. Bu durumda Kremers vd. 

(1992), Banerjee vd. (1998) ve Tursoy ve Faisal’a (2018) göre eşbütünleşme 

ilişkisinin varlığına ilişkin karar hata düzeltme terimine göre verilecektir. Hata 

düzeltme teriminin negatif ve istatistiki olarak anlamlı olması (olasılık değerinin 

0.05’ten küçük olması) tahmin edilen değişkenler arasında uzun dönemli bir 

ilişkinin varlığına işaret edecektir. Ancak F-Bounds değerinin alt sınır kritik 

değerinin altında olması, tahmin edilen değişkenler arasında eşbütünleşmenin 

olmadığını gösterecektir. 

Eşbütünleşmenin sınanmasında ikinci bir test olarak sadece bağımlı 

değişkenin gecikmeli değerini göz önünde bulunduran t-Bounds testinin 

hipotezleri, 𝐻0: 𝛼1 = 0 ve 𝐻𝐴: 𝛼1 ≠ 0 şeklindedir. Bu testin test istatistik 

değerleri Pesaran vd. (2001) tarafından hesaplanan alt ve üst sınır kritik 

değeriyle karşılaştırılacaktır. 

Birim kök testleri açısından çelişkili sonuçlar elde edildiği ya da bağımlı 

değişkenin I(0) olduğu durumlarda A-ARDL prosedürü uygulanır. A-ARDL 

yönteminde kullanılan Exogenous F-Bounds testi sadece bağımsız 

değişken(ler)in gecikmeli değerini dikkate alır. Exogenous F-Bounds testinin 

hipotezleri, 𝐻0: 𝛼2 = 𝛼3 = 𝛼4 = 0 ve 𝐻𝐴: 𝛼2 ≠ 𝛼3 ≠ 𝛼4 ≠ 0 şeklindedir. Bu 

hipotezler, F-Bounds testinden farklı olarak bağımlı değişkeni dikkate 

almamaktadır. 

Yukarıda yapılan açıklamalar ışığında eşbütünleşme testlerini ifade eden 

“Bounds” (sınır) testlerinin Eviews üzerinden uygulaması şu şekilde yapılabilir: 

➢ Eviews programında önce bağımlı değişken olmak üzere daha sonra 

modelde yer alan bağımsız değişkenlerin tamamı seçilir.  

➢ İmleç seçili verilerin üzerindeyken sağ tıklanır. Açılan ekranda “Open ⇒ As 

Equation” sekmeleri sırasıyla seçilir.  

➢ Bu açılan ekranın “Method” kısmından “ARDL-Auto-regressive Distributed 

Lag Models” seçeneği işaretlenir.  

➢ Gelen ekranda veriler çeyreklik olduğu için “max lags”lar 4 seçilmiştir. 

Trend spesifikasyon kısmında “Case 3” yani sabitli model olan “3.Constant” 

tercih edilmiştir. Yapısal kırılmaları dikkate alan birim kök test sonuçlarına 

göre belirlenen kırılma dönemleri “List of fixed regressors” kısmından 
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modele kukla değişken olarak eklenmiştir. “Tamam” seçeneği tıklanarak 

spesifikasyon belirleme işlemleri tamamlanır. 

➢ Ardından açılan ekran üzerinden aşağıda Şekil 5.7’de görüldüğü üzere 

“View ⇒ Coefficient Diagnostics ⇒ Long Run Form and Bounds Test” 

sekmeleri tıklanır. 

Şekil 5.7. F-Bounds ve t-Bounds Testi: Birinci Adım 

 

Şekil 5.8. F-Bounds ve t-Bounds Testi Sonuçları 
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➢ Açılan ekran aşağıya doğru kaydırıldığında (alt kısmında) F-Bounds ve t-

Bounds test değerleri yukarıda Şekil 5.8’deki gibi görülebilecektir. 

➢ Şekil 5.8’de görüldüğü üzere F-Bounds test değeri 16.61374’tür. Bu değer 

I(0) ve I(1) sınır değerleriyle karşılaştırılır. 1000 gözlem değeri için 

16.61374 değeri %1 anlamlılık düzeyinde üst sınır değer olan 5.61 

değerinden yüksektir. Dolayısıyla F-Bounds test sonucuna göre oluşturulan 

model %1 anlamlılık seviyesinde simetrik/doğrusal olarak eşbütünleşiktir. 

Çalışmanın gözlem değeri 63’tür. Veriler çeyreklik olduğu için maksimum 

gecikme uzunluğu 4 olarak belirlenmiş ve en uygun modelin ARDL (4, 1, 0, 

3) olduğu tespit edilmişti. Dolayısıyla maksimum gecikme uzunluğunun 

düşülmesinin ardından çalışmanın gerçek gözlem değeri 59 olarak ortaya 

çıkar. Bu yüzden değerlendirmenin 60 ya da 55 değerine göre yapılması 

daha uygun olacaktır. 60 değeri 59 değerine daha yakın olduğu için alt ve 

üst kritik değerleri 60 gözlem değeri için karşılaştırılmıştır. Yukarda Şekil 

5.8’de görüldüğü üzere 60 gözlem değeri için 16.61374 değeri %1 anlamlılık 

düzeyinde üst sınır kritik değeri olan 6.188 değerinden büyüktür. 

Dolayısıyla F-Bounds test sonucuna göre oluşturulan model sınırlı gözlem 

değeri için de %1 anlamlılık seviyesinde simetrik/doğrusal olarak 

eşbütünleşiktir. Benzer sonuç 55 gözlem değeri için de geçerlidir. 

Dolayısıyla F-Bounds test sonucu ne kadar büyükse eşbütünleşme ilişkisi o 

kadar kuvvetli olacaktır. Örneğin F-Bounds test değeri 2.08 olsaydı herhangi 

bir eşbütünleşme ilişkisi olmadığı anlamına gelecekti. 

➢ Yukarıda Şekil 5.8’de görüldüğü üzere t-Bounds test değeri -7.778518’dir. 

Bu değer I(0) ve I(1) sınır değerleriyle karşılaştırılır. -7.778518 değeri %1 

anlamlılık düzeyinde üst sınır değer olan -4.37 değerinden büyüktür. 

Dolayısıyla t-Bounds test sonucuna göre oluşturulan model %1 anlamlılık 

seviyesinde simetrik/doğrusal olarak eşbütünleşiktir.  

Şekil 5.9. Augmented ARDL Exogenous F-Bounds Testi: Birinci Adım 
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Hatırlanacağı üzere çalışmada bağımlı değişken olarak yer alan Y serisi 

birim kök testleri neticesinde I(0) olarak tespit edilmişti. Bu yüzden üçüncü bir 

test olarak sadece bağımsız değişkenlerin gecikmeli değerini dikkate alan 

Exogenous F-Bounds testi uygulanmıştır. Bu testin uygulanmasında şu adımlar 

takip edilebilir: 

➢ Bounds test sonuçlarının olduğu ekranın üstünde yer alan “Name” sekmesi 

tıklanır. Açılan ekrana mevcut model “eq01” olarak kaydedilir (Şekil 5.9). 

Böylece değişkenlerin olduğu ana ekrana bu denklem kaydedilmiş olur. 

➢ Ardından ana ekran üzerinde bulunan “eq01” eşitliği çift tıklanarak açılır.  

➢ Aşağıda Şekil 5.10’da görüldüğü üzere ana ekranın en üst kısmında bulunan 

“Add-ins” sekmesinden “Augmented ARDL Bounds Test” seçeneği tıklanır. 

Şekil 5.10. Augmented ARDL Exogenous F-Bounds Testi: İkinci Adım 

 

➢ Bu seçimin ardından değişkenlerin olduğu ana ekrana hem “testable_form” 

adında bir dosya hem de aşağıda Şekil 5.11’de görüldüğü üzere “Augmented 

ARDL Test” isimli bir pencere açılır. 

Şekil 5.11. Augmented ARDL Exogenous F-Bounds Test Sonuçları 
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➢ Açılan bu pencerenin aşağıya kaydırılmasının ardından Şekil 5.11’de 

görüldüğü üzere Exogenous F-Bounds test değerinin 5.310122 olduğu 

görülmektedir. Bu değer diğer testlerde olduğu gibi I(0) ve I(1) sınır 

değerleriyle karşılaştırılır. 5.310122 değeri 1000 gözlem değeri için %5 

anlamlılık düzeyinde üst sınır değer olan 4.65 değerinden büyüktür. 

Dolayısıyla Exogenous F-Bounds test sonucuna göre oluşturulan model %5 

anlamlılık seviyesinde simetrik/doğrusal olarak eşbütünleşiktir. Çalışmanın 

gerçek gözlem değeri 59’dur. 60 gözlem değeri için 5.310122 değeri %5 

anlamlılık düzeyinde üst sınır değeri olan 4.88 değerinden büyüktür. 

Dolayısıyla Exogenous F-Bounds test sonucuna göre oluşturulan model 

sınırlı gözlem değeri için de %5 anlamlılık seviyesinde simetrik/doğrusal 

olarak eşbütünleşiktir. Benzer sonuç 55 gözlem değeri için de geçerlidir.  

➢ Özet olarak sınır test sonuçlarının tamamı için oluşturulan model %5 

anlamlılık seviyesinde simetrik/doğrusal olarak eşbütünleşiktir. Dolayısıyla 

değişkenlerin doğrusal birleşimlerinin denge noktasına yakınsadığı (Balkı 

ve Göksu, 2023) yani uzun dönemde birlikte hareket ettikleri sonucuna 

ulaşılmıştır. 

5.4. Uzun Dönemli Katsayıların Tahmini 

Denklem 2’de uzun dönem katsayı tahminlerini ifade eden 

“α2, α3 ve α4" değerleri F-Bounds ve t-Bounds test sonuçlarının olduğu ekranın 

üst tarafında aşağıda Şekil 5.12’de görüldüğü üzere “Levels Equation / Case 3: 

Unrestricted Constant and No Trend” başlığı altında yer almaktadır. 

Şekil 5.12. ARDL Uzun Dönemli Tahmin Sonuçları 

 

➢ Bu katsayılara en son açık olan Augmented ARDL penceresinden de 

ulaşılabileceği gibi ana ekrana kaydedilen “eq01” eşitliğine çift tıklanarak 

da ulaşılabilir. 

➢ Yukarıda Şekil 5.12’de gösterilen uzun dönem katsayı sonuçlarına göre X1 

ve X2 değişkenlerinin katsayıları negatiftir. Bu sonuç bağımsız değişkenler 

olan X1 ve X2’deki değişikliklerin bağımlı değişken olan Y değişkenini zıt 
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yönde etkileyeceğini gösterir. Yani X1 artarsa Y azalır, X1 azalırsa Y artar. 

Aynı sonuç X2 değişkeni için de geçerlidir. Daha açık ifade etmek gerekirse 

X2 artarsa Y azalır, X2 azalırsa Y artar. X3 değişkeninin katsayısı ise 

pozitiftir. Bu sonuç X3 değişkeninin bağımlı değişken olan Y değişkenini 

aynı yönde etkileyeceğini gösterir. Yani X3 artarsa Y artar, X3 azalırsa Y 

azalır. 

➢ X1 değişkeninin uzun dönem katsayısı -0.578719’dur. Bu sonucu daha 

detaylı yorumlayacak olursak X1 değişkeninde meydana gelecek %1’lik bir 

artış Y değişkenini yaklaşık % 0.58 (0.578719) oranında azaltır. Bu 

değişkenler arasında doğrusal bir ilişki olduğu için bu değerlendirmenin tam 

tersi de doğrudur. Yani X1 değişkeni %1 azalırsa Y değişkenini yaklaşık % 

0.58 (0.578719) oranında artırır. Bu sonuç, istatistiki olarak %5 önem 

seviyesinde anlamlıdır. Çünkü X1 değişkeninin “prob.” (olasılık) değeri 

0.0333 olup 0.05’ten küçüktür.  

➢ Benzer değerlendirme X2 değişkeni için de yapılabilirdi. Ancak X2 

değişkenin katsayısı istatistiki olarak anlamsızdır. Çünkü X2 değişkeninin 

“prob.” (olasılık) değeri 0.3055 olup 0.10’dan bile büyüktür. 

➢ X3 değişkeninin uzun dönem katsayısı 7.005800’dır. Bu sonuç X3 

değişkeninde meydana gelecek %1’lik bir artışın Y değişkenini yaklaşık % 

7 (7.005800) oranında artıracağı anlamına gelir. Bu değişkenler arasında 

doğrusal bir ilişki olduğu için bu değerlendirmenin tam tersi de doğrudur. 

Yani X3 değişkeni %1 azalırsa Y değişkenini yaklaşık % 7 (7.005800) 

oranında azalır. Bu sonuç, istatistiki olarak %1 önem seviyesinde anlamlıdır. 

Çünkü X3 değişkeninin “prob.” (olasılık) değeri 0.0000 olup 0.01’den 

küçüktür.  

➢ Bu arada hemen belirtmek gerekir ki tüm değişkenler yüzdesel olduğu için 

sonuçlar yüzde olarak yorumlanmıştır. Benzer bir değerlendirme (yüzdesel 

yorumlama), değişkenlerin tamamı logaritmik olduğu durumda ya da 

logaritmik ve yüzdesel değişkenlerin modelde karışık olarak yer aldığı 

durumda da yapılabilir. Ancak değişkenler yüzdesel ya da logaritmik 

olmadığı durumlarda, sonuçlar yorumlanırken “%1 artarsa ya da azalırsa” 

ifadeleri yerine “1 birim artarsa ya da azalırsa” ifadelerini kullanmak daha 

uygun olacaktır. 

5.5. Kısa Dönemli Katsayıların Tahmini 

Bu başlık altında Denklem 3’te gösterilen sabit terimi ifade eden "β0", 

kukla değişkenlerin katsayıları olan “β1 ve β2", kısa dönem katsayıları ifade 

eden “β3, β4, β5 ve β6" değerleri ile hata düzeltme terimi katsayısı olan “𝛾1”in 

tahmin edilmesinde Eviews uygulama adımları sunulacaktır.  

➢ Kısa dönem sonuçlarını elde etmek için F-Bounds ve t-Bounds test 

sonuçlarının olduğu “Long Run Form and Bounds Test” ekranından “View 
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⇒ Coefficient Diagnostics ⇒ Error Correction Form” sekmeleri aşağıda 

Şekil 5.13’te görüldüğü gibi tıklanır. 

Şekil 5.13. ARDL Kısa Dönemli Katsayıların Tahmini: Birinci Adım 

 

➢ Böylece aşağıda Şekil 5.14’te gösterilen kısa dönem sonuçlarının olduğu 

“ECM Regression / Case 3: Unrestricted Constant and No Trend” başlıklı 

tabloya ulaşılır. 

Şekil 5.14. ARDL Kısa Dönemli Katsayıların Tahmin Sonuçları 
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➢ Kısa dönem tahmin sonuçları incelendiğinde denklem 3’te hata düzeltme 

terimi katsayısını ifade eden “𝛾1” bu tabloda “CointEq(-1)”e karşılık gelir. 

Bu katsayının negatif (-) olması ve olasılık değerinin de 0.05’ten küçük 

olması beklenmektedir. Yukarıda Şekil 5.14’te görülebileceği üzere hata 

düzeltme terimi katsayısı -0.965571 olup olasılık değeri 0.0000’dır. Hata 

düzeltme terimi katsayısının negatif ve istatistiksel olarak anlamlı olması 

modelin eşbütünleşik olduğuna dair ek bir kanıt sunmaktadır (Akçay ve 

Karasoy, 2017). Olasılık değerinin 0.05’ten küçük olması bu katsayının 

anlamlı olduğunu gösterirken negatif (-) olması modelde ortaya çıkacak bir 

dengesizliğin düzeleceği anlamına gelir (Göksu, 2023: 232). Bazen bu 

katsayı değeri negatif olsa da mutlak değer olarak 1’den büyük çıkar. Bu 

sonuç dengesiz bir yakınsama olacağı şeklinde yorumlanabilir (Narayan ve 

Smyth, 2006; Göksu, 2022: 865). 

➢ Bağımlı değişken olan Y değişkeni üzerinde, üç döneme kadar kendi 

gecikmeli değerinin pozitif etkisi vardır. Bağımsız değişken olan X1 

değişkeninin Y değişkeni üzerinde istatistiki olarak anlamlı bir etkisi yoktur 

(Prob. değerleri 0.05’ten büyüktür). Hatırlanacağı üzere en uygun modelin 

ARDL (4, 1, 0, 3) olduğu tespit edilmişti. Parantez içerisinde yer alan sıfır 

değeri X2 değişkeninin gecikmeli değerine karşılık gelir. Gecikme değeri 

sıfır olduğundan X2 değişkeni için kısa dönem katsayısı değeri Eviews 

ekranında yer almamaktadır. Uzun dönemle benzer şekilde, X3 değişkeninin 

gecikmeli değerlerinin Y üzerinde kısa dönemde de pozitif etkileri vardır. 

Modele dahil edilen kukla değişkenlerin katsayıları negatif olup istatistiki 

olarak da anlamlıdır. Bu sonuç her iki kırılma döneminde ortaya çıkan 

şokların olumsuz etkilerine dair ampirik kanıtlar sunmaktadır. 

5.6. ARDL Tanısal (Diagnostic) Testlerin Uygulanması 

Tahmin edilen model sonucunda elde edilen bulguların sağlamlılığının 

kontrolü “diagnostic” ya da “tanısal testler” ile sağlanır. Çalışma kapsamında 

uygulanacak olan tanısal testler için Eviews adımları şu şekildedir: 

➢ Normallik: Normallik varsayımı için “Jarque-Bera” testi uygulanacaktır. 

Bu test, hata terimlerinin normal dağılıp dağılmadığını sınamaktadır. 

➢ Normal dağılım sınamasında “Jarque-Bera” testi için Eviews adımları, kısa 

veya uzun dönem katsayılarının tahmin edildiği ekrandan “View ⇒ Residual 

Diagnostics ⇒ Histogram-Normality Test” seçenekleri sırasıyla takip 

edilerek aşağıda Şekil 5.15’teki gibi belirlenir. 
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Şekil 5.15. Jarque-Bera Testi: Birinci Adım 

 

➢ Bu seçimlerin ardından hata terimlerinin Jarque-Bera test istatisitiği ve 

olasılık değerleri Şekil 5.16’daki gibi görünür. 

Şekil 5.16. Jarque-Bera Test Sonucu 
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➢ “Jarque-Bera” test değeri 0.526936 olup olasılık değeri de 0.768767’dir. 

“Jarque-Bera” testinin olasılık değeri 0.10’dan büyük olduğu için model 

normal dağılıma uygundur (Demir ve Balkı, 2019: 20). 

➢ Otokorelasyon: Bu kelime ardışık bağımlılık anlamına gelmektedir. 

Regresyon analizlerinde hata terimlerinin arasında ilişki olmaması 

istenmektedir. Hata terimleri arasında ilişkinin olması otokorelasyon 

sorununun varlığına işaret eder (Ünver Gamgam, 1996). Otokorelasyon 

sorununun olması durumunda, parametre tahmincileri sapmasız olmakla 

birlikte etkin değildir (Yavuz, 2009). Bu varsayım için “Breusch-Godfrey 

Serial Correlation LM” testi uygulanmıştır. 

➢ Otokorelasyon sınaması için uygulanacak olan “Breusch-Godfrey Serial 

Correlation LM” testinin Eviews adımları şu şekildedir: Kısa veya uzun 

dönem katsayılarının tahmin edildiği ekrandan “View ⇒ Residual 

Diagnostics ⇒ Serial Correlation LM Test” seçenekleri sırasıyla aşağıda 

Şekil 5.17’deki gibi belirlenir. Ardından “lag specification” ekranı gelir. 

Şekil 5.17’de görüldüğü üzere gecikme uzunluğu otomatik olarak 2 

gelmiştir. Son olarak “OK” tuşuna tıklanır. 

Şekil 5.17. Breusch-Godfrey Serial Correlation LM Test: Birinci Adım 

 

➢ Aşağıda sunulan “Breusch-Godfrey Serial Correlation LM” test değeri 

0.028844 olup olasılık değeri 0.9857’dir. Olasılık değeri 0.10’dan büyük 

olduğu için modelde otokorelasyon sorunu yoktur. 
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Şekil 5.18. Breusch-Godfrey Serial Correlation LM Test Sonucu 

 

➢ Değişen Varyans (Farklı Yayılım, Heteroskedasticity): Değişen 

varyansın tersi olarak tanımlayabileceğimiz sabit varyans varsayımı, 

regresyon analizlerinin önemli varsayımlarından biridir (Tarı, 2006). Sabit 

varyans ya da “homoscedasticity”, hata terimi varyansının bağımsız 

değişkenlerdeki değişmelerden etkilenmeyip hep aynı kalması anlamına 

gelir (Yamak ve Köseoğlu, 2006; Albayrak, 2008). Bu varsayım için 

“Breusch-Pagan-Godfrey” testi uygulanmıştır. Ayrıca değişen varyansın 

sınanmasında ikinci bir test olarak “ARCH” testi de uygulanmıştır. 

➢ Değişen varyans sınaması için uygulanacak olan “Breusch-Pagan-Godfrey” 

testinin Eviews adımları şu şekildedir: Kısa veya uzun dönem katsayılarının 

tahmin edildiği ekrandan “View ⇒ Residual Diagnostics ⇒ 

Heteroskedasticity” seçenekleri sırasıyla aşağıda Şekil 5.19’daki gibi 

belirlenir. Ardından gelen ekranda “Breusch-Pagan-Godfrey” testi seçilerek 

“OK” tuşuna tıklanır. 

Şekil 5.19. Breusch-Pagan-Godfrey Testi: Birinci Adım 
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➢ “Breusch-Pagan-Godfrey” testi sonuçları aşağıda Şekil 5.20’de 

sunulmuştur. Bu testin katsayı değeri 16.71994 olup olasılık değeri 

0.2124’tür. Olasılık değeri 0.10’dan büyük olduğu için modelde değişen 

varyans sorunu yoktur. 

Şekil 5.20. Breusch-Pagan-Godfrey Test Sonucu 

 

➢ Değişen varyans sınaması için uygulanacak ikinci test olan “ARCH” testinin 

Eviews adımları şu şekildedir: Kısa veya uzun dönem katsayılarının tahmin 

edildiği ekrandan “View ⇒ Residual Diagnostics ⇒ Heteroskedasticity” 

seçenekleri sırasıyla aşağıda Şekil 5.21’deki gibi belirlenir. Ardından gelen 

ekranda “ARCH” testi seçilerek “OK” tuşuna tıklanır. 

Şekil 5.21. ARCH Değişen Varyans Testi: Birinci Adım 
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➢ “ARCH” testi sonuçları aşağıda Şekil 5.22’de sunulmuştur. Bu testin katsayı 

değeri 0.240265 olup olasılık değeri 0.6240’tır. Olasılık değeri 0.10’dan 

büyük olduğu için modelde değişen varyans sorunu yoktur. 

Şekil 5.22. ARCH Değişen Varyans Test Sonucu 

 

➢ Fonksiyonel Form (Biçim): Tahmin edilen modelde herhangi bir 

spesifikasyon ya da model kurma hatasının olup olmadığının tespiti için 

“Ramsey-RESET” testi uygulanmıştır. 

➢ “Ramsey-RESET” testinin Eviews adımları şu şekildedir: Kısa veya uzun 

dönem katsayılarının tahmin edildiği ekrandan “View ⇒ Stability 

Diagnostics ⇒ Ramsey RESET Test” seçenekleri sırasıyla aşağıda Şekil 

5.23’teki gibi belirlenir. Ardından “specification” ekranı gelir. Bu ekranda 

“number of fitted terms” otomatik olarak 1 gelmiştir. Son olarak “OK” 

tuşuna tıklanır. 

Şekil 5.23. Ramsey RESET Test: Birinci Adım 
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➢ “Ramsey RESET” testi sonuçları aşağıda Şekil 5.24’te sunulmuştur. Bu 

testin katsayı değeri 0.076612 olup olasılık değeri 0.7832’dir. Olasılık değeri 

0.10’dan büyüktür dolasıyla %1 önem düzeyinde model kurma hatası 

(fonksiyonel form sorunu) yoktur. 

Şekil 5.24. Ramsey RESET Test Sonucu 

 

➢ CUSUM ve CUSUM2: Bu testler zaman serisi analizlerinde tahmin edilen 

katsayıların kararlılığını ya da istikrarını sınamak için uygulanmaktadır. 

➢ CUSUM ve CUSUM2 grafiklerini elde etmek için uygulanması gereken 

Eviews adımları şu şekildedir: Kısa veya uzun dönem katsayılarının tahmin 

edildiği ekrandan “View ⇒ Stability Diagnostics ⇒ Recursive Estimates ⇒ 

önce CUSUM Test daha sonra CUSUM of Squares Test” seçenekleri 

sırasıyla aşağıda Şekil 5.25’teki gibi belirlenir. Ardından “OK” tuşuna 

tıklanır. 

Şekil 5.25. CUSUM ve CUSUM2 Grafiklerini Oluşturma: Birinci Adım 
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➢ Böylece aşağıda Şekil 5.26’da yer alan CUSUM ve CUSUM2 grafikleri 

oluşturulur.  

Şekil 5.26. CUSUM ve CUSUM2 Grafikleri 
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➢ Brown vd. (1975) tarafından önerilen CUSUM testi, hata terimlerinin %95 

güven aralığında istenilen sınırlar içerisinde olup olmadığını gösterirken 

CUSUM2 testi ise kümülatif hata terimlerinin kareleri için aynı sınamayı 

yapmaktadır (Çetin vd. 2014). Ayrıca Şekil 5.26’da sunulan CUSUM ve 

CUSUM2 grafiklerinin %95 güven aralığında, istenilen sınırlar içerisinde 

olduğu görülmektedir. Bu sonuç doğrultusunda, kurulan modelin istikrarlı 

olduğunu söylenebilir. 
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6. BÖLÜM 

NARDL EŞBÜTÜNLEŞME YÖNTEMİ 

Bu bölümde asimetrik ya da doğrusal olmayan ARDL yaklaşımı 

anlatılacağından öncelikle simetrik ve asimetrik etki üzerinde durulacaktır. 

Bundan önceki bölümde ele alınan ARDL yöntemi simetrik ya da doğrusal bir 

yöntem olup bağımsız değişkenlerde meydana gelen artış ve azalışların bağımlı 

değişken üzerinde oluşturduğu etkinin aynı olduğu varsayımına dayanır. Bir 

örnek üzerinden açıklayacak olursak Y bağımlı değişken ve X bağımsız değişken 

olmak üzere X değişkeninin katsayısının ARDL yöntemine göre 1.5 olarak 

tahmin edildiğini farz edelim. Bu sonuç X değişkenin 1 birim artması 

durumunda Y değişkeninin 1.5 birim artacağını gösterdiği gibi  X değişkenin 1 

birim azalması durumunda Y değişkeninin 1.5 birim azalacağını da gösterir. 

Dikkat edilirse artış ve azalışların etki büyüklüğü aynıdır. Oysa gerçek hayatta 

durum tam olarak böyle olmayabilir. Örneğin, bir ailenin 12.sınıfa giden iki 

çocuğu olsun. Bu çocuklardan birinin derslerine çok çalıştığını, diğerinin ise hiç 

ders çalışmadığını farzedelim. Ailenin derslerine hiç çalışmayan çocuğun 

üniversite sınavında başarılı olup olmaması karşısında verdiği duygusal tepki ile 

derslerine çok çalışan çocuğun üniversite sınavında başarılı olup olmaması 

karşısında verdiği duygusal tepki aynı olmayabilir. Hatta olayı biraz daha 

karmaşık hale getirecek olursak, bu iki çocuğun üniversite sınavında iyi bir 

üniversitenin iyi bir bölümünü kazanması durumunda, ailenin hiç ders 

çalışmayan çocuğun iyi bir üniversite kazanmasına göstereceği duygusal tepki 

ile çok ders çalışan çocuğun iyi bir üniversite kazanması durumunda göstereceği 

duygusal tepki aynı olmayabilir. Hiç ders çalışmayan çocuğundan böylesine bir 

başarı görmek, aileyi daha fazla mutlu edebilir. Olayı tersten ele alırsak bu iki 

çocuğun üniverite sınavında başarılı olamamaları karşısında ailenin gece gündüz 

ders çalışan çocuğuna duyduğu üzüntünün daha fazla olması beklenir. 

Dolayısıyla günlük hayattan bir örnekle açıklanmaya çalışılan bu 

kavramın ekonometri içerisindeki yerine bakılacak olursa, iktisadi değişkenler 

arasında yapılan analizler doğrusal ve doğrusal olmayan şeklinde kategorize 

edebilir. Simetrik analizler, bağımsız değişkenlerde yaşanan negatif ve pozitif 

şokların bağımlı değişken üzerinde oluşturduğu etki büyüklüğünü aynı olarak 

kabul ederken asimetrik analizler negatif ve pozitif şokların etki büyüklüğünün 

farklı olduğunu dikkate almaktadır. Asimetrik analizlerin kökeni, Granger ve 

Yoon’un (2002) litertüre kazandırdığı zaman serileri arasındaki “saklı 

eşbütünleşme” kavramına kadar uzanmaktadır. 

Asimetrik yöntemler kullanılarak yapılan çalışmalarda, bu yöntemin 

niçin tercih edildiği çok detaylı bir şekilde açıklanmalıdır. Çünkü bu yöntem, bir 

tercih olmaktan ziyade bir gereklilik olmalıdır. Asimetrik yöntemlerin tercih 

edilme sebepleri arasında, analizde kullanılan serilerin “BDS” testi sonucu 

normal dağılım sergilememesi, inceleme döneminde tespit edilebilecek önemli 
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yapısal kırılmalar ve simetrik yöntemle yapılan analizlerde anlamlı bir ilişkinin 

tespit edilememsi gösterilebilir. Bu gerekçelerin dışında analizde kullanılan 

değişkenlere has özellikler de asimetrik yöntemlerin tercih edilme sebebi 

olabilir. Örneğin, bir analizde vergi ya da kamu harcamalarına ilişkin bir 

değişken varsa devlet bütçesinin hükümeti oluşturan siyasi parti ya da parti 

gruplarının tercihlerinden etkilenebileceği, yani asimetrik etkilerin ortaya 

çıkabileceği göz ardı edilmemelidir.  

Aydın da çalışmasında (2017), iktisadi değişkenlerin şoklar karşısında 

verdiği tepkilerdeki farklılıkları dikkate almadan yapılan analizlerin saklı 

ilişkileri ortaya çıkarmada yetersiz kalacağını ve analizlere olan güvenin 

sarsılabileceğini belirtmiştir. Bu çalışmada asimetrik yöntemin tercih 

edilmesindeki temel gerekçe şu şekilde ifade edilmiştir:  

“…Uygulamada petrol, borsa ve döviz kuru gibi zaman boyunca oynaklığın fazla 

olduğu değişkenlerde söz konusu asimetrik ilişkinin incelenmesi, simetrik bir 

incelemeye göre daha derin analiz yapma olanağı tanımaktadır. Bu da yapılan 

incelemenin daha sağlıklı sonuçlar verdiği gerçeğini ortaya çıkarmaktadır.” 

Bu açıklamalar ışığında NARDL yönteminin uygulama adımları takip 

eden alt başlıklarda açıklanacaktır. Ayrıca NARDL analizi için gerekli olan 

durağanlık testleri, maksimum ve optimum gecikme uzunlukları, spesifikasyon 

belirleme adımları ARDL yönteminde açıklandığı için bu kısımda 

tekrarlanmayacaktır. Ayrıntılı bilgi için bir önceki bölüm incelenebilir. 

6.1. NARDL Yöntemi: Ampirik Formülasyon 

NARDL yönteminde öncelikle bağımsız değişkenlerin pozitif ve negatif 

olarak ayrıştırılması gerekir. Örneğin bağımsız değişken olan X değişkeninden 

𝑋+ ve 𝑋− olmak üzere iki farklı değişken oluşturulmalıdır. 

Örnek modelde 𝑙𝑛𝑌 bağımlı değişken ve 𝑙𝑛𝑋1 bağımsız değişken olmak 

üzere, modelin simetrik fonksiyonel form yapısı şu şekilde olacaktır: 

𝑙𝑛𝑌 = ƒ(𝑙𝑛𝑋1𝑡 + 𝜀𝑡) 

Yukarıdaki modelin asimetrik fonksiyonel yapısı ise şu şekilde ifade edilebilir: 

𝑙𝑛𝑌 = ƒ (𝑙𝑛𝑋1𝑡
+ , 𝑙𝑛𝑋1𝑡

− , ) 

𝑙𝑛𝑌𝑡 = 𝛽0 + 𝛽1𝑙𝑛𝑋1𝑡
+ + 𝛽2𝑙𝑛𝑋1𝑡

− + 𝜇𝑡 

Modeldeki veriler şu şekilde ayrıştırılabilir: 

𝑙𝑛𝑋 1𝑡
+ ∑ ∆𝑙𝑛𝑋 1𝑖

+ = 

𝑡

𝑖=1

∑ 𝑚𝑎𝑥(∆𝑙𝑛𝑋1𝑖 , 0)

𝑡

𝑖=1
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𝑙𝑛𝑋 1𝑡
− ∑ ∆𝑙𝑛𝑋 1𝑖

− = 

𝑡

𝑖=1

∑ 𝑚𝑖𝑛(∆𝑙𝑛𝑋1𝑖 , 0)

𝑡

𝑖=1

 

Shin vd.’nin (2014) üretmiş olduğu spesifikasyonlara dayalı olarak tahmin 

edilecek doğrusal olmayan/asimetrik model aşağıda denklem 4’te sunulmuştur: 

∆𝑙𝑛𝑌 𝑡 = 𝛽0 + ∑ 𝛽1𝑖

𝑘

𝑖=1

∆𝑙𝑛𝑌𝑡−𝑖 + ∑ 𝛽2𝑖
 

𝑙

𝑖=0

∆𝑙𝑛𝑋 1𝑡−𝑖
+ + ∑ 𝛽3𝑖

 

𝑚

𝑖=0

∆𝑙𝑛𝑋 1𝑡−𝑖
− + 𝛼1𝑙𝑛𝑌𝑡−1

+ 𝛼2𝑙𝑛𝑋 1𝑡−1
+ + 𝛼3𝑙𝑛𝑋 1𝑡−1

− + 𝜇𝑡                                                              (4) 

Yukarıda denklem 4’te yer alan “Δ” fark operatörünü, değişkenlerin 

başındaki “𝑙𝑛” doğal logaritmalarının alındığını, “
t
” hata terimini, “β0” sabit 

terimi, “β1, β2 ve β3” kısa dönem katsayıları “α1, α2 ve α3” uzun dönemli 

katsayıları “k, l, m” gecikme uzunluklarını ifade etmektedir. 

Nonlinear-ARDL yönteminde eşbütünleşmenin sınanmasında F-Bounds 

ve t-Bounds Test” sınır testleri kullanılacaktır. Hem uzun hem de kısa dönem 

asimetrik ilişkilerin varlığı “Wald” testi ile sınanacaktır. Bu testin uzun dönem 

boş ve alternatif hipotezleri şu şekildedir: 

𝐻0 =  
𝛼2

−𝛼1

=
𝛼3

−𝛼1

; 𝐻𝐴 =  
𝛼2

−𝛼1

≠
𝛼3

−𝛼1

 

Wald” testinin kısa dönem boş ve alternatif hipotezleri ise şu şekilde 

gösterilebilir: 

𝐻0 = ∑ 𝛽2𝑖
 

𝑏

𝑖=0

=  ∑ 𝛽3𝑖
 

𝑐

𝑖=0

 ; 𝐻𝐴 = ∑ 𝛽2𝑖
 

𝑏

𝑖=0

≠  ∑ 𝛽3𝑖
 

𝑐

𝑖=0

 

6.2. NARDL Yönteminin Eviews Uygulaması 

NARDL modelinin tahmin edilebilmesi için öncelikle NARDL 

yamasının/eklentisinin indirilmesi gerekmektedir. Bu işlem için şu adımlar takip 

edilebilir: 

➢ İlk adım olarak Eviews paket programı ana ekranın üst tarafında yer alan 

“Add-ins” kısmından “Download Add-ins” seçeneği seçilir.  

➢ Bu işlemin ardından Şekil 6.1’de sunulan pencereden “NARDL” eklentisi 

seçilir ve sol tarafta bulunan “Install” seçeneği tıklanır. Ardından gelen 

ekranda “OK” ve iki defa da “Yes” seçenekleri ardı ardına tıklanır. 

➢ Sonrasında “NARDL: Installed successfully” uyarısı alınıp “OK” seçeneği 

tıklanır. 
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Şekil 6.1. NARDL Eklentisinin Yüklenmesi 

 

➢ Bu ekranda eklentinin gelmemesi ya da herhangi bir sorun yaşanması 

durumunda “Website” sekmesi tıklanıp internet sitesi üzerinden de bu yama 

yüklenebilir. 

➢ Hemen belirtmek gerekir ki ARDL tahmini yapmadan “Add-ins” kısmında 

bu eklenti görünmeyecektir. 

➢ Eklentinin/yamanın yüklenmesinin ardından tahmin sürecine geçilebilir. 

➢ NARDL yöntemiyle aslında saklı eşbütünleşmeleri tespit etmeye 

çalıştığımızdan özellikle ARDL yöntemine göre eşbütünleşmenin olmadığı 

örnek bir uygulama dosyası üzerinden analizler uygulanacaktır. 

➢ NARDL modelinin Eviews paket programında tahmin edilebilmesi için 

öncelikle ARDL modelinin tahmin edilmesi gerekir. ARDL modelinin 

tahmin edilmesinde bir önceki bölümde yapılan açıklamalar ve varsayımlar 

dikkate alınmalıdır. Kısaca bu tahmin şu şekilde yapılmıştır: 

➢ Öncelikli olarak seriler yüzdesel olmadığı için logaritmik dönüşüm işlemine 

tabi tutulmuştur. Daha sonra seriler çeyreklik olduğu için STL (seasonal 

trend decomposition) yöntemiyle mevsimsel arındırma işlemi 

gerçekleştirilmiştir. Değişkenlerin sonundaki “_sa” uzantısı simgesel 

kargaşaya yol açmaması için kullanılmamıştır. Bu madde kapsamında 

uygulanan adımlar için 1. Bölüm incelenebilir. 

➢ Ardından birim kök test sonucunda 𝑙𝑛𝑌 bağımlı değişkenin I(1), bağımsız 

değişken olan 𝑙𝑛𝑋1’in I(0) olduğu sonucuna varılmıştır. Dolayısıyla birim 
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kök testi sonucunda I(2) olan herhangi bir değişken yoktur. Ayrıca 

değişkenler farklı düzeylerde durağan olduğu için ARDL ve NARDL 

yöntemleri uygulanabilir. 

➢ Eviews programında ilk önce 𝑙𝑛𝑌 bağımlı değişken olmak üzere daha sonra 

bağımsız değişken olan 𝑙𝑛𝑋1 değişkeni seçilir.  

➢ İmleç seçili verilerin üzerindeyken sağ tıklanır. Açılan ekranda “Open ⇒ As 

Equation” sekmeleri sırasıyla seçilir.  

➢ Açılan ekranın “Method” kısmından “ARDL-Auto-regressive Distributed 

Lag Models” seçeneği işaretlenir.  

➢ Gelen ekranda veriler çeyreklik olduğu için “max lags”lar 4 seçilmiştir. 

(Yıllık olsaydı 2, aylık olsaydı 8 tercih edilmeliydi). Trend spesifikasyon 

kısmında “Case 3” yani sabitli model olan “3.Constant” tercih edilmiştir. 

“Tamam” seçeneği tıklanarak ARDL modeli tahmin edilmiş olur. 

➢  ARDL modelinin tahmin edilmesinin ardından “View ⇒ Label” kısmı 

seçilir. 

Şekil 6.2. NARDL Tahmini: Birinci Adım 

 

➢ “Label” seçiminin ardından aşağıda Şekil 6.3’te görünen pencere açılır. 
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Şekil 6.3. NARDL Tahmini: İkinci Adım 

 

➢ Açılan pencerede ilk olarak dikdörtgen kutunun içerisine klavyeden 

“Asyvars” yazılır. “Asyvars” yazıldıktan sonra yan satıra geçilip tüm 

bağımsız değişkenler yazılır. Bizim modelimizde bir bağımsız değişken 

olduğu için sadece 𝑙𝑛𝑋1 yazılmıştır. Ardından Aşağıda Şekil 6.4’te 

gösterildiği üzere “Add-ins ⇒ Make Nonlinear ARDL” tıklanır. 

Şekil 6.4. NARDL Tahmini: Üçüncü Adım 

 

➢ Böylece NARDL modeli tahmin edilmiş olur. 

6.3. Eşbütünleşmenin Sınanması: Sınır (Bounds) Testlerinin Uygulanması 

NARDL yönteminin uygulanmasının ardından Eviews ana ekranına 

aşağıda Şekil 6.5’te görüldüğü üzere her bir bağımsız değişken için pozitif ve 

negatif olarak ayrıştırılmış seriler (lnx1_neg ve lnx1_pos) gelecektir. Aşağıda 

Şekil 6.5’te açılan pencere üzerinden “View ⇒ Coefficient Diagnostics ⇒ Long 

Run Form and Bounds Test” sekmeleri sırasıyla tıklanır. 
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Şekil 6.5. NARDL Eşbütünleşme Testi: Birinci Adım 

 

➢ Açılan ekran aşağıya doğru kaydırıldığında (alt kısmında) “F-Bounds Test” 

ve “t-Bounds Test” değerleri aşağıda Şekil 6.6’daki gibi görülebilecektir. 

Şekil 6.6. F-Bounds Test ve t-Bounds Test Sonuçları 
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➢ Yukarıda Şekil 6.6’da görüldüğü üzere F-Bounds Test değeri 7.734372’dir. 

Bu değer I(0) ve I(1) sınır değerleriyle karşılaştırılır. 1000 gözlem değeri 

için bu değer %1 anlamlılık düzeyinde üst sınır değer olan 6.36 değerinden 

büyüktür. Dolayısıyla F-Bounds Test sonucuna göre oluşturulan model %1 

anlamlılık seviyesinde asimetrik olarak eşbütünleşiktir.  

➢ Çalışmada gözlem sayısı 68’dir. Veriler çeyreklik olduğu için maksimum 

gecikme uzunluğu 4 olarak belirlenmiş ve en uygun modelin NARDL (3, 2, 

1) olduğu tespit edilmiştir. Dolayısıyla gecikme uzunluklarının 

düşülmesinin ardından çalışmanın gerçek gözlem sayısı 65 olarak ortaya 

çıkar. Yukarda Şekil 6.6’da görüldüğü üzere 65 gözlem değeri için 7.734372 

değeri %1 anlamlılık düzeyinde üst sınır değer olan 6.853 değerinden 

büyüktür. Dolayısıyla F-Bounds Test sonucuna göre oluşturulan model 

sınırlı gözlem değeri için de %1 anlamlılık seviyesinde asimetrik olarak 

eşbütünleşiktir.  

➢ Yukarda Şekil 6.6’da görüldüğü üzere “t-Bounds Test” değeri  -

3.472039’dur. Bu değer I(0) ve I(1) sınır değerleriyle karşılaştırılır. -

3.472039 değeri %10 anlamlılık düzeyinde üst sınır değer olan -3.21’in 

mutlak değer olarak üzerindedir. Dolayısıyla “t-Bounds Test” sonucuna göre 

oluşturulan model %10 anlamlılık seviyesinde asimetrik olarak 

eşbütünleşiktir.  

➢ Sonuç olarak sınır test sonuçlarının tamamı için oluşturulan model farklı 

anlamlılık seviyelerinde asimetrik olarak eşbütünleşiktir. Dolayısıyla 

değişkenlerin doğrusal olmayan birleşimlerinin denge noktasına yakınsadığı 

yani, uzun dönemde asimetrik olarak birlikte hareket ettikleri sonucuna 

varılabilir.  

6.4. Uzun Dönemli Katsayıların Tahmini 

Denklem 4’te uzun dönem katsayılarını ifade eden “α_2  ve α_(3 ) " 

değerleri F-Bounds ve t-Bounds Test sonuçlarının olduğu ekranda “Levels 

Equation/Case 3: Unrestricted Constant and No Trend” başlığı altında yer 

almaktadır. Burada yer alan iki değişken lnX_1 bağımsız değişkeninin pozitif ve 

negatif olarak ayrıştırılmış hallerini ifade eder. 

➢ Bu katsayılara ana ekrana kaydedilen “NARDL” eşitliğine çift tıklayarak da 

ulaşılabilir. 

➢ Aşağıdada Şekil 6.7’de gösterilen uzun dönem katsayı sonuçlarına göre 

LNX1_POS değişkenin uzun dönem katsayısı negatif olup -1.345122’dir. 

𝑙𝑛𝑋1 değişkeninde meydana gelecek %1’lik bir artış 𝑙𝑛𝑌 değişkenini 

yaklaşık %1.35 oranında azaltır. Bu sonuç %5 önem seviyesinde anlamlıdır. 

Çünkü LNX1_POS değişkeninin “prob.” (olasılık) değeri 0.0276 olup 

0.05’ten küçüktür. 
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Şekil 6.7. NARDL Uzun Dönem Tahmin Sonuçları 

 

➢ Öte yandan LNX1_NEG değişkenin uzun dönem katsayısı da negatif olup 

katsayı değeri -2.395303’tür. Bu sonuç şöyle yorumlanabilir: 𝑙𝑛𝑋1 değişkeni 

%1 azalırsa 𝑙𝑛𝑌 değişkenini yaklaşık %2.40 oranında artar. Bu sonuç %1 

önem seviyesinde anlamlıdır. Çünkü LNX1_NEG değişkeninin “prob.” 

(olasılık) değeri 0.0021 olup 0.01’den küçüktür.  

➢ Bu arada hemen belirtmek gerekir ki tüm değişkenler yüzdesel olduğu için 

yüzde olarak yorumlanmıştır. Benzer bir değerlendirme (yüzdesel 

yorumlama), değişkenlerin tamamı logaritmik olduğu durumda ya da 

logaritmik ve yüzdesel değişkenlerin modelde karışık olarak yer aldığı 

durumda da yapılabilirdi. Ancak değişkenler yüzdesel ya da logaritmik 

olmadığı durumlarda sonuçlar yorumlanırken “%1 artarsa ya da azalırsa” 

demek yerine “1 birim artarsa ya da azalırsa” demek daha uygun olacaktır. 

6.5. Uzun Dönem Asimetrik İlişkilerin Test Edilmesi: Wald Testi 

Uygulaması 

Bu başlık altında asimetrik ilişkilerin varlığı kısa ve uzun dönemde ayrı 

ayrı sınanacaktır.  

➢ NARDL F-Bound testi ekranı açıkken “Conditional Error Correction 

Regression” başlığı altında bulunan değişkenlerin sadece isimleri seçilip 

Mouse’un sağ tuşuna tıklanarak kopyalanmalıdır. Bu adımın ekran 

görüntüsü aşağıda Şekil 6.8’de gösterilmiştir. 
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Şekil 6.8. Asimetrik İlişkilerin Tespiti: Birinci Adım 

 

➢ Daha sonra Eviews ana ekranının en üstünde bulunan “Quick ⇒ Estimate 

Equation” tıklanır.  

Şekil 6.9. Asimetrik İlişkilerin Tespiti: İkinci Adım 
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➢ Açılan ekranda Method kısmından “STEPLS” Şekil 6.10’daki gibi seçilir.  

Şekil 6.10. Asimetrik İlişkilerin Tespiti: Üçüncü Adım 

 

➢ Kopyalanmış olan değişkenlerden başında “D” olanlar alt kısma; “D” 

olmayanlar üst tarafa yapıştırılır. Yapıştırma işleminin ardından bazı 

değişkenlerin sonunda yer alan * veya ** işaretleri silinir. Üst kısmın en 

başına (C değişkeninden önce) bağımlı değişken olan 𝑙𝑛𝑌 eklenir. 

Aralarında bir boşluk olacak şekilde aşağıda Şekil 6.11’de sunulan ekran 

görüntüsündeki gibi yazılır.  

Şekil 6.11. Asimetrik İlişkilerin Tespiti: Dördüncü Adım 
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➢ “Option” kısmına tıklanır. “Selection Method” kısmından “Uni-directional” 

seçilir. Daha sonra “Backwars” işaretlenip “p-value” değeri 0.10 olarak 

aşağıda Şekil 6.12’de görüldüğü gibi değiştirilir ve “Tamam” sekmesine 

tıklanır. 

Şekil 6.12. Asimetrik İlişkilerin Tespiti: Beşinci Adım 

 

➢  Aşağıdaki ekran görüntüsü elde edilir (Şekil 6.13).  

Şekil 6.13. Asimetrik İlişkilerin Tespiti: Altıncı Adım 
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➢ Ardından açık olan ekran üzerinden aşağıda Şekil 6.14’te görüldüğü gibi 

“View ⇒ Representations” sekmeleri tıklanır. 

Şekil 6.14. Asimetrik İlişkilerin Tespiti: Yedinci Adım 

 

➢ Böylece aşağıda Şekil 6.15’te görülen ekran görüntüsü elde edilir. Bundan 

sonra uygulanacak olan “Wald” testleri “Estimation Equation” denklemi için 

yapılacaktır.  

Şekil 6.15. Asimetrik İlişkilerin Tespiti: Sekizinci Adım 

 



91 

 

Estimation Equation: 

========================= 

LNY = C(1) + C(2)*LNY(-1) + C(3)*LNX1_POS(-1) + C(4)*LNX1_NEG(-1) +  

C(5)*D(LNX1_POS) + C(6)*D(LNY(-1)) + C(7)*D(LNX1_POS(-1)) + 

C(8)*D(LNX1_NEG) + C(9)*D(LNY(-2)) 

➢ Açık olan ekranda “View ⇒ Coefficient Diagnostic ⇒ Wald Test Coefficient 

Restrictions” seçenekleri aşağıda Şekil 6.16’daki gibi sırasıyla seçilir.  

Şekil 6.16. Asimetrik İlişkilerin Tespiti: Dokuzuncu Adım 

 

➢ Bu seçimlerin ardından aşağıda Şekil 6.17’de sunulan “Wald testi” için 

denklemlerin yazılacağı ekran açılır. 

Şekil 6.17. Uzun Dönem Wald Testi Veri Girişi 
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➢ Gelen ekrana “-C(3)/C(2)=-C(4)/C(2)” yazılıp “OK” sekmesi tıklanır. 

Aslında “Wald testi” ile 𝑙𝑛𝑋1 katsayısındaki bir dönem gecikmeli azalışların 

bağımlı değişkenin bir dönem gecikmeli değerine oranıyla 𝑙𝑛𝑋1 

katsayısındaki bir dönem gecikmeli artışların bağımlı değişkenin bir dönem 

gecikmeli değerine oranı birbirine eşit mi?” sorusuna cevap aranmaktadır. 

Bu denklemin yerine matematiksel olarak sadeleşmiş hali olan C(3)=C(4) 

denklemi de yazılabilir. Wald testi sonucu aşağıda Şekil 6.18’de 

sunulmuştur. 

Şekil 6.18. Uzun Dönem Wald Testi Sonuçları 

 

➢ “Wald” testi sonuçlarına göre uzun dönemde H0 hipotezi %1 anlamlılık 

seviyesinde reddedilir. Çünkü olasılık değeri 0.01’den küçüktür. Bu sonuç 

𝑙𝑛𝑋1 değişkenindeki artışlarla azalışlar arasında uzun dönemde asimetrik bir 

ilişki olduğunu kanıtlar. Dolayısıyla bu sonuç, 𝑙𝑛𝑋1 değişkenindeki 

artışların 𝑙𝑛𝑌 değişkeni üzerindeki etkisiyle 𝑙𝑛𝑋1 değişkenindeki azalışların 

𝑙𝑛𝑌 değişkeni üzerindeki etkisinin uzun dönemde aynı olmadığı savını 

desteklemektedir. 

6.6. Kısa Dönem Asimetrik İlişkilerin Test Edilmesi: Wald Testi 

Uygulaması 

   Bir önceki başlıkta “Wald” testi uzun dönem için uygulanmış ve 

sonuçları sunulmuştur. Bu başlık altında kısa dönemde “Wald” testi adımları 

anlatılacaktır. Testin uygulanma safahatı aynı olmakla birlikte kısa dönem için 
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𝑙𝑛𝑋1değişkeninin “D”(diffrence’ın kısaltması) ile başlayan aşağıda yeşil renkle 

gösterilen katsayılardan pozitif olanlarla negatif olanlar eşitlenir.  

Estimation Equation: 

========================= 

LNY = C(1) + C(2)*LNY(-1) + C(3)*LNX1_POS(-1) + C(4)*LNX1_NEG(-1) +  

C(5)*D(LNX1_POS) + C(6)*D(LNY(-1)) + C(7)*D(LNX1_POS(-1)) + 

C(8)*D(LNX1_NEG) + C(9)*D(LNY(-2)) 

➢ “Wald” testinin kısa dönemde uygulanması için açık olan ekranda “View ⇒ 

Coefficient Diagnostic ⇒ Wald Test Coefficient Restrictions” seçenekleri 

sırasıyla seçilir.  

➢ Bu seçimlerin ardından aşağıda Şekil 6.19’da sunulan “Wald” testi için 

denklemlerin yazılacağı ekran açılır. Gelen ekrana “C(5)+C(7)=C(8)” 

yazılıp “OK” sekmesine tıklanır. 

Şekil 6.19. Kısa Dönem Wald Testi Veri Girişi 

 

Şekil 6.20. Kısa Dönem Wald Testi Sonuçları 
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➢ Yukarıda Şekil 6.20’de yer alan “Wald” testi sonuçlarına göre uzun 

dönemde H0 hipotezi %1 anlamlılık seviyesinde reddedilir. Çünkü olasılık 

değeri 0.01’den küçüktür. Bu sonuç 𝑙𝑛𝑋1 değişkenindeki artışlarla azalışlar 

arasında kısa dönemde asimetrik bir ilişki olduğunu kanıtlar. Dolayısıyla bu 

sonuç, 𝑙𝑛𝑋1 değişkenindeki artışların 𝑙𝑛𝑌 değişkeni üzerindeki etkisiyle 

𝑙𝑛𝑋1 değişkenindeki azalışların 𝑙𝑛𝑌  değişkeni üzerindeki etkisinin kısa 

dönemde aynı olmadığı savını desteklemektedir.  

6.7. NARDL Yönteminde Tanısal Testler 

Tahmin edilen model sonucunda elde edilen bulguların sağlamlılığının kontrolü 

“diagnostic” ya da tanısal testlerle sağlanır. Çalışma kapsamında uygulanacak 

olan tanısal testlerin açıklamaları için 5.5. numaralı başlık incelenebilir. Bu 

başlık altında tanısal testlerin Eviews uygulama adımları sunularak sonuçlar 

değerlendirilecektir. 

6.7.1. Normallik Testi 

➢ Normal dağılım sınamasında “Jarque-Bera” testi kullanılacaktır. Bu testin 

Eviews adımları şöyledir: NARDL kısa veya uzun dönem katsayılarının 

tahmin edildiği ekrandan “View ⇒ Residual Diagnostics ⇒ Histogram – 

Normality Test” seçenekleri sırasıyla seçilir. 

➢ Bu seçimlerin ardından hata terimlerinin Jarque-Bera testi ve olasılık 

değerleri Şekil 6.21’deki gibi görünür. 

Şekil 6.21. Jarque-Bera Test Sonucu 
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➢ “Jarque-Bera” test değeri 0.497206 olup olasılık değeri de 0.779889’dur. 

“Jarque-Bera” testinin olasılık değeri 0.10’dan büyük olduğu için modelin 

normal dağılıma uygun olduğu söylenebilir. 

6.7.2. Otokorelasyon Testi 

➢ Otokorelasyon sınaması için uygulanacak olan “Breusch-Godfrey Serial 

Correlation LM” testinin Eviews adımları şu şekildedir: NARDL kısa veya 

uzun dönem katsayılarının tahmin edildiği ekrandan “View ⇒ Residual 

Diagnostics ⇒ Serial Correlation LM Test” seçenekleri sırasıyla seçilir. 

Ardından “lag specification” ekranında gecikme uzunluğu otomatik olarak 

“2” gelmiştir. Son olarak “OK” sekmesine tıklanır. “Breusch-Godfrey Serial 

Correlation LM” testinin sonuç ekranı aşağıda Şekil 6.22’deki gibidir. 

Şekil 6.22. Breusch-Godfrey Serial Correlation LM Testi Sonucu 

 

➢ Yukarda sunulan LM test değeri 0.677320 olup olasılık değeri 0.7127’dir. 

Olasılık değeri 0.10’dan büyük olduğu için modelde otokorelasyon sorunu 

yoktur. 

6.7.3. Değişen Varyans (Farklı Yayılım, Heteroskedasticity)Testi 

Değişen varyans sınaması için uygulanacak olan “Breusch-Pagan-

Godfrey” testi Eviews adımları şu şekildedir:  

➢ NARDL kısa veya uzun dönem katsayılarının tahmin edildiği ekrandan 

“View ⇒ Residual Diagnostics ⇒ Heteroskedasticity” seçenekleri sırasıyla 

seçilir. Ardından gelen ekranda “Breusch-Pagan-Godfrey” testi seçilerek 

“OK” sekmesine tıklanır. Bu testin sonuç ekranı aşağıda Şekil 6.23’teki 

gibidir. 

Şekil 6.23. Breusch-Pagan-Godfrey Testi Sonucu 
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➢ “Breusch-Pagan-Godfrey” testinin katsayı değeri 8.272639 olup olasılık 

değeri 0.4073’tür. Olasılık değeri 0.10’dan büyük olduğu için modelde 

değişen varyans sorunu yoktur. 

Değişen varyans sınaması için uygulanan ikinci test olan “ARCH” 

testinin Eviews adımları şu şekildedir:  

➢ NARDL kısa veya uzun dönem katsayılarının tahmin edildiği ekrandan 

“View ⇒ Residual Diagnostics ⇒ Heteroskedasticity” seçenekleri sırasıyla 

tıklanır. Ardından gelen ekranda “ARCH” testi seçilerek “OK” tuşuna 

tıklanır. “ARCH” testi sonuçları aşağıda Şekil 6.24’te sunulmuştur. 

Şekil 6.24. ARCH Değişen Varyans Testi Sonucu 

 

➢ Bu testin katsayı değeri 0.327561 olup olasılık değeri 0.5671’dir. Olasılık 

değeri 0.10’dan büyük olduğu için modelde değişen varyans sorunu yoktur. 

6.7.4. Fonksiyonel Form (Biçim) Testi 

Tahmin edilen modelde herhangi bir spesifikasyon hatasının olup 

olmadığının tespiti için “Ramsey-RESET” testi uygulanmıştır. “Ramsey-

RESET” testinin Eviews adımları şu şekildedir:  

➢ NARDL kısa veya uzun dönem katsayılarının tahmin edildiği ekrandan 

“View ⇒ Stability Diagnostics ⇒ Ramsey RESET Test” seçenekleri 

sırasıyla belirlenir. Bu ekranda “number of fitted terms” otomatik olarak 1 

gelmiştir. Son olarak “OK” tuşuna tıklanır. “Ramsey RESET” testi sonuçları 

aşağıda Şekil 6.25’te sunulmuştur.  

Şekil 6.25. Ramsey RESET Testi Sonucu 
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➢ Bu testin katsayı değeri 1.217981 olup olasılık değeri 0.2292’dir. Olasılık 

değeri 0.10’dan büyük olduğu için model kurma hatası yoktur. 

6.7.5. CUSUM ve CUSUM2 Grafikleri 

CUSUM ve CUSUM2 grafiklerini elde etmek için uygulanması gereken 

Eviews adımları şu şekildedir:  

➢ NARDL Kısa veya uzun dönem katsayılarının tahmin edildiği ekrandan 

“View ⇒ Stability Diagnostics ⇒ Recursive Estimates ⇒ önce CUSUM Test 

daha sonra CUSUM of Squares Test” seçenekleri sırasıyla seçilir. Ardından 

“OK” tuşuna tıklanır.  

➢ Bu grafikler NARDL tahmin ekranı açıkken “Add-ins” tıklanarak buradaki 

seçeneklerden de otomatik olarak oluşturulabilir. CUSUM ve CUSUM2 

grafikleri aşağıda Şekil 6.26 ve 6.27’de sunulmuştur. 

Şekil 6.26. CUSUM Grafiği 

 

Şekil 6.27. CUSUM2 Grafiği 
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➢ Brown vd. (1975) tarafından önerilen CUSUM testi, hata terimlerinin %95 

güven aralığında istenilen sınırlar içerisinde olup olmadığını gösterirken 

CUSUM2 testi ise kümülatif hata terimlerinin kareleri için aynı sınamayı 

yapmaktadır (Çetin vd. 2014). Ayrıca Şekil 6.27 ve 6.28’de sunulan 

CUSUM ve CUSUM2 grafiklerinin %95 güven aralığında, istenilen sınırlar 

içerisinde olduğu görülmektedir. Bu sonuç doğrultusunda, kurulan modelin 

istikrarlı olduğunu söylenebilir. 
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7. BÖLÜM 

TODA-YAMAMOTO NEDENSELLİK TESTİ 

Toda ve Yamamoto (1995) tarafından önerilen bu nedensellik yöntemi 

durağanlık gereksinimleri açısından oldukça esnek bir yöntemdir. Bu 

yöntemdeki uygulama adımları şu şekilde özetlenebilir: 

➢ VAR modeli için en uygun gecikme uzunluğu tespit edilir. 

➢ En uygun gecikme uzunluğuna en yüksek bütünleşme derecesi eklenir.  

➢ Eklenmiş bu değer üzerinden VAR modeli tahmin edilir. Y’nin bağımlı 

değişken olduğu X1 ve X2’nin bağımsız değişken olduğu bir denklemde, 

VAR modelleri şu şekildedir:  

𝑌𝑡 = 𝛼0 + ∑ 𝛽1𝑖

𝑘+𝑑𝑚𝑎𝑥

𝑖=1

𝑌𝑡−𝑖 + ∑ 𝛽2𝑖

𝑘+𝑑𝑚𝑎𝑥

𝑖=1

𝑋1𝑡−𝑖 + ε1𝑡                                                       (1) 

H0: X1⇏Y (X1’den Y’ye doğru nedensellik yoktur). 

HA: X1⇒Y (X1’den Y’ye doğru nedensellik vardır). 

𝑋1𝑡 = 𝛼1 + ∑ 𝛽3𝑖

𝑘+𝑑𝑚𝑎𝑥

𝑖=1

𝑋1𝑡−𝑖 + ∑ 𝛽4𝑖

𝑘+𝑑𝑚𝑎𝑥

𝑖=1

𝑌𝑡−𝑖 + ε2𝑡                                                   (2) 

H0: Y ⇏ X1 (Y’den X1’e doğru nedensellik yoktur). 

HA: Y ⇒ X1 (Y’den X1’e doğru nedensellik vardır). 

𝑌𝑡 = 𝛼2 + ∑ 𝛽5𝑖

𝑘+𝑑𝑚𝑎𝑥

𝑖=1

𝑌𝑡−𝑖 + ∑ 𝛽6𝑖

𝑘+𝑑𝑚𝑎𝑥

𝑖=1

𝑋2𝑡−𝑖 + ε1𝑡                                                       (3) 

H0: X2⇏Y (X2’den Y’ye doğru nedensellik yoktur). 

HA: X2⇒Y (X2’den Y’ye doğru nedensellik vardır). 
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𝑋2𝑡 = 𝛼3 + ∑ 𝛽7𝑖

𝑘+𝑑𝑚𝑎𝑥

𝑖=1

𝑋2𝑡−𝑖 + ∑ 𝛽8𝑖

𝑘+𝑑𝑚𝑎𝑥

𝑖=1

𝑌𝑡−𝑖 + ε2𝑡                                                   (4) 

H0:Y ⇏ X2 (Y’den X2’e doğru nedensellik yoktur). 

HA:Y ⇒ X2 (Y’den X2’e doğru nedensellik vardır). 

𝑋1𝑡 = 𝛼4 + ∑ 𝛽9𝑖

𝑘+𝑑𝑚𝑎𝑥

𝑖=1

𝑋1𝑡−𝑖 + ∑ 𝛽10𝑖

𝑘+𝑑𝑚𝑎𝑥

𝑖=1

𝑋2𝑡−𝑖 + ε1𝑡                                              (5) 

H0: X2⇏X1 (X2’den X1’e doğru nedensellik yoktur). 

HA: X2⇒X1 (X2’den X1’e doğru nedensellik vardır). 

𝑋2𝑡 = 𝛼5 + ∑ 𝛽11𝑖

𝑘+𝑑𝑚𝑎𝑥

𝑖=1

𝑋2𝑡−𝑖 + ∑ 𝛽12𝑖

𝑘+𝑑𝑚𝑎𝑥

𝑖=1

𝑋1𝑡−𝑖 + ε2𝑡                                            (6) 

H0: X1⇏ X2 (X1’den X2’e doğru nedensellik yoktur). 

HA: X1⇒ X2 (X1’den X2’e doğru nedensellik vardır). 

Şekil 7.1. VAR Spesifikasyonlarının Belirlenmesi 
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Toda ve Yamamoto (1995) nedensellik testi için yukarıda anlatılan 

hususların Eviews üzerinden uygulaması şu şekilde yapılabilir: 

➢ Eviews programında önce bağımlı değişken olmak üzere daha sonra 

modelde yer alan bağımsız değişkenlerin tamamı seçilir.  

➢ İmleç seçili verilerin üzerindeyken sağ tıklanır. Açılan ekranda “Open ⇒ As 

VAR…” sekmeleri sırasıyla seçilir. Bu pencerede VAR modelinin 

spesifikasyonları belirlenir. Bu adımın Eviews ekran görüntüsü yukarıda 

Şekil 7.1’de sunulmuştur. 

➢ Modele kukla değişken dahil edilecekse “Exogenous variable” kısmından 

eklenir. Standart “VAR” modeli için “Tamam” seçeneği seçilir. 

➢ Gelen ekrandan Şekil 7.2’de görüldüğü üzere “View ⇒ Lag Structure ⇒ Lag 

Length Criteria” seçenekleri işaretlenir ve ardından gelen ekranda otomatik 

seçili olan “Lag Specification” değiştirilmeden “OK” seçeneğine tıklanır. 

Gözlem sayısı ne kadar büyükse gecikme uzunluğu da o kadar yüksek 

olacaktır. Bu modelde gecikme uzunluğu 3 olarak gelmiştir. 

Şekil 7.2. Optimum Gecikme Uzunluğunun Tespiti: Birinci Adım 

 

➢ Aşağıda Şekil 7.3’ten de görüleceği üzere SIC (Schwarz Bilgi Kriteri) hariç 

tüm bilgi kriterlerine göre gecikme uzunluğu 2’dir (yıldızlı değerler!). 

Gecikme uzunluğunun tespitinde Akaike Bilgi Kriteri (AIC) dikkate alındığı 

için gecikme uzunluğunun 2 olmasına karar verilmiştir. 
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Şekil 7.3. Optimum Gecikme Uzunluğu Sonucu 

 

➢ Sırada yapılması gereken işlem en uygun gecikme uzunluğuna en yüksek 

bütünleşme derecesinin eklenmesidir. Serilere uygulanan birim kök testi 

sonuçlarına göre değişkenlerin I(1) ve I(0) olduğu bulunmuştur. Dolayısıyla 

maksimum bütünleşme derecesi olarak ifade edilen dmax=1 olduğuna karar 

verilmiştir (Birim kök testleri için detaylı bilgiye 4. Bölümden ulaşılabilir). 

En uygun gecikme uzunluğunu ifade eden k=2, dmax=1 olduğundan k+dmax=3 

olduğuna karar verilmiştir. Dolayısıyla yukarıda Şekil 7.3’te dikdörtgen 

kutucuk içerisinde yer alan “Estimate” kısmına tıklanarak “Lag Intervals for 

Endogenous” kısmında “1 2” olan değer “1 3” olarak değiştirilerek 

“Tamam” seçeneği tıklanır.  

7.1. Tanısal testler 

Tahmin edilen VAR modelinin istikrarlı olup olmadığı Eviews programı 

üzerinden şu şekilde tespit edilebilir: 

➢ Aşağıda Şekil 7.4’te görüldüğü gibi tahmin edilen “VAR” modeli üzerinden 

“Lag Structure ⇒ AR Roots Graph ya da AR Roots Table” seçeneği tıklanır. 
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Şekil 7.4. AR Roots Graph / Table Oluşturma 

 

➢ Aşağıda Şekil 7.5’ten de görüleceği üzere “AR Roots” grafiğine göre tüm 

ters köklerin birim çemberin iç bölgesinde yer alması ve tüm köklerin birden 

küçük olması modelin istikrarlı olduğunu gösterir. Aynı sonuçlar “AR Roots 

Table” sonuç tablosundan da görülebilir. 

Şekil 7.5. AR Roots Graph / Table Sonuçları 

 

➢ Modelin istikrarlı olduğuna karar verildikten sonra oluşturulan “VAR” 

modelinde otokorelasyon sorunu olup olmadığı test edilir. Otokorelasyon 

testi için aşağıda Şekil 7.6’daki gibi “View ⇒ Residual Tests⇒ 

Autocorrelation LM Test” seçenekleri sırasıyla seçilir. Ardından açılan 

“Lags to include” kısmına (k+dmax=3 olduğundan) “3” yazılır ve “OK” 

seçeneği tıklanır. 
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Şekil 7.6. Otokorelasyon Sınamasının Yapılması 

 

➢ “OK” seçeneğine tıklanmasının ardından aşağıda Şekil 7.7’de “VAR” 

modeli için otokorelasyon testi sonuçları sunulmuştur. “3” gecikme 

uzunluğuna göre hesaplanan olasılık (Prob.) değerleri 0.10’dan büyük 

olduğundan tahmin edilen “VAR” modelinde herhangi bir otokorelasyon 

sorunu yoktur. 

Şekil 7.7. Otokorelasyon Sınaması Sonuçları 
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➢ Otokorelasyon sınamasının ardından tahmin edilen “VAR” modelinin 

normal dağılım gösterip göstermediğinin test edilmesine geçilebilir. 

Normallik testi için kullanılacak olan “Jarque-Bera” testinde şu adımlar 

takip edilmelidir: “View ⇒ Residual Tests⇒ Normality Test” seçimlerinin 

ardından “OK” seçeneği tıklanır. 

Şekil 7.8. Normallik Sınaması 

 

➢ Oluşturulan “VAR” modeli için hesaplanan “Jarque-Bera” testi olasılık 

(Prob.) değerleri 0.10’dan büyük olduğundan model normal dağılıma 

uygundur (Şekil 7.8). 

Tanısal test sonuçlarına göre oluşturulan “VAR” modelinin sağlam bir model 

olduğuna karar verilmiş olup artık nedensellik sınamasına geçilebilir. 

7.2. Toda-Yamamoto Nedensellik Testi 

Toda-Yamamoto nedensellik testi için şu adımlar takip edilmelidir:  

➢ “Proc ⇒ Make System ⇒ Order by Variable” seçenekleri aşağıda Şekil 

7.9’daki gibi sırasıyla seçilir. 
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Şekil 7.9. Toda-Yamamoto Nedensellik Testi: Birinci Adım 

 

➢ Bu seçimlerin ardından üç gecikmeli değerlerine göre bağımlı değişkenin 

yanında diğer bağımsız değişkenlerin de bağımlı değişken olarak yer aldığı 

denklemler aşağıda Şekil 7.10’daki gibi ana ekrana gelecektir. 

Şekil 7.10. Toda-Yamamoto Nedensellik Testi: İkinci Adım 

 

➢ Yukarıda denklemlerin yer aldığı Şekil 7.10’da siyah dikdörtgen kutunun 

içerisinde yer alan “Estimate” seçeneği tıklanır. Ardından Şekil 7.11’deki 

gibi “Estimation method” kısmından “Seemingly Unrelated Regression” 

seçeneği seçilip “Tamam” seçeneğine tıklanır. 
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Şekil 7.11. Toda-Yamamoto Nedensellik Testi: Üçüncü Adım 

 

➢ Tüm bu adımların ardından açılan pencere aşağıya doğru kaydırıldığı zaman 

Y’nin, X1’in ve X2’nin bağımlı değişken olduğu denklemler aşağıda Şekil 

7.12’deki gibi oluşacaktır.  

Şekil 7.12. Toda-Yamamoto Nedensellik Testi Sonucu 
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➢ Tabloda görüldüğü üzere Y’nin bağımlı değişken olduğu denklem aşağıda 

yer almaktadır. 

Equation: Y = C(1)*Y(-1) + C(2)*Y(-2) + C(3)*Y(-3) + C(4)*X1(-1) + C(5)*X1(-2) + 

C(6)*X1(-3) + C(7)*X2(-1) + C(8)*X2(-2) + C(9)*X2(-3) + C(10) 

➢ Sarı renkle gösterilen X1 değişkeninin bir, iki ve üç dönem gecikmeli 

değerlerinden (C(4), C(5) ve C(6)) Y değişkenine doğru nedensellik olup 

olmadığı “Wald” testleri yardımıyla sınanır. Bu test için şu adımlar takip 

edilebilir: “View ⇒ Coefficient Diagnostics ⇒ Wald Coefficient Test” 

seçenekleri Şekil 7.13’teki gibi sırasıyla seçilir. 

Şekil 7.13. Wald Testi: Birinci Adım (X1 ⇒ Y) 

 

➢ Açılan “Wald” testi ekranına X1’den Y’ye doğru nedensellik olmadığını 

ifade eden H0 hipotezi için Şekil 7.14’teki gibi şu şekilde bir denklem yazılır: 

“C(4)=C(5)=C(6)=0” ve “OK” seçeneği tıklanır. 

Şekil 7.14. Wald Testi: İkinci Adım (X1 ⇒ Y) 
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➢ Aşağıda Şekil 7.15’te “Wald” testi sonuçları sunulmuştur. Buna göre 

hesaplanan test değeri 15.74194 iken 3 serbestlik derecesine göre olasılık 

(Prob.) değeri 0,0013’tür.  

Şekil 7.15. Wald Testi Sonucu (X1 ⇒ Y) 

 

➢ Ancak hatırlanacağı üzere en uygun gecikme uzunluğunu ifade eden “k” 

değeri 2 olarak belirlenmişti. Dolayısıyla olasılık (Prob.) değerinin “2” 

serbestlik derecesine göre hesaplanması gerekir. Bu hesaplama için boş bir 

Excel sayfası açılarak herhangi bir hücreye tıklanır. Ardından 

“=KİKAREDAĞ(15.74194;2)” yazılarak klavyeden “enter” tuşuna basılır. 

Şekil 7.16. Wald Testi: Serbestlik Derecesi 2’ye Göre Olasılık Değeri 

Hesaplama (X1 ⇒ Y) 
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➢ Yukarıda Şekil 7.16’da sunulan Excel sayfasından da görüldüğü üzere 

serbestlik derecesi 2’ye göre hesaplanan olasılık değeri 0.0004’tür. 

Dolayısıyla nedenselliğin olmadığını ifade eden H0 hipotezi reddedilirken 

nedenselliğin olduğunu ifade eden HA hipotezi kabul edilir. Sonuç olarak %1 

anlamlılık seviyesinde, X1 değişkeninden Y değişkenine doğru nedensellik 

ilişkisi vardır. 

➢ X2 değişkeninden Y değişkenine doğru olan nedensellik ilişkisini test etmek 

için benzer adımlar izlenir. Denklemde yeşil renkle gösterilen X2 

değişkeninin bir, iki ve üç dönem gecikmeli değerlerinden (C(7), C(8) ve 

C(9)) Y değişkenine doğru nedensellik ilişkisinin olup olmadığı “Wald” 

testleri yardımıyla sınanır. Bu test için şu adımlar takip edilebilir: 

➢ “View ⇒ Coefficient Diagnostics ⇒ Wald Coefficient Test” seçenekleri 

sırasıyla seçilir. Açılan “Wald Test” ekranına X2’den Y’ye doğru 

nedensellik olmadığını ifade eden H0 hipotezi için Şekil 7.17’deki gibi şu 

şekilde (C(7)=C(8)=C(9)=0) bir denklem yazılır ve “OK” seçeneği tıklanır. 

Şekil 7.17. Wald Testi: Birinci Adım (X2 ⇒ Y) 
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➢ Aşağıda Şekil 7.18’de “Wald” testi sonuçları sunulmuştur. “Wald” testi 

sonucuna göre hesaplanan test değeri 11.51025 iken 3 serbestlik derecesine 

göre olasılık (Prob.) değeri 0.0093’tür.  

Şekil 7.18. Wald Testi Sonucu (X2 ⇒ Y) 

 

➢ Ancak hatırlanacağı üzere en uygun gecikme uzunluğunu ifade eden “k” 

değeri 2 olarak belirlenmişti. Dolayısıyla olasılık (Prob.) değerinin “2” 

serbestlik derecesine göre hesaplanması gerekir. Bu hesaplama için Şekil 

7.19’daki gibi boş bir Excel sayfası açılarak herhangi bir hücreye tıklanır. 

Ardından “=KİKAREDAĞ(11.51025;2)” yazılarak klavyeden “enter” 

tuşuna basılır. 

Şekil 7.19. Wald Testi: Serbestlik Derecesi 2’ye Göre Olasılık Değeri 

Hesaplama (X2 ⇒ Y) 
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➢ Yukarıda Şekil 7.19’da sunulan Excel sayfasından da görüldüğü üzere, 2 

serbestlik derecesine göre hesaplanan olasılık değeri 0.0032’dir. Dolayısıyla 

nedenselliğin olmadığını ifade eden H0 hipotezi reddedilirken nedenselliğin 

olduğunu ifade eden HA hipotezi kabul edilir. Sonuç olarak %1 anlamlılık 

seviyesinde, X2 değişkeninden Y değişkenine doğru nedensellik ilişkisi 

vardır. 

➢ “Seemingly Unrelated Regression” tahmin yöntemine göre X1’in bağımlı 

değişken olduğu denklem aşağıda yer almaktadır. 

Equation: X1= C(11)*Y(-1) + C(12)*Y(-2) + C(13)*Y(-3) + C(14)*X1(-1) + 

C(15)*X1(-2) + C(16)*X1(-3) + C(17)*X2(-1) + C(18)*X2(-2) + C(19)*X2(-3) + C(20) 

➢ Sarı renkle gösterilen Y değişkeninin bir, iki ve üç dönem gecikmeli 

değerlerinden (C(11), C(12) ve C(13)) X1 değişkenine doğru nedensellik 

olup olmadığı “Wald” testleri yardımıyla sınanır. Bu test için şu adımlar 

takip edilebilir:  

➢ “View ⇒ Coefficient Diagnostics ⇒ Wald Coefficient Test” seçenekleri 

sırasıyla seçilir. Açılan “Wald Test” ekranına Y’den X1’e doğru nedensellik 

olmadığını ifade eden H0 hipotezi için şu şekilde “C(11)=C(12)=C(13)=0” 

bir denklem yazılır ve “OK” seçeneği tıklanır. 

Şekil 7.20. Wald Testi: Birinci Adım (Y ⇒ X1) 
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➢ Aşağıda Şekil 7.21’de “Wald” testi sonuçları sunulmuştur. “Wald” testi 

sonucuna göre hesaplanan test değeri 12.68912 iken 3 serbestlik derecesine 

göre olasılık (Prob.) değeri 0.0054’tür.  

Şekil 7.21. Wald Testi Sonucu (Y ⇒ X1) 

 

➢ Ancak hatırlanacağı üzere en uygun gecikme uzunluğunu ifade eden “k” 

değeri 2 olarak belirlenmişti. Dolayısıyla olasılık (Prob.) değerinin “2” 

serbestlik derecesine göre hesaplanması gerekir. Bu hesaplama için boş bir 

Excel sayfası açılarak herhangi bir hücreye tıklanır. Ardından 

“=KİKAREDAĞ(12.68912;2)” yazılarak klavyeden “enter” tuşuna basılır. 

Şekil 7.22. Wald Testi: Serbestlik Derecesi 2’ye Göre Olasılık Değeri 

Hesaplama (Y ⇒ X1) 

 



114 

 

➢ Yukarda Şekil 7.22’de sunulan Excel sayfasından görüldüğü üzere serbestlik 

derecesi 2’ye göre hesaplanan olasılık değeri 0.0018’dir. Dolayısıyla 

nedenselliğin olmadığını ifade eden H0 hipotezi reddedilirken nedenselliğin 

olduğunu ifade eden HA hipotezi kabul edilir. Sonuç olarak %1 anlamlılık 

seviyesinde, Y değişkeninden X1 değişkenine doğru nedensellik ilişkisi 

vardır. 

➢ Yeşil renkle gösterilen X2 değişkeninin bir, iki ve üç dönem gecikmeli 

değerlerinden (C(17), C(18) ve C(19)) X1 değişkenine doğru nedensellik 

olup olmadığı Wald testleri yardımıyla sınanır. Bu test için şu adımlar takip 

edilebilir: “View ⇒ Coefficient Diagnostics ⇒ Wald Coefficient Test” 

seçenekleri sırasıyla seçilir. Açılan “Wald Test” ekranına X2’den X1’e doğru 

nedensellik olmadığını ifade eden H0 hipotezi için şu şekilde 

“C(17)=C(18)=C(19)=0” bir denklem yazılır ve “OK” seçeneği tıklanır. 

Şekil 7.23. Wald Testi: Birinci Adım (X2 ⇒ X1) 

 

➢ Aşağıda Şekil 7.24’te “Wald” testi sonuçları sunulmuştur. Buna göre, 

hesaplanan test değeri 8.895662 iken “3” serbestlik derecesine göre olasılık 

(Prob.) değeri 0.0307’dir.  
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Şekil 7.24. Wald Testi Sonucu (X2 ⇒ X1) 

 

➢ Ancak hatırlanacağı üzere en uygun gecikme uzunluğunu ifade eden “k” 

değeri 2 olarak belirlenmişti. Dolayısıyla olasılık (Prob.) değerinin “2” 

serbestlik derecesine göre hesaplanması gerekir. Bu hesaplama için boş bir 

Excel sayfası açılarak herhangi bir hücreye tıklanır. Ardından 

“=KİKAREDAĞ(8.895662;2)” yazılarak klavyeden “enter” tuşuna basılır. 

Şekil 7.25. Wald Testi: Serbestlik Derecesi 2’ye Göre Olasılık Değeri 

Hesaplama (X2 ⇒ X1) 
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➢ Yukarıda Şekil 7.24’te sunulan Excel sayfasından görüldüğü üzere “2” 

serbestlik derecesine göre hesaplanan olasılık değeri 0.0117’dir. Dolayısıyla 

nedenselliğin olmadığını ifade eden H0 hipotezi reddedilirken nedenselliğin 

olduğunu ifade eden HA hipotezi kabul edilir. Sonuç olarak %5 anlamlılık 

seviyesinde, X2 değişkeninden X1 değişkenine doğru nedensellik ilişkisi 

vardır. 

➢  “Seemingly Unrelated Regression” tahmin yöntemine göre X2’nin bağımlı 

değişken olduğu denklem aşağıda yer almaktadır. 

Equation: Equation: X2 = C(21)*Y(-1) + C(22)*Y(-2) + C(23)*Y(-3) + C(24)*X1(-1) +        

C(25)*X1(-2) + C(26)*X1(-3) + C(27)*X2(-1) + C(28)*X2(-2) + C(29)*X2( -3) + 

C(30) 

➢ Sarı renkle gösterilen Y değişkeninin bir, iki ve üç dönem gecikmeli 

değerlerinden (C(21), C(22) ve C(23)) X2 değişkenine doğru nedensellik 

olup olmadığı Wald testleri yardımıyla sınanır. Bu test için şu adımlar takip 

edilebilir:  

➢ “View ⇒ Coefficient Diagnostics ⇒ Wald Coefficient Test” seçenekleri 

sırasıyla seçilir. Açılan “Wald Test” ekranına Y’den X2’ye doğru 

nedensellik olmadığını ifade eden H0 hipotezi için şu şekilde 

(C(21)=C(22)=C(23)=0) bir denklem yazılır ve “OK” seçeneği tıklanır. 

Şekil 7.26. Wald Testi: Birinci Adım (Y ⇒ X2) 
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➢ Aşağıda Şekil 7.26’da “Wald” testi sonuçları sunulmuştur. “Wald” testi 

sonucuna göre hesaplanan test değeri 10.17142 iken “3” serbestlik 

derecesine göre olasılık (Prob.) değeri 0.0172’dir. 

Şekil 7.27. Wald Testi Sonucu (Y ⇒ X2) 

 

➢ Ancak hatırlanacağı üzere en uygun gecikme uzunluğunu ifade eden “k” 

değeri 2 olarak belirlenmişti. Dolayısıyla olasılık (Prob.) değerinin “2” 

serbestlik derecesine göre hesaplanması gerekir. Bu hesaplama için boş bir 

Excel sayfası açılarak herhangi bir hücreye tıklanır. Ardından 

“=KİKAREDAĞ(10.17142;2)” yazılarak “enter” tuşuna basılır. 

Şekil 7.28. Wald Testi: Serbestlik Derecesi 2’ye Göre Olasılık Değeri 

Hesaplama (Y ⇒ X2) 
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➢ Yukarda Şekil 7.27’de sunulan Excel sayfasından görüldüğü üzere “2” 

serbestlik derecesine göre hesaplanan olasılık değeri 0.0062’dir. Dolayısıyla 

nedenselliğin olmadığını ifade eden H0 hipotezi reddedilirken nedenselliğin 

olduğunu ifade eden HA hipotezi kabul edilir. Sonuç olarak %1 anlamlılık 

seviyesinde, Y değişkeninden X2 değişkenine doğru nedensellik ilişkisi 

vardır. Dikkat edilirse “3” serbestlik derecesine göre anlamlılık seviyesi %5 

iken “2” serbestlik derecesine göre %1 olmuştur. 

➢ Yeşil renkle gösterilen X1 değişkeninin bir, iki ve üç dönem gecikmeli 

değerlerinden (C(24), C(25) ve C(26)) X2 değişkenine doğru nedensellik 

olup olmadığı “Wald” testleri yardımıyla sınanır. Bu test için şu adımlar 

takip edilebilir:  

➢ “View ⇒ Coefficient Diagnostics ⇒ Wald Coefficient Test” seçenekleri 

sırasıyla seçilir. Açılan “Wald Test” ekranına X1’den X2’ye doğru 

nedensellik olmadığını ifade eden H0 hipotezi için şu şekilde 

(C(24)=C(25)=C(26)=0) bir denklem yazılır ve “OK” seçeneği tıklanır. 

Şekil 7.29. Wald Testi: Birinci Adım (X1 ⇒ X2) 

 

➢ Aşağıda Şekil 7.29’da “Wald” testi sonuçları sunulmuştur. Buna göre, 

hesaplanan test değeri 4.393887 iken “3” serbestlik derecesine göre olasılık 

(Prob.) değeri 0.2220’dir.  
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Şekil 7.30. Wald Testi Sonucu (X1 ⇒ X2) 

 

➢ Ancak hatırlanacağı üzere en uygun gecikme uzunluğunu ifade eden “k” 

değeri 2 olarak belirlenmişti. Dolayısıyla olasılık (Prob.) değerinin “2” 

serbestlik derecesine göre hesaplanması gerekir. Bu hesaplama için boş bir 

Excel sayfası açılarak herhangi bir hücreye tıklanır. Ardından 

“=KİKAREDAĞ(4.393887;2)” yazılarak  “enter” tuşuna basılır. 

Şekil 7.31. Wald Testi: Serbestlik Derecesi 2’ye Göre Olasılık Değeri 

Hesaplama (X1 ⇒ X2) 

 



120 

 

➢ Yukarda Şekil 7.30’da sunulan Excel sayfasından görüldüğü üzere “2” 

serbestlik derecesine göre hesaplanan olasılık değeri 0.1111’dir. Dolayısıyla 

nedenselliğin olmadığını ifade eden H0 hipotezi kabul edilerek nedenselliğin 

olduğunu ifade eden HA hipotezi reddedilir. Sonuç olarak X1 değişkeninden 

X2 değişkenine doğru nedensellik ilişkisi yoktur. 
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8. BÖLÜM 

ARDL ÖRNEK UYGULAMA ADIMLARI 

Kitabın bu bölümünde örnek bir ARDL modeli üzerinden, kitap 

içerisinde detaylı bir şekilde ele alınan uygulama adımlarının özeti sunulmuştur. 

1.Adım: Verilerin Transferi 

Verilerin Eviews programına aktarılmasında çok farklı yöntemler 

olmakla birlikte bu uygulama örneğinde veriler Excel’den transfer edilecektir. 

Öncelikle veriler aşağıda Şekil 8.1’de sunulan formatta Excel dosyası içerisinde 

hazırlanarak kaydedilir.  

Şekil 8.1. Verilerin Excel Paket Programında Hazırlanması 
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➢ Kaydedilen Excel dosyasına sağ tıklanarak “Birlikte aç” sekmesinden 

Eviews programı seçilir. 

➢ Ardından üç kez “sonraki” butonu, devamında ise “Finish” ve “No” 

seçenekleri tıklanır. 

➢ Böylece veriler Eviews programına aktarılmış olur. 

2.Adım: Tanımlayıcı/Betimleyici/Özet İstatistikler 

Verilerin tamamı yüzdesel olduğu için logaritmaları alınmamış olup 

yıllık olmasından dolayı mevsimsel arındırma işlemleri uygulanmamıştır. 

Zaman serisi analizlerinden sağlıklı sonuçlar elde edebilmek için olması gereken 

asgari gözlem sayısı 30’dur. Veri seti 1982-2021 dönemini kapsamakta olup 

toplamda 40 gözlem değeriyle zaman serisi için asgari olması gereken gözlem 

değerini karşılamaktadır. Bu kontrollerin ardından tanımlayıcı / betimleyici / 

özet istatistiklerin elde edilmesi aşamasına geçilmiştir.  

➢ Eviews paket programında “Ctrl” tuşu basılı iken mouse’un sol tuşu 

kullanılarak ilk olarak bağımlı değişken daha sonra bağımsız değişkenler 

seçilir. 

➢ İmleç seçili verilerin üzerindeyken sağ tıklanır. Açılan ekranda “Open ⇒ 

As Group” sekmeleri sırasıyla seçilir.  

➢ Seçilen tüm değişkenlere ilişkin gözlem değerleri aynı ekranda açılır. Bu 

açılan ekran üzerinden “View ⇒ Descriptive Stats ⇒ Comman Sample” 

tıklanır. 

➢ Böylece aşağıda Şekil 8.2’de sunulan tanımlayıcı/betimleyici/özet istatistik 

sonuçları elde edilmiş olur.  

Şekil 8.2. Tanımlayıcı/Betimleyici/Özet İstatistikler 
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➢ Oluşturulan bu tablo kopyalanarak Word programı üzerinde düzenlenebilir.  

➢ Bu işlemde tablonun tamamı taranıp Mouse’un sağ tuşuna tıklanarak 

“Copy” sekmesi aracılığıyla tablo kolaylıkla kopyalanabilir.  

➢ Örnek tablo gösterimi aşağıda Tablo 8.1’de sunulmuştur. Tablonun yorumu 

için kitabın 2. bölümü incelenebilir. 

Tablo 8.1. Tanımlayıcı/Betimleyici/Özet İstatistik Tablosu 

 Y X1 X2 

 Mean  4.753594  21.31477  23.70264 

 Median  5.403357  21.88290  23.84148 

 Maximum  11.20011  35.39563  35.81710 

 Minimum -5.750007  11.86405  15.01687 

 Std. Dev.  4.259981  5.594097  5.329402 

 Skewness -0.855674  0.252549  0.183340 

 Kurtosis  3.178812  2.824562  2.060329 

 Jarque-Bera  4.934479  0.476504  1.695726 

 Probability  0.084819  0.788004  0.428329 

 Sum  190.1437  852.5908  948.1056 

 Sum Sq. Dev.  707.7500  1220.463  1107.698 

 Observations  40  40  40 

3.Adım: Korelasyon matrisi 

➢ En son tanımlayıcı istatistik sonuçlarını aldığımız ekrandan “View ⇒ 

Covariance Analysis” sekmesi tıklanarak açılan pencere üzerinden 

“Correlation” seçeneği işaretlenir.  

➢ “Layout” kısmından nasıl bir raporlama yöntemi isteniyorsa o yöntem 

seçilir.  

➢ Bu çalışmada “Single table” seçeneği tercih edilmiştir.  

➢ Son olarak “OK” seçeneği tıklanır. 

➢ Böylece aşağıda Şekil 8.3’te sunulan korelasyon matrisi sonuçları elde 

edilmiş olur.  

Şekil 8.3. Korelasyon Matrisi 
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➢ Korelasyon matrisi sonuçları kopyalanarak Word programı üzerinde 

düzenlenebilir.  

➢ Örnek tablo gösterimi aşağıda Tablo 8.2’de sunulmuştur. Bağımsız 

değişkenler arasındaki korelasyon katsayısı 0.74’tür. Buna göre, bağımsız 

değişkenler arasında çoklu doğrusal bağlantı (multicollinearity) sorunu 

yoktur. Çünkü korelasyon katsayısı 0.80’in altındadır (Balkı, 2023). 

Tablonun yorumu için kitabın 3. bölümü incelenebilir. 

Tablo 8.2. Korelasyon Matrisi Tablosu 

Correlation Y X1 X2 

Y  1.000000   

X1  -0.050275 1.000000  

X2  0.235026 0.738822 1.000000 

Korelasyon analizi kapsamında yukarıda Tablo 8.2’de sunulan sonuçlar 

saçılım grafiği yoluyla görselleştirilebilir.  

➢ Bu grafiği elde etmek için “View ⇒ Graph” sekmesi tıklanır.  

➢ “Graph Option” penceresi üzerinden “Scatter” ve “Scatterplot matrix” 

seçilir ve son olarak “OK” seçeneği tıklanır.  

➢ Böylece korelasyon matrisi sonuçlarının görselleştirilmiş halini ifade eden 

ve aşağıda Şekil 8.4’te sunulan saçılım grafikleri elde edilmiş olur. 

Şekil 8.4. Saçılım Grafiği 
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4.Adım: Zaman Yolu Grafiklerin Oluşturulması 

Değişkenlerin her birinin grafiğini elde etmek için en son tanımlayıcı istatistik 

sonuçlarının alındığı ekran üzerinden; 

➢ “View ⇒ Graph” sekmeleri seçilir. “Details” kısmında yer alan “Multiple 

series” kısmından “Multiple graphs” seçilerek “OK” seçeneği tıklanır.  

➢ Böylece değişkenlere ilişkin aşağıda Şekil 8.5’te sunulan grafikler elde 

edilmiş olur.  

➢ Elde edilen grafikler seçilip Mouse’a sağ tıklayıp “Copy to clipboard” 

seçeneği aracılığıyla Word dosyasına yapıştırılabilir. 

Şekil 8.5. Değişkenlere İlişkin Zaman Yolu Grafikleri 

 

5.Adım: Birim Kök Testleri 

➢ Eviews paket programında ana ekranın üst tarafında yer alan “Add-ins” 

kısmına, ardından “All Unit Root Tests” sekmesine tıklanır (Bu eklentinin 

detayları için kitabın 4. bölümü incelenebilir).  

➢ Gelen ekrana değişkenlerin isimleri, aralarına birer boşluk olmak üzere 

klavye yardımıyla yazılır (Örnek: Y X1 X2). 

➢ Ardından “ADF and PP” seçilerek “OK” tuşuna tıklanır.  

Şekil 8.6. ADF ve PP Birim Kök Test Sonuçları Ekran Görüntüsü 
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➢ Böylece yukarıda Şekil 8.6’da sunulan “ADF” ve “PP” birim kök test 

sonuçları elde edilir. 

➢ Oluşturulan bu tablo kopyalanarak Word programı aracılığıyla 

düzenlenebilir.  

➢ Örnek tablo gösterimi aşağıda Tablo 8.3’te sunulmuştur. Tablonun yorumu 

için kitabın 3. bölümü incelenebilir. 

Tablo 8.3. ADF ve PP Birim Kök Test Sonuçları 

 At Level PP 

  Y X1 X2 

With Constant t-Statistic -0.7683 -0.6291 -6.8655*** 

 Prob.  0.8169  0.8524  0.0000 

With Constant & Trend  t-Statistic -3.0607 -3.4118* -6.7554*** 

 Prob.  0.1297  0.0644  0.0000 

Without Constant & Trend  t-Statistic  3.5171  2.2981 -3.2958*** 

 Prob.  0.9998  0.9939  0.0016 

 At First Difference          PP 

  d(Y) d(X1) d(X2) 

With Constant t-Statistic -8.3522*** -7.7412*** -19.1840*** 

 Prob.  0.0000  0.0000  0.0001 

With Constant & Trend  t-Statistic -9.1023*** -7.6608*** -19.0961*** 

 Prob.  0.0000  0.0000  0.0000 

Without Constant & Trend  t-Statistic -6.2995*** -6.7121*** -19.5463*** 

 Prob.  0.0000  0.0000  0.0000 

 At Level ADF 

  Y X1 X2 

With Constant t-Statistic -1.2519 -1.0781 -6.5092*** 

 Prob.  0.6419  0.7148  0.0000 

With Constant & Trend  t-Statistic -4.2828*** -3.3644* -6.4185*** 

 Prob.  0.0085  0.0711  0.0000*** 

Without Constant & Trend  t-Statistic  0.9292  1.0247 -1.9132* 

 Prob.  0.9028  0.9168  0.0541 

 At First Difference        ADF 

  d(Y) d(X1) d(X2) 

With Constant t-Statistic -6.1823*** -6.6097*** -10.1418*** 

 Prob.  0.0000  0.0000  0.0000 

With Constant & Trend  t-Statistic -6.1485*** -6.6124*** -9.9963*** 

 Prob.  0.0001  0.0000  0.0000 

Without Constant & Trend  t-Statistic -5.9632*** -6.6113*** -10.2800*** 

 Prob.  0.0000  0.0000  0.0000 

KARAR  I(1) I(1) I(0) 

➢ Bağımlı değişken olan Y: I(1)  

➢ Bağımsız değişkenlerden X1: I(1) iken X2: I(0)’dır.  
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➢ Dolaysıyla bağımlı değişkenin I(1) olmasının yanında değişkenler arasında 

I(2) olan herhangi bir değişken olmaması ve değişkenlerin farklı seviyelerde 

durağan olması ARDL yönteminin uygulanmasına imkân verir. 

6.Adım: ARDL Sınır Testlerinin Uygulanması 

➢ Eviews programında önce bağımlı değişken olmak üzere daha sonra 

modelde yer alan bağımsız değişkenlerin tamamı seçilir.  

➢ İmleç seçili verilerin üzerindeyken sağ tıklanır. Açılan ekranda “Open ⇒ As 

Equation” sekmeleri sırasıyla seçilir.  

➢ Bu açılan ekranın “Method” kısmından “ARDL-Auto-regressive Distributed 

Lag Models” seçeneği seçilir.  

➢ Metot seçiminin ardından veriler yıllık olduğu için “max lags”lar iki (2) 

seçilmiştir. 

➢ Trend spesifikasyon kısmında “Case 3” yani sabitli model olan “3.Constant” 

tercih edilmiştir. Devamında “Tamam” seçeneği tıklanarak spesifikasyon 

belirleme işlemleri tamamlanmış olur. 

➢ Ardından açılan ekran üzerinden “View ⇒ Coefficient Diagnostics ⇒ Long 

Run Form and Bounds Test” sekmeleri sırasıyla tıklanır. 

➢ Açılan ekranın alt kısmında F-Bounds ve t-Bounds Test değerleri aşağıda 

Şekil 8.7’deki gibi hesaplanmış halde gelir. 

Şekil 8.7. F-Bounds Test ve t-Bounds Test Sonuçları 

 



128 

 

➢ Eviews üzerinden hesaplanan bu sonuçların raporlanmasında 

kullanılabilecek örnek tablo aşağıda Tablo 8.4’te sunulmuştur.  

Tablo 8.4. ARDL Eşbütünleşme Testi Sonuçları 

ƒ (Y │X1, X2) 

ARDL (1, 0, 0) k:2 m:2 n=39 

Test İstatistiği Sonuç 

FOVERALL 16.85*** 
Eşbütünleşik 

tDV -5.92*** 

Tablo CV 1% 5% 10%  

Testler I(0) I(1) I(0) I(1) I(0) I(1)  

F OVERALL 5.893 7.337 4.133 5.26 3.373 4.377 n=40 

t DV -3.43 -4.1 -2.86 -3.53 -2.57 -3.21 - 

Not: Tahminler Case #III’e göre yapılmıştır. ***, %1 önem seviyesini; k, bağımsız 

değişken sayısını; m, maksimum gecikme uzunluğunu; n ise gözlem sayısını gösterir.  

➢ F-Bounds Test / FOVERALL ve t-Bounds Test / tDV sınır test sonuçları için 

oluşturulan model %1 anlamlılık seviyesinde simetrik/doğrusal olarak 

eşbütünleşiktir. Çünkü test istatistik değerleri I(1) için belirlenen üst sınır 

değerlerden mutlak değer olarak büyüktür. Dolayısıyla değişkenlerin 

doğrusal birleşimlerinin denge noktasına yakınsadığı (Göksu, 2022), yani 

uzun dönemde birlikte hareket ettikleri sonucuna ulaşılır. Tablonun detaylı 

yorumu için kitabın 5. bölümü incelenebilir. 

7.Adım: ARDL Uzun ve Kısa Dönem Katsayılar 

Uzun dönem katsayılar F-Bounds ve t-Bounds Test sonuçlarının olduğu 

ekranda “Levels Equation / Case 3: Unrestricted Constant and No Trend” başlığı 

altında aşağıda Şekil 8.8’deki gibi yer alır. 

Şekil 8.8. ARDL Uzun Dönem Tahmin Sonuçları Ekran Görüntüsü 

 

➢ Kısa dönem sonuçlarını elde etmek için ise F-Bounds ve t-Bounds Test 

sonuçlarının olduğu “Long Run Form and Bounds Test” ekranından,  
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➢ “View ⇒ Coefficient Diagnostics ⇒ Error Correction Form” sekmeleri 

tıklanarak 

➢ Aşağıda Şekil 8.9’da gösterilen kısa dönem sonuçlarının olduğu “ECM 

Regression / Case 3: Unrestricted Constant and No Trend” başlıklı tabloya 

ulaşılır. 

Şekil 8.9. ARDL Kısa Dönem Tahmin Sonuçları Ekran Görüntüsü 

 

➢ Kısa ve uzun dönem katsayıların raporlanmasında kullanılabilecek örnek 

tablo aşağıda Tablo 8.5’te sunulmuştur.  

Tablo 8.5. ARDL Kısa ve Uzun Dönem Tahmin Sonuçları 

a) Uzun dönem (Bağımlı değişken: Y) Katsayılar t-istatistik Olasılık 

X1 0.892595*** 11.03968 0.0000 

X2 0.470770*** 3.954781 0.0004 

b) Kısa dönem  Katsayılar t-istatistik Olasılık 

C 1.834233 5.483188 0.0000 

ECT t-1 -0.685387 -7.309762 0.0000 

➢ Yukarıda Tablo 8.5’te sunulan uzun dönem katsayı sonuçlarına göre X1 ve 

X2 değişkenlerinin katsayıları pozitiftir. X1 değişkeninde meydana gelecek 

%1’lik bir artış Y değişkenini yaklaşık %0.89 oranında arttırır. Bu 

değişkenler arasında doğrusal bir ilişki olduğu için bu değerlendirmenin tam 

tersi de doğrudur. Yani, X1 değişkeni %1 azalırsa Y değişkeni de yaklaşık 

%0.89 oranında azalır. Bu sonuç %1 önem seviyesinde istatistiki olarak 

anlamlıdır.  
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➢ Benzer değerlendirme X2 değişkeni için de yapılabilir. X2 değişkenin de 

meydana gelecek %1’lik bir artış Y değişkenini yaklaşık %0.47 oranında 

arttırır. X2 değişkeni %1 azalırsa Y değişkenini yaklaşık %0.47 oranında 

azalır. Bu sonuç %1 önem seviyesinde anlamlıdır.  

➢ Kısa dönem tahmin sonuçları incelendiğinde hata düzeltme terimi katsayısı 

-0.68 olup olasılık değeri 0.0000’dır. Olasılık değerinin 0.05’ten küçük 

olması bu katsayının anlamlı olduğunu gösterirken negatif (-) olması 

modelde ortaya çıkacak bir dengesizliğin düzeleceği anlamına gelir (Özçelik 

ve Göksu, 2019). Ayrıca sabit terimi ifade eden “C” katsayısı pozitif ve 

istatistiki olarak da anlamlıdır. 

➢ Kamu yatırım harcamalarıyla transfer harcamalarının ekonomik büyüme 

üzerine etkilerini inceleyen bir çalışma yapıldığını farz edelim. 

➢ Bu durumda oluşturulacak modelde bağımlı değişken olarak yer alan Y 

değişkeni ekonomik büyümeyi, bağımsız değişken olarak yer alan X1 

değişkeni kamu yatırım harcamalarının toplam kamu harcamaları içindeki 

payını, X2 değişkeni ise transfer harcamalarının toplam kamu harcamaları 

içindeki payını temsil etsin. Oluşturulan model doğrultusunda uzun dönem 

katsayılarının yorumlanması şu şekilde yapılabilir: 

➢ Uzun dönemde her iki değişkenin katsayılarının pozitif olması, kamu yatırım 

harcamaları ve transfer harcamalarının ekonomik büyüme üzerinde olumlu 

etkileri olduğunu gösterir. Ancak kamu yatırım harcamalarının ekonomik 

büyüme üzerindeki olumlu etkisi, transfer harcamalarının olumlu etkisinden 

yaklaşık iki kat daha fazladır. 

➢ Kamu yatırım harcamalarında meydana gelecek %1’lik bir artış ekonomik 

büyümeyi yaklaşık %0.89 oranında arttıracakken transfer harcamalarında 

meydana gelecek %1’lik bir artış ekonomik büyümeyi yaklaşık %0.47 

oranında artıracaktır.  

➢ Bu değişkenler arasındaki ilişkiler doğrusal olduğu için bu değerlendirmenin 

tam tersi de doğrudur. Yani kamu yatırım harcamalarında meydana gelecek 

%1’lik bir azalış, ekonomik büyümeyi yaklaşık %0.89 oranında 

azaltacakken transfer harcamalarında meydana gelecek %1’lik bir azalış, 

ekonomik büyümeyi yaklaşık %0.47 oranında azaltacaktır.  

➢ Ayrıca bu sonuçlar da %1 önem seviyesinde anlamlıdır.  

8.Adım: ARDL Diagnostik/Tanısal Testlerin Uygulanması 

Tahmin edilen model sonucunda elde edilen bulguların sağlamlılığının 

kontrolü diagnostik ya da tanısal testlerle sağlanır. Çalışma kapsamında 

uygulanacak olan tanısal testlerin Eviews adımları şu şekildedir: 
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Normallik:  

➢ Normal dağılım sınaması için uygulanacak olan “Jarque-Bera” testinin 

Eviews adımları şöyledir: 

➢ Kısa veya uzun dönem katsayılarının tahmin edildiği ekrandan “View ⇒ 

Residual Diagnostics ⇒ Histogram - Normality Test” seçenekleri sırasıyla 

seçilir. 

➢ Bu seçimlerin ardından “Jarque-Bera” test ve olasılık değerleri Şekil 

8.10’daki gibi elde edilir.  

Şekil 8.10. Jarque-Bera Test Sonucu 

 

Otokorelasyon: 

➢ Otokorelasyon sınaması için uygulanacak olan “Breusch-Godfrey Serial 

Correlation LM” testi Eviews adımları şu şekildedir:  

➢ En son “Jarque-Bera” test sonuçlarının elde edildiği ekrandan “View ⇒ 

Residual Diagnostics ⇒ Serial Correlation LM Test” seçenekleri sırasıyla 

seçilir.  

➢ Ardından “lag specification” ekranında gecikme uzunluğu otomatik olarak 

2 gelmiştir. Son olarak “OK” sekmesine tıklanır. 

➢ Bu seçimlerin ardından “Breusch-Godfrey Serial Correlation LM test” ve 

olasılık değerleri aşağıda Şekil 8.11’deki gibi elde edilir.  
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Şekil 8.11. Breusch-Godfrey Serial Correlation LM Test Sonucu 

 

Değişen Varyans (Farklı Yayılım, Heteroskedasticity):  

➢ Değişen varyans sınaması için uygulanacak olan ilk test “Breusch-Pagan-

Godfrey” testinin Eviews adımları şu şekildedir:  

➢ En son “Breusch-Godfrey Serial Correlation LM” testi katsayılarının tahmin 

edildiği ekrandan “View ⇒ Residual Diagnostics ⇒ Heteroskedasticity” 

seçenekleri sırasıyla belirlenir.  

➢ Ardından gelen ekranda “Breusch-Pagan-Godfrey” testi seçilerek “OK” 

sekmesine tıklanır. 

➢ Bu seçimlerin ardından “Breusch-Pagan-Godfrey test” ve olasılık değerleri 

Şekil 8.12’deki gibi elde edilir. 

Şekil 8.12. Breusch-Pagan-Godfrey Test Sonucu 

 

➢ Değişen varyans sınaması için uygulanacak ikinci test olan “ARCH” testinin 

Eviews adımları şu şekildedir:  

➢ Kısa veya uzun dönem katsayılarının tahmin edildiği ekrandan “View ⇒ 

Residual Diagnostics ⇒ Heteroskedasticity” seçenekleri sırasıyla tıklanır.  

➢ Ardından gelen ekranda “ARCH” testi seçilerek “OK” sekmesine tıklanır. 

➢ Bu seçimlerin ardından “ARCH” test ve olasılık değerleri Şekil 8.13’teki 

gibi elde edilir.  
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Şekil 8.13. ARCH Değişen Varyans Test Sonucu 

 

Fonksiyonel Form (Biçim):  

➢ Tahmin edilen modelde herhangi bir spesifikasyon hatasının olup 

olmadığının tespiti için “Ramsey-RESET” testi uygulanmıştır. Bu testinin 

Eviews adımları şu şekildedir:  

➢ Kısa veya uzun dönem katsayılarının tahmin edildiği ekrandan “View ⇒ 

Stability Diagnostics ⇒ Ramsey RESET Test” seçenekleri sırasıyla seçilir. 

Son olarak “OK” sekmesine tıklanır. 

➢ Bu seçimlerin ardından “Ramsey RESET” testi ve olasılık değerleri Şekil 

8.14’teki gibi elde edilir. 

Şekil 8.14. Ramsey RESET Testi Sonucu 

 

CUSUM ve CUSUM2:  

➢ Tahmin edilen katsayıların kararlılığını ya da istikrarını sınamak amacıyla 

CUSUM ve CUSUM2 grafikleri oluşturulmuştur. Bu grafikleri elde etmek 

için uygulanması gereken Eviews adımları şu şekildedir:  
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➢ Kısa veya uzun dönem katsayılarının tahmin edildiği ekrandan “View ⇒ 

Stability Diagnostics ⇒ Recursive Estimates ⇒ önce CUSUM Test daha 

sonra CUSUM of Squares Test” seçenekleri sırasıyla seçilir.  

➢ Ardından her bir seçim için “OK” sekmesine tıklanır. 

➢ Böylece aşağıda Şekil 8.15’te yer alan CUSUM ve CUSUM2 grafikleri elde 

edilir.  

Şekil 8.15. CUSUM ve CUSUM2 grafikleri 

 

➢ Eviews üzerinden hesaplanan tüm bu “diagnostics” ya da tanısal test 

sonuçlarının raporlanmasında kullanılabilecek örnek tablo aşağıda Tablo 

8.6’da sunulmuştur.  

Tablo 8.6. ARDL Tanısal Test Sonuçları 

Tanısal testler 
Test 

değeri 
 Olasılık 

Breusch-Godfrey Serial Corr. LM test χ 2
SC 1.101087  0.5766 

Breusch-Pagan-Godfrey Heteroskedasticity test χ2
HET(BPG) 5.662025  0.1293 

ARCH Heteroskedasticity test χ2 
HET(ARCH) 0.019548  0.8888 

Jarque-Bera Normality test χ2
NORM 2.638374  0.2673 

Ramsey RESET test χ2
FF 0.311725  0.5766 

CUSUM = İstiktarlı CUSUM2 = İstiktarlı 

➢ Yukarıda Tablo 8.6’da sunulan “diagnostics” ya da tanısal test sonuçlarına 

göre; 

➢ “Breusch-Godfrey Serial Correlation LM test” değeri 1.101087 olup olasılık 

değeri 0.5766’dır. Olasılık değeri 0.10’dan büyük olduğu için modelde 

otokorelasyon sorunu yoktur. 

➢ Değişen varyans sınamasında ilk uygulanan “Breusch-Pagan-Godfrey” 

testinin katsayı değeri 5.662025 olup olasılık değeri 0.1293’tür. Olasılık 

değeri 0.10’dan büyük olduğu için modelde değişen varyans sorunu yoktur. 
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➢ Değişen varyans sınamasında ikinci uygulanan “ARCH” testinin katsayı 

değeri 0.019548 olup olasılık değeri 0.8888’dir. Olasılık değeri 0.10’dan 

büyük olduğu için modelde değişen varyans sorunu yoktur.  

➢ “Jarque-Bera” test değeri 2.638374 olup olasılık değeri de 0.2673’tür.  

“Jarque-Bera” testinin olasılık değeri 0.10’dan büyük olduğu için modelin 

normal dağılıma uygun olduğu söylenebilir. 

➢ “Ramsey RESET” testinin katsayı değeri 0.311725 olup olasılık değeri 

0.5766’dır. Olasılık değeri 0.10’dan büyük olduğu için model kurma hatası 

sorunu yoktur. 

➢ CUSUM ve CUSUM2 grafikleri %95 güven aralığında, istenilen sınırlar 

içerisinde olduğu için kurulan model istikrarlıdır. 
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9. BÖLÜM 

NARDL ÖRNEK UYGULAMA ADIMLARI 

Kitabın bu bölümünde örnek bir NARDL modeli üzerinden, kitap 

içerisinde detaylı bir şekilde ele alınan uygulama adımlarının özeti sunulmuştur. 

NARDL analiz yönteminin uygulanmasında literatürde genellikle tercih edilen 

uygulama, ARDL analiz sürecinin işletilmesi ve raporlanmasının ardından 

NARDL prosedürünün işletilmesidir. ARDL prosedürü örnek uygulaması 8. 

bölümde detaylı bir şekilde işlendiği için bu bölümde tekrar edilmeyecektir. 

Dolayısıyla bu bölümde sadece NARDL analiz yöntemi örnek bir uygulama 

üzerinden ele alınacaktır.  

➢ Analizde kullanılan verilerin tamamı için logaritmik dönüşüm işlemleri 

yapılmıştır. Ayrıca verilerin yıllık olmasından dolayı mevsimsel arındırma 

işlemleri uygulanmamıştır. Veri seti 1971-2018 dönemini kapsamakta olup 

toplamda 48 gözlem değeriyle zaman serisi için asgari olması gereken 

gözlem değerini karşılamaktadır. 

➢ Birim kök testi sonuçlarına göre bağımlı değişkenin I(1) olmasının yanında 

değişkenler arasında I(2) olan herhangi bir değişken olmaması ve 

değişkenlerin farklı seviyelerde durağan olması NARDL yönteminin 

uygulanmasına imkân verir. 

➢ NARDL yöntemiyle aslında saklı eşbütünleşme ilişkileri tespit edilmeye 

çalışıldığından özellikle ARDL yöntemine göre eşbütünleşme ilişkisinin 

olmadığı örnek bir model üzerinden analizler anlatılacaktır. 

➢ NARDL modelinin Eviews paket programında tahmin edilebilmesi için 

öncelikle ARDL modelinin tahmin edilmesi gerekir. ARDL modelinin 

tahmin edilmesinde bir önceki bölümde yapılan açıklamalar ve varsayımlar 

dikkate alınarak uygulanır.  

➢ Metot seçiminin ardından veriler yıllık olduğu için “max lags”lar iki (2) 

seçilmiştir. 

➢ Trend spesifikasyon kısmında Case 3, yani sabitli model “3.Constant” tercih 

edilmiştir. 

1.Adım: NARDL Sınır Testlerinin Uygulanması 

➢ ARDL modelinin tahmin edilmesinin ardından “View ⇒ Label” kısmı 

seçilir. 

➢ Bu seçiminin ardından aşağıda Şekil 9.1’de görünen pencere açılır. 

➢ Açılan pencerede ilk olarak dikdörtgen kutunun içerisine klavyeden 

“Asyvars” yazılır. “Asyvars” yazıldıktan sonra yan satıra geçilip tüm 

bağımsız değişkenler yazılır. Dolayısıyla oluşturulan modelde bağımsız 

değişken olarak yer alan “lnx1 lnx2 lnx3” aralarında birer boşluk bırakılarak 

yazılır.  
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Şekil 9.1. NARDL Sınır Testi: Birinci Adım 

 

➢ Ardından “Add-ins ⇒ Make Nonlinear ARDL” seçeneği tıklanır. 

➢ Böylece NARDL modeli tahmin edilmiş olur. 

➢ Açılan pencere üzerinden “View ⇒ Coefficient Diagnostics ⇒ Long Run 

Form and Bounds Test” sekmeleri sırasıyla tıklanır. 

➢ Açılan ekran aşağıya doğru kaydırıldığında “F-Bounds Test” ve “t-Bounds 

Test” değerleri aşağıda Şekil 9.2’deki gibi görülebilecektir. 

Şekil 9.2. F-Bounds Test ve t-Bounds Test Sonuçları 
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➢ Eviews üzerinden hesaplanan bu sonuçların raporlanmasında 

kullanılabilecek örnek tablo aşağıda Tablo 9.1’de sunulmuştur.  

Tablo 9.1. NARDL Eşbütünleşme Testi Sonuçları 

ƒ(𝑙𝑛𝑌 ∣ 𝑙𝑛𝑋1𝑡
+, 𝑙𝑛𝑋1𝑡

−, 𝑙𝑛𝑋2𝑡
+, 𝑙𝑛𝑋2𝑡

−, 

 𝑙𝑛𝑋3𝑡
+, 𝑙𝑛𝑋3𝑡

−) 

NARDL (2, 2, 1, 2, 2, 1, 1) 

F-critical 

values 

asymptotic 

n=1.000 

F-critical 

values 

finite 

n=35 

t-critical 

values 

 k m Statistic  I(0) I(1) I(0) I(1) I(0) I(1) 

 
6 

 

2 

 

F PSS  : 11,92*** 

t BDM :  -8,14*** 

10%   2,12 3,23 2.387 3.671 -2,57 -4,04 

5%   2,45 3,61 2.864 4.324 -2,86 -4,38 

1%   3,15 4,43 4.016 5.797 -3,43 -4,99 

Not: Tahminler Case #III’e göre yapılmıştır. ***, %1 önem seviyesini; k, bağımsız 

değişken sayısını; m, maksimum gecikme uzunluğunu; n ise gözlem sayısını gösterir. 

➢ “F-Bounds Test / F PSS” ve “t-Bounds Test / t BDM” sınır test sonuçlarına göre 

oluşturulan modelde %1 anlamlılık seviyesinde asimetrik ya da doğrusal 

olmayan eşbütünleşme ilişkisi vardır. Çünkü test istatistik değerleri I(1) için 

hesaplanan üst sınır değerlerinden mutlak değer olarak büyüktür. 

Dolayısıyla değişkenlerin doğrusal olmayan bileşimlerinin denge noktasına 

yakınsadığı, yani uzun dönemde asimetrik olarak hareket ettikleri sonucuna 

varılabilir. Tablonun detaylı yorumu için kitabın 5. bölümü incelenebilir. 

2.Adım: NARDL Uzun Dönemli Katsayıların Elde Edilmesi 

➢ NARDL uzun dönem katsayı değerleri F-Bounds ve t-Bounds Test 

sonuçlarının olduğu ekranda “Levels Equation/Case 3: Unrestricted 

Constant and No Trend” başlığı altında yer alır. Aşağıda Şekil 9.3’te her bir 

bağımsız değişkenin pozitif ve negatif işaretli katsayılarını ifade eden 

değerler yer almaktadır. 
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Şekil 9.3. NARDL Uzun Dönem Tahmin Sonuçları Ekranı 

 

➢ NARDL uzun dönem katsayıların raporlanmasında kullanılabilecek örnek 

tablo aşağıda Tablo 9.2’de sunulmuştur.  

Tablo 9.2. NARDL Uzun Dönem Tahmin Sonuçları 

Uzun dönem Katsayılar t-istatistik Olasılık 

LlnX1
+ 0.675854 8.935419 0.0000 

LlnX1 
- 4.690122 9.033241 0.0000 

LlnX2
+ -0.037450 -3.847205 0.0014 

LlnX2 
- 0.072817 0.694952 0.4971 

LlnX3
+ 0.437463 7.826146 0.0000 

LlnX3 
- -0.414024 -5.331197 0.0001 

Not: Değişkenlerin önündeki “L” simgesi uzun döneme (long-run) karşılık gelmektedir. 

“ln” simgesi ise logaritmaların alındığını göstermektedir. 

➢ Yukarıda Tablo 9.2’de gösterilen uzun dönem katsayı sonuçlarına göre 

LlnX1
+ değişkenin uzun dönem katsayısı pozitif olup katsayı değeri 

0.675854’tür. X1 değişkeninde meydana gelecek %1’lik bir artış Y 

değişkenini yaklaşık olarak %0.68 oranında artıracaktır. Bu sonuç %1 önem 

seviyesinde anlamlıdır. Çünkü LlnX1
+ değişkeninin olasılık değeri 0.0000 

olup 0.01’den küçüktür. 

➢ Öte yandan LlnX1
- değişkenin uzun dönem katsayısı da pozitif olup katsayı 

değeri 4.690122’dir. Bu sonuç şöyle yorumlanabilir: X1 değişkeni %1 

azalırsa Y değişkeni yaklaşık %4.69 oranında azalır. Bu sonuç %1 önem 

seviyesinde anlamlıdır. Çünkü LlnX1
- değişkeninin olasılık değeri 0.0000 

olup 0.01’den küçüktür. 

➢ LlnX2
+ değişkenin uzun dönem katsayısı negatif olup katsayı değeri -

0.037450’dır. X2 değişkeninde meydana gelecek %1’lik bir artış Y 
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değişkenini yaklaşık olarak %0.04 oranında azaltacaktır. Bu sonuç %1 önem 

seviyesinde anlamlıdır. Çünkü LlnX2
+ değişkeninin olasılık değeri 0.0014 

olup 0.01’den küçüktür. 

➢ Öte yandan LlnX2
- değişkenin uzun dönem katsayısı pozitif olup katsayı 

değeri 0.072817’dir. Bu sonuç şöyle yorumlanabilir: X2 değişkeni %1 

azalırsa Y değişkeni yaklaşık %0.07 oranında azalır. Bu sonuç istatistiki 

olarak anlamsızdır. Çünkü LlnX2
- değişkeninin olasılık değeri 0.4971 olup 

0.05’ten büyüktür. 

➢ LlnX3
+ değişkenin uzun dönem katsayısı pozitif olup katsayı değeri 

0.437463’tür. X3 değişkeninde meydana gelecek %1’lik bir artış Y 

değişkenini yaklaşık olarak %0.44 oranında artıracaktır. Bu sonuç %1 önem 

seviyesinde anlamlıdır. Çünkü LlnX3
+ değişkeninin olasılık değeri 0.0000 

olup 0.01’den küçüktür. 

➢ LlnX3
- değişkenin uzun dönem katsayısı ise negatif olup katsayı değeri -

0.414024’tür. Bu sonuç şöyle yorumlanabilir: X3 değişkeni %1 azalırsa Y 

değişkeni yaklaşık %0.41 oranında artar. Bu sonuç %1 önem seviyesinde 

anlamlıdır. Çünkü LlnX3
- değişkeninin olasılık değeri 0.0001 olup 0.01’den 

küçüktür. 

3.Adım: Uzun Dönemli Asimetrik İlişkilerin Test Edilmesi: Wald Testi 

Uygulaması 

Bu adımda asimetrik ilişkilerin varlığı öncelikle uzun dönemde daha 

sonra kısa dönemde sınanacaktır.  

➢ En son NARDL uzun dönem katsayı sonuçlarının alındığı ekranın en 

üstünde yer alan “Conditional Error Correction Regression” başlığı altında 

bulunan değişkenlerin sadece isimleri seçilip Mouse’un sağ tuşuna tıklanıp 

kopyalanır.  

➢ Daha sonra Eviews ana ekranının en üstünde bulunan “Quick ⇒ Estimate 

Equation” tıklanır.  

➢ Açılan ekranda “Method” kısmından “STEPLS” seçilir.  

➢ Kopyalanmış olan değişkenlerden başında “D” olanlar alt kısımda yer alan 

“List of search regressors” kısmına;  

➢ “D” olmayanlar üst kısımda “Dependent variable followed by list of always 

included regressors” kısmına aralarında bir boşluk olacak şekilde 

yapıştırılarak düzenlenir. Bu kısmın en başına (C değişkeninden önce) 

bağımlı değişken olan lnY eklenir.  

➢ Yapıştırma işleminin ardından bazı değişkenlerin sonunda yer alan * veya 

** işaretleri silinir.  

➢ “Option” kısmına tıklanır. “Selection Method” kısmından “Uni-directional” 

seçilir. Daha sonra “Backwars” işaretlenip “p-value” değeri 0.05 olarak 

değiştirilir ve “Tamam” sekmesi tıklanır. 
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➢ Ardından açık olan ekran üzerinden “View ⇒ Representations” sekmeleri 

tıklanır.  

➢ Böylece “Estimation Equation” denklemi elde edilir. Bundan sonra 

uygulanacak olan “Wald” testleri bu denklem üzerinden uygulanacaktır.  

Estimation Equation: 

========================= 

LNY = C(1) + C(2)*LNY(-1) + C(3)*LNX1_POS(-1) + C(4)*LNX1_NEG(-1) + 

C(5)*LNX2_POS(-1) + C(6)*LNX2_NEG(-1) + C(7)*LNX3_POS(-1) + 

C(8)*LNX3_NEG(-1) +  

C(9)*D(LNX1_NEG) + C(10)*D(LNX2_NEG) + C(11)*D(LNX2_POS) + 

C(12)*D(LNX3_POS) + C(13)*D(LNX2_POS(-1)) + C(14)*D(LNX1_POS(-1)) + 

C(15)*D(LNX2_NEG(-1)) + C(16)*D(LNY(-1)) + C(17)*D(LNX3_NEG) 

Uzun dönem “Wald” testi bu denklemin üst kısmında yer alan 

katsayılara (C(3),…,C(8) arasındaki katsayılar) uygulanacakken kısa dönem 

“Wald” testi bu denklemin alt kısmında yer alan katsayılara (C(9),…,C(17) 

arasındaki C(16) hariç katsayılar) uygulanacaktır. 

➢ Açık olan ekranda “View ⇒ Coefficient Diagnostic ⇒ Wald Test Coefficient 

Restrictions” seçenekleri sırasıyla seçilir. Böylece “Wald” testi için 

denklemlerin yazılacağı ekran açılır. 

➢ Gelen ekrana -C(3)/C(2) = -C(4)/C(2) yazılıp “OK” sekmesi tıklanır. 

Aslında “Wald testi” ile X1 katsayısındaki bir dönem gecikmeli azalışların 

bağımlı değişkenin bir dönem gecikmeli değerine oranıyla X1 katsayısındaki 

bir dönem gecikmeli artışların bağımlı değişkenin bir dönem gecikmeli 

değerine oranı birbirine eşit mi?” sorusuna cevap aranmaktadır. Bu 

denklemin yerine matematiksel olarak sadeleşmiş hali olan C(3)=C(4) 

denklemi de yazılabilir.  

➢ “Wald” testi sonuçlarına göre uzun dönemde H0 hipotezi %1 anlamlılık 

seviyesinde reddedilir. Çünkü test istatistik değeri 8.935078 olup olasılık 

değeri 0.01’den küçüktür. Bu sonuç X1 değişkenindeki artışlarla azalışlar 

arasında uzun dönemde asimetrik bir ilişki olduğunu kanıtlar. Dolayısıyla 

X1 değişkenindeki artışların Y değişkeni üzerindeki etkisiyle X1 

değişkenindeki azalışların Y değişkeni üzerindeki etkisinin uzun dönemde 

aynı olmadığı sonucuna ulaşılır. 

➢ Aynı işlemi X2 değişkenine uygulamak için en son açık olan ekran üzerinden 

“View ⇒ Coefficient Diagnostic ⇒ Wald Test Coefficient Restrictions” 

seçenekleri sırasıyla seçilir. Böylece “Wald” testi için denklemlerin 

yazılacağı ekran açılır. 

➢ Gelen ekrana -C(5)/C(2) = -C(6)/C(2) ya da C(5)=C(6)  yazılıp “OK” 

sekmesi tıklanır.  
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➢ “Wald” testi sonuçlarına göre uzun dönemde H0 hipotezi %5 anlamlılık 

seviyesinde kabul edilir. Çünkü test istatistik değeri 0.972696 olup olasılık 

değeri 0.3240’tır. Bu sonuç X2 değişkenindeki artışlarla azalışlar arasında 

uzun dönemde asimetrik bir ilişki olmadığını kanıtlar. Dolayısıyla X2 

değişkenindeki artış ve azalışların Y değişkeni üzerindeki etkisinin uzun 

dönemde aynı olduğu anlamına gelir. 

➢ Benzer işlemleri X3 değişkenine uygulamak için en son açık olan ekran 

üzerinden “View ⇒ Coefficient Diagnostic ⇒ Wald Test Coefficient 

Restrictions” seçenekleri sırasıyla seçilir. Böylece “Wald” testi için 

denklemlerin yazılacağı ekran açılır. 

➢ Gelen ekrana -C(7)/C(2) = -C(8)/C(2) ya da C(7)=C(8) yazılıp “OK” 

sekmesi tıklanır.  

➢ “Wald” testi sonuçlarına göre uzun dönemde H0 hipotezi %1 anlamlılık 

seviyesinde reddedilir. Çünkü test istatistik değeri 8.877737 olup olasılık 

değeri 0.01’den küçüktür. Bu sonuç X3 değişkenindeki artışlarla azalışlar 

arasında uzun dönemde asimetrik bir ilişki olduğunu kanıtlar. Dolayısıyla 

X3 değişkenindeki artışların Y değişkeni üzerindeki etkisiyle X3 

değişkenindeki azalışların Y değişkeni üzerindeki etkisi uzun dönemde aynı 

olmadığı anlamına gelir. 

4.Adım: Kısa Dönemli Asimetrik İlişkilerin Test Edilmesi: Wald Testi 

Uygulaması 

   Bir önceki adımda “Wald” testi sonuçları uzun dönem için sunulmuştu. 

Bu adımda ise kısa dönem “Wald” testi adımları anlatılacaktır. Testin uygulanma 

safahatı aynı olmakla birlikte kısa dönem için X1 değişkeninin “D” (diffrence’ın 

kısaltması) ile başlayan aşağıda yeşil renkle gösterilen katsayılarından pozitif 

olanlarla negatif olanlar eşitlenir. Dolayısıyla bu açıklamaların ışığında “Wald” 

testi veri giriş ekranına C(5)+C(7)=C(8) yazılır.  

Estimation Equation: 

========================= 

LNY = C(1) + C(2)*LNY(-1) + C(3)*LNX1_POS(-1) + C(4)*LNX1_NEG(-1) + 

C(5)*LNX2_POS(-1) + C(6)*LNX2_NEG(-1) + C(7)*LNX3_POS(-1) + 

C(8)*LNX3_NEG(-1) +  

C(9)*D(LNX1_NEG) + C(10)*D(LNX2_NEG) + C(11)*D(LNX2_POS) + 

C(12)*D(LNX3_POS) + C(13)*D(LNX2_POS(-1)) + C(14)*D(LNX1_POS(-1)) + 

C(15)*D(LNX2_NEG(-1)) + C(16)*D(LNY(-1)) + C(17)*D(LNX3_NEG) 

➢ “Wald” testinin kısa dönemde uygulanması için açık olan ekranda “View ⇒ 

Coefficient Diagnostic ⇒ Wald Test Coefficient Restrictions” seçenekleri 

sırasıyla seçilir.  
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➢ “Wald” testi için denklemlerin yazılacağı ekrana X1 değişkeninin kısa 

dönem pozitif ve negatif katsayılarına karşılık gelen C(9) ve C(14) birbirine 

eşitlenerek C(9)=C(14) yazılıp “OK” sekmesine tıklanır. Böylece X1 

değişkeni için kısa dönem “Wald” testi sonuçları elde edilmiş olur.  

➢ “Wald” testi sonuçlarına göre kısa dönemde H0 hipotezi %1 anlamlılık 

seviyesinde reddedilir. Çünkü test istatistik değeri 79.85866 olup olasılık 

değeri 0.01’den küçüktür. Bu sonuç X1 değişkenindeki artışlarla azalışlar 

arasında kısa dönemde asimetrik bir ilişki olduğunu kanıtlar. Dolayısıyla X1 

değişkenindeki artışların Y değişkeni üzerindeki etkisiyle X1 değişkenindeki 

azalışların Y değişkeni üzerindeki etkisi kısa dönemde aynı olmadığı 

anlamına gelir. 

➢ X2 değişkeni için de benzer adımlar uygulanır. X2 değişkeni için Wald testi 

sonuçlarının elde edildiği ekran üzerinden açık olan ekranda “View ⇒ 

Coefficient Diagnostic ⇒ Wald Test Coefficient Restrictions” seçenekleri 

sırasıyla seçilir.  

➢ “Wald” testi için denklemlerin yazılacağı ekrana X2 değişkeninin kısa 

dönem pozitif ve negatif katsayılarına karşılık gelen C(11) ile C(13)’ün 

toplamı, C(10) ile C(15)’in toplamına eşitlenerek 

“C(11)+C(13)=C(10)+C(15)” yazılıp “OK” sekmesine tıklanır. Böylece X2 

değişkeni için kısa dönem Wald testi sonuçları elde edilmiş olur. 

➢ “Wald” testi sonuçlarına göre kısa dönemde H0 hipotezi %1 anlamlılık 

seviyesinde reddedilir. Çünkü test istatistik değeri 78.49047 olup olasılık 

değeri 0.01’den küçüktür. Bu sonuç X2 değişkenindeki artışlarla azalışlar 

arasında kısa dönemde asimetrik bir ilişki olduğunu kanıtlar. Dolayısıyla X2 

değişkenindeki artışların Y değişkeni üzerindeki etkisiyle X2 değişkenindeki 

azalışların Y değişkeni üzerindeki etkisi kısa dönemde aynı olmadığı 

anlamına gelir. 

➢ Benzer adımlar X3 değişkeni için de uygulanır. X3 değişkeni için “Wald” 

testi sonuçlarının elde edildiği ekran üzerinden açık olan ekranda “View ⇒ 

Coefficient Diagnostic ⇒ Wald Test Coefficient Restrictions” seçenekleri 

sırasıyla seçilir.  

➢ “Wald” testi için denklemlerin yazılacağı ekrana X3 değişkeninin kısa 

dönem pozitif ve negatif katsayılarına karşılık gelen C(12) ile C(17) 

birbirine eşitlenerek C(12)=C(17) yazılıp “OK” sekmesine tıklanır. Böylece 

X3 değişkeni için kısa dönem “Wald” testi sonuçları elde edilmiş olur. 

➢ “Wald” testi sonuçlarına göre kısa dönemde H0 hipotezi %5 anlamlılık 

seviyesinde reddedilir. Çünkü test istatistik değeri 5.274803 olup olasılık 

değeri 0.05’ten küçüktür. Bu sonuç X3 değişkenindeki artışlarla azalışlar 

arasında kısa dönemde asimetrik bir ilişki olduğunu kanıtlar. Dolayısıyla X3 

değişkenindeki artışların Y değişkeni üzerindeki etkisiyle X3 değişkenindeki 

azalışların Y değişkeni üzerindeki etkisinin kısa dönemde aynı olmadığı 

anlamına gelir. 
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➢ NARDL kısa ve uzun dönem “Wald” testi sonuçlarının raporlanmasında 

kullanılabilecek örnek tablo aşağıda Tablo 9.3’te sunulmuştur.  

Tablo 9.3. NARDL Kısa ve Uzun Dönem Wald Testi Sonuçları 

Uzun Dönem Test istatistiği Olasılık Kısa Dönem Test istatistiği Olasılık 

WLR, lnX1 8.935078 0.0028 WSR, lnX1 79.85866 0.0000 

WLR, lnX2 0.972696 0.3240 WSR, lnX2 78.49047 0.0000 

WLR, lnX3 8.877737 0.0029 WSR, lnX3 5.274803 0.0216 

Not: Değişkenlerin önündeki “W” simgesi “Wald” testine karşılık gelmektedir. “LR” ve 

“SR” sırasıyla uzun ve kısa döneme karşılık gelmektedir. 

5.Adım: NARDL Diagnostik/Tanısal Testlerin Uygulanması 

NARDL tahminlerinden elde edilen bulguların sağlamlılığının kontrolü 

diagnostik ya da tanısal testlerle sağlanır. Bu adımda öncelikle testlerin 

uygulama adımları gösterilip daha sonra bu testlerin toplu olarak raporlanması 

ve yorumlanması yapılacaktır. Çalışma kapsamında uygulanacak olan tanısal 

testlerin Eviews adımları şu şekildedir: 

Normallik:  

➢ Normal dağılım sınaması için uygulanacak olan “Jarque-Bera” testinin 

Eviews adımları şöyledir: 

➢ Ana ekranda “NARDL” isimli tahmin dosyasına çift tıklanır. Açılan 

ekrandan “View ⇒ Residual Diagnostics ⇒ Histogram – Normality Test” 

seçenekleri seçilir. 

➢ Bu seçimlerin ardından “Jarque-Bera” test ve olasılık değerleri Şekil 9.4’teki 

gibi elde edilir.  

Şekil 9.4. Jarque-Bera Test Sonucu 
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Otokorelasyon:  

➢ Otokorelasyon sınaması için uygulanacak olan “Breusch-Godfrey Serial 

Correlation LM” testinin Eviews adımları şu şekildedir:  

➢ En son “Jarque-Bera” test sonuçlarının elde edildiği ekrandan “View ⇒ 

Residual Diagnostics ⇒ Serial Correlation LM Test” seçenekleri sırasıyla 

seçilir.  

➢ Ardından “lag specification” ekranında gecikme uzunluğu otomatik olarak 

2 gelmiştir. Seriler yıllık olduğu için bu gecikme uzunluğu uygundur. Son 

olarak “OK” sekmesine tıklanır. 

➢ Bu seçimlerin ardından “Breusch-Godfrey Serial Correlation LM test” ve 

olasılık değerleri aşağıda Şekil 9.5’teki gibi elde edilir.  

Şekil 9.5. Breusch-Godfrey Serial Correlation LM Test Sonucu 

 

Değişen Varyans (Farklı Yayılım, Heteroskedasticity):  

➢ Değişen varyans sınaması için uygulanacak ilk test olan “Breusch-Pagan-

Godfrey” testinin Eviews adımları şu şekildedir:  

➢ En son “Breusch-Godfrey Serial Correlation LM” katsayılarının tahmin 

edildiği ekrandan “View ⇒ Residual Diagnostics ⇒ Heteroskedasticity” 

seçenekleri sırasıyla belirlenir.  

➢ Ardından gelen ekranda “Breusch-Pagan-Godfrey” testi seçilerek “OK” 

sekmesine tıklanır. 

➢ Bu adımlardan sonra “Breusch-Pagan-Godfrey” test ve olasılık değerleri 

Şekil 9.6’daki gibi elde edilir. 

Şekil 9.6. Breusch-Pagan-Godfrey Test Sonucu 
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➢ Değişen varyans sınaması için uygulanacak ikinci test olan “ARCH” testinin 

Eviews adımları şu şekildedir:  

➢ Kısa veya uzun dönem katsayılarının tahmin edildiği ekrandan “View ⇒ 

Residual Diagnostics ⇒ Heteroskedasticity” seçenekleri sırasıyla tıklanır.  

➢ Ardından gelen ekranda “ARCH” testi seçilerek “OK” sekmesine tıklanır. 

➢ Bu seçimlerin ardından “ARCH” test ve olasılık değerleri Şekil 9.7’deki gibi 

elde edilir.  

Şekil 9.7. ARCH Değişen Varyans Test Sonucu 

 

Fonksiyonel Form (Biçim):  

➢ Tahmin edilen modelde herhangi bir spesifikasyon hatasının olup 

olmadığının tespiti için “Ramsey-RESET” testi uygulanmıştır. Bu testin 

Eviews adımları şu şekildedir:  

➢ Kısa veya uzun dönem katsayılarının tahmin edildiği ekrandan “View ⇒ 

Stability Diagnostics ⇒ Ramsey RESET Test” seçenekleri sırasıyla seçilir. 

Son olarak “OK” sekmesine tıklanır. 

➢ Bu seçimlerin ardından “Ramsey RESET Test” ve olasılık değerleri Şekil 

9.8’deki gibi elde edilir. 

Şekil 9.8. Ramsey RESET Test Sonucu 
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CUSUM ve CUSUM2:  

➢ Tahmin edilen katsayıların kararlılığını ya da istikrarını sınamak CUSUM 

ve CUSUM2 grafikleri oluşturulmuştur. Bu grafikleri elde etmek için 

uygulanması gereken Eviews adımları şu şekildedir:  

➢ Kısa veya uzun dönem katsayılarının tahmin edildiği ekrandan “View ⇒ 

Stability Diagnostics ⇒ Recursive Estimates ⇒ önce CUSUM Test daha 

sonra CUSUM of Squares Test” seçenekleri sırasıyla seçilir.  

➢ Ardından her bir seçim için “OK” sekmesine tıklanır. 

➢ Böylece aşağıda Şekil 9.9’da yer alan CUSUM ve CUSUM2 grafikleri elde 

edilmiş olur.  

Şekil 9.9. CUSUM ve CUSUM2 Grafikleri 

 

➢ Eviews üzerinden hesaplanan tüm bu “diagnostics” ya da tanısal test 

sonuçlarının raporlanmasında kullanılabilecek örnek tablo aşağıda Tablo 

9.4’te sunulmuştur.  

Tablo 9.4. NARDL Tanısal Test Sonuçları 

Tanısal testler Test değeri  Olasılık 

Breusch-Godfrey Serial Corr. LM test χ 2
SC 3.215336  0.2004 

Breusch-Pagan-Godfrey Heteroskedasticity  

test χ2
HET(BPG) 

17.61340  0.4136 

ARCH Heteroskedasticity test χ2 
HET(ARCH) 0.256258  0.6127 

Jarque-Bera Normality test χ2
NORM 1.462354  0.4813 

Ramsey RESET test χ2
FF 0.006140  0.9386 

CUSUM = İstiktarlı CUSUM2 = İstiktarlı 

➢ Yukarıda Tablo 9.4’te sunulan “diagnostics” ya da tanısal test sonuçlarına 

göre; 

➢ “Breusch-Godfrey Serial Correlation LM test” değeri 1.101087 olup olasılık 

değeri 0.5766’dır. Olasılık değeri 0.10’dan büyük olduğu için modelde 

otokorelasyon sorunu yoktur. 
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➢ Değişen varyans sınamasında ilk uygulanan “Breusch-Pagan-Godfrey” 

testinin katsayı değeri 5.032212 olup olasılık değeri 0.6560’tır. Olasılık 

değeri 0.10’dan büyük olduğu için modelde değişen varyans sorunu yoktur. 

➢ Değişen varyans sınamasında ikinci uygulanan “ARCH” testinin katsayı 

değeri 0.019548 olup olasılık değeri 0.8888’dir. Olasılık değeri 0.10’dan 

büyük olduğu için modelde değişen varyans sorunu yoktur.  

➢ “Jarque-Bera” test değeri 2.638374 olup olasılık değeri 0.2673’tür. “Jarque-

Bera” testinin olasılık değeri 0.10’dan büyük olduğu için modelin normal 

dağılıma uygun olduğu söylenebilir. 

➢ “Ramsey RESET” testinin katsayı değeri 0.311725 olup olasılık değeri 

0.5766’dır. Olasılık değeri 0.10’dan büyük olduğu için model kurma hatası 

yoktur. 

➢ CUSUM ve CUSUM2 grafiklerinin %95 güven aralığında, istenilen sınırlar 

içerisinde olduğu için kurulan model istikrarlıdır. 
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